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R&S®SMB100A Safety and Regulatory Information

Safety instructions

1 Safety and Regulatory Information

The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following chapters.

Intended use

The product is intended for the development, production and verification of electronic
components and devices in industrial, administrative, and laboratory environments.
Use the product only for its designated purpose. Observe the operating conditions and
performance limits stated in the data sheet.

Where do | find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:

® |n Safety instructions. The same information is provided in many languages as
printed "Safety Instructions". The printed "Safety Instructions" are delivered with
the product.

® Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

1.1 Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the data sheet,
manuals and the printed "Safety Instructions". If you are unsure about the appropriate
use, contact Rohde & Schwarz customer service.

Using the product requires specialists or specially trained personnel. These users also
need sound knowledge of at least one of the languages in which the user interfaces
and the product documentation are available.

Never open the casing of the product. Only service personnel authorized by

Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer service at
http://www.customersupport.rohde-schwarz.com.

Lifting and carrying the product

The maximum weight of the product is provided in the data sheet. To move the product
safely, you can use lifting or transporting equipment such as lift trucks and forklifts. Fol-
low the instructions provided by the equipment manufacturer.
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Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing. If Rohde & Schwarz provides
accessories designed for your product, e.g. a carrying bag, you can use the product
outdoors.

Unless otherwise specified, you can operate the product up to an altitude of 2000 m
above sea level. The product is suitable for pollution degree 2 environments where
nonconductive contamination can occur. For more information on environmental condi-
tions such as ambient temperature and humidity, see the data sheet.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is
moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting to power

The product is an overvoltage category Il product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death.

Take the following measures for your safety:

® Before switching on the product, ensure that the voltage and frequency indicated
on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

® |f a product has an exchangeable fuse, its type and characteristics are indicated
next to the fuse holder. Before changing the fuse, switch off the product and dis-
connect it from the power source. How to change the fuse is described in the prod-
uct documentation.

® Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

® Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.
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® |f the product needs an external power supply, use the power supply that is deliv-
ered with the product or that is recommended in the product documentation or a
power supply that conforms to the country-specific regulations.

Only connect the product to a power source with a fuse protection of maximum
20 A.

Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

® B B>

1.2 Labels on R&S SMB

Labels on the casing inform about:

® Personal safety, see "Connecting to power" on page 14.

® Product and environment safety, see Table 1-1.

e |dentification of the product, see the serial number on the rear panel.

Table 1-1: Labels regarding R&S SMB and environment safety

Labeling in line with EN 50419 for disposal of electrical and electronic equipment after the prod-
uct has come to the end of its service life. For more information, see Chapter 8, "Maintenance,
fr— Storage and Disposal”, on page 490.
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1.3 Warning Messages in the Documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

CAUTION

Potentially hazardous situation. Could result in minor or moderate injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.4 Korea certification class B

o 7171 FH&BF) AA AR 2A FE AN AESHE AL BH0R &
o, BE Ao A A F 5 AT
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2 Welcome to the R&S SMB

The R&S SMB is a high-performance signal generator developed to meet demanding
customer requirements. Offering excellent signal characteristic and straightforward and
intuitive operation, the signal generator makes signal generation fast and easy.

2.1 Key Features

Outstanding key features of the R&S SMB are:

® Frequency range from 100 kHz to up to 40 GHz

® SSB phase noise of —108 dBc (typ.) at 10 GHz and 20 kHz offset
® Wideband noise of —138 dBc at 10 GHz and 30 MHz offset

® High output power of up to +27 dBm (meas.)

® Analog modulations with AM, FM/@M and pulse modulation

For more information, see data sheet.

2.2 Documentation overview

This section provides an overview of the R&S SMB user documentation. Unless speci-
fied otherwise, you find the documents on the R&S SMB product page at:

www.rohde-schwarz.com/manual/smb100a

2.2.1 User manual and help

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control commands
with programming examples, and information on maintenance, instrument interfaces
and error messages. Includes the contents of the quick start guide manual.

The contents of the user manuals are available as help in the R&S SMB. The help
offers quick, context-sensitive access to the complete information.

All user manuals are also available for download or for immediate display on the Inter-
net.

2.2.2 Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMB. It also lists the
options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.
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2.2.3

2.2.4

2.3

24

Notes on screenshots
See www.rohde-schwarz.com/brochure-datasheet/smb100a

Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the
used open source software.

See www.rohde-schwarz.com/firmware/smb100a

Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smb100a.

Typographical conventions

The following text markers are used throughout this documentation:

Convention Description
"Graphical user interface ele- All names of graphical user interface elements on the screen, such as
ments" dialog boxes, menus, options, buttons, and softkeys are enclosed by

quotation marks.

[Keys] Key and knob names are enclosed by square brackets.

Filenames, commands, Filenames, commands, coding samples and screen output are distin-

program code guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.
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Notes on screenshots

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.
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3 Getting Started

3.1 Preparing for Use

Here, you can find basic information about setting up the product for the first time.

3.1.1 Lifting and Carrying

See "Lifting and carrying the product” on page 13.
» Use the carrying handle at the side for lifting and carrying the R&S SMB.

For mounting the R&S SMB in a rack, see Chapter 3.1.4.2, "Mounting the R&S SMB in
a Rack", on page 22.

3.1.2 Unpacking and Checking

1. Unpack the R&S SMB carefully.

2. Retain the original packing material. Use it to protect the control elements and con-
nectors when transporting or shipping the R&S SMB later.
See also "Lifting and carrying" on page 489.

3. Using the delivery notes, check the equipment for completeness.
4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

3.1.3 Choosing the Operating Site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the data sheet.

See also "Choosing the operating site" on page 14.

Electromagnetic compatibility classes

The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the data sheet.
® (lass B equipment is suitable for use in:

— Residential environments
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— Environments that are directly connected to a low-voltage supply network that
supplies residential buildings

® C(Class A equipment is intended for use in industrial environments. It can cause
radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.1.4 Setting Up the R&S SMB

See also:
® "Setting up the product” on page 14
® ‘"Intended use" on page 13

3.1.41 Placing the R&S SMB on a Bench Top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the data
sheet.

2. CAUTION! Foldable feet can collapse. See "Setting up the product” on page 14.

Always fold the feet completely in or out. With folded-out feet, do not place any-
thing on top or underneath the product.

3. WARNING! A stack of products can fall over and cause injury. Never stack more
than three products on top of each other. Instead, mount them in a rack.

Stack as follows:

If the products have foldable feet, fold them in completely.
It is best if all products have the same dimensions (width and length). If the
products have different dimensions, stack according to size and place the
smallest product on top.

e Do not exceed the permissible total load placed on the product at the bottom of
the stack:
— 50 kg when stacking products of identical dimensions (left figure).
— 25 kg when stacking smaller products on top (middle figure).
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Left = Stacked correctly, same dimensions
Middle = Stacked correctly, different dimensions
Right = Stacked incorrectly, too many products
4. NOTICE! Overheating can damage the product.
Prevent overheating as follows:

e Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity.

e Do not place the product next to heat-generating equipment such as radiators
or other products.

3.1.4.2 Mounting the R&S SMB in a Rack

To prepare the rack
1. Observe the requirements and instructions in "Setting up the product" on page 14.

2. NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the R&S SMB in a rack

1. Use an adapter kit that fits the dimensions of the R&S SMB to prepare the instru-
ment for rack mounting.

a) Order the rack adapter kit designed for the R&S SMB. For the order number,
see the data sheet.

b) Mount the adapter kit. Follow the assembly instructions provided with the
adapter Kkit.

2. Lift the R&S SMB to shelf height.
3. Push the R&S SMB onto the shelf until the rack brackets fit closely to the rack.

4. Tighten all screws at the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S SMB in the rack.
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To unmount the R&S SMB from a rack
1. Loosen the screws at the rack brackets.
2. Remove the R&S SMB from the rack.

3. If placing the R&S SMB on a bench top again, unmount the adapter kit from the
R&S SMB. Follow the instructions provided with the adapter kit.

3.1.5 Considerations for Test Setup

Cable selection and electromagnetic interference (EMI)
Electromagnetic interference (EMI) can affect the measurement results.

To suppress electromagnetic radiation during operation:
® Use high-quality shielded cables, especially for the following connector types:

— BNC
Double-shielded BNC cables.
How to: "To connect to non-screwable connectors (BNC)" on page 26

- USB
Double-shielded USB cables.
How to: Chapter 3.1.9, "Connecting USB Devices", on page 25.
See Chapter 9.6, "Measuring USB Cable Quality", on page 506.

- LAN
At least CAT6 STP cables.
How to: Chapter 3.1.7, "Connecting to LAN", on page 24

® Always terminate open cable ends.
® Ensure that connected external devices comply with EMC regulations.

Signal input and output levels

Information on signal levels is provided in the data sheet. Keep the signal levels within
the specified ranges to avoid damage to the R&S SMB and connected devices.
Preventing electrostatic discharge (ESD)

Electrostatic discharge is most likely to occur when you connect or disconnect a DUT.

» NOTICE! Electrostatic discharge can damage the electronic components of the
product and the device under test (DUT).

Ground yourself to prevent electrostatic discharge damage:

a) Use a wrist strap and cord to connect yourself to ground.
b) Use a conductive floor mat and heel strap combination.
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3.1.6 Connecting to Power

For safety information, see "Connecting to power" on page 14.

If there were any problems during power on, check the condition of the mains fuses as
described under Chapter 8.2, "Changing Fuses", on page 490.

To connect the R&S SMB to power:

1. Plug the AC power cable into the AC power connector at the rear panel of the
instrument. Only use the AC power cable delivered with the R&S SMB.
2. Plug the AC power cable into a power outlet with ground contact.

The required ratings are listed next to the AC power connector and in the data
sheet.

3.1.7 Connecting to LAN

Network environment

Before connecting the product to a local area network (LAN), consider the following:
® |[nstall the latest firmware to reduce security risks.
® Forinternet or remote access, use secured connections if applicable.

® Ensure that the network settings comply with the security policies of your company.
Contact your local system administrator or IT department before connecting your
product to your company LAN.

® When connected to the LAN, the product may potentially be accessed from the
internet, which may be a security risk. For example, attackers might misuse or
damage the product.

To connect to LAN

The "LAN" connector is at the rear panel.
» Connect the LAN socket with an RJ-45 cable to the LAN.

By default, the R&S SMB is configured to use DHCP (dynamic host configuration pro-
tocol) and no static IP address is configured.

If switched on and connected to the LAN, you can find the address information in the
network settings dialog.

See Chapter 4.2.3.8, "Network Settings", on page 104
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3.1.8 Connecting to IEC 625/IEEE 488 (GPIB)

To connect to the IEC 625/IEEE 488 interface

You can use the GPIB bus interface for controlling the instrument remotely. The "IEC
625/IEEE 488" connector is at the rear panel.

1. Connect the "IEC 625/IEEE 488" socket to the controller PC with a double-shielded
GPIB bus interface cable.

2. Configure the settings for remote control over GPIB.

The controller must address the instrument with the GPIB bus address.
For details, refer to Chapter 5.1.6, "GPIB Interface (IEC/IEEE Bus Interface)",
on page 246 and Chapter A.1, "GPIB Bus Interface", on page 508.

3.1.9 Connecting USB Devices
You can connect or disconnect USB devices, e.g., memory stick, a CD-ROM keyboard,
etc, with the R&S SMB during operation.
To connect a USB device to the interface of the R&S SMB, always use the USB type A

connector t the rear panel. Refer to the documentation of the USB device to find out
which USB connector type you can connect to the USB device.

To connect USB storage devices

USB storage devices, such as memory sticks, allow easy data transfer from/to the
R&S SMB. You can also use them for firmware updates.

» Connect the USB storage device to the USB type A connector at the rear panel.

To connect USB devices with external power supply

1. NOTICE! Connected devices with external power supply can feed back current into
the 5 V power supply of the USB interface and thus damage the R&S SMB.

Ensure that there is no connection between the positive pole of the power supply
and the +5 V power pin of the USB interface (VBUS).

2. Connect the USB storage device to the USB type A connector at the rear panel.

To connect a keyboard
» Connect the keyboard to the USB type A connector at the rear panel.

When connected, the R&S SMB detects the keyboard automatically. A detected
keyboard has the default layout English — US.

Use the Chapter 4.2.3.9, "Display/Keyboard Settings", on page 108 dialog to con-
figure the keyboard properties.
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To connect a mouse
» Connect the keyboard to the USB type A connector at the rear panel.

When connected, the R&S SMB detects the mouse automatically.

To connect power sensors

You can also connect power sensors of the R&S NRP series either directly at the USB
interface, or using an USB hub, e.g. R&S NRP-Z5 with several connected power sen-
sors.

For sensors with network capabilitiy, you can use the LAN interface, see

» To connect a power senor to the USB type A connector, you have several options:
e Connect the sensor to the USB type A connector
If necessary, use an adapter cable, e.g. R&S NRP-Z3 or R&S NRP-Z4
e Connect several sensors to an USB hub, and the hub to the R&S SMB.

See Chapter 4.3.6, "RF Measurement”, on page 167.

Connecting to RF
The "RF" connector is at the front panel.

To prepare for connecting to RF
1. NOTICE! Damaged or not clean connections can lead to RF insertion loss and mis-
match, and even premature wear of the connectors.

Before connecting to the port, inspect the RF connector visually to check that it is
clean, undamaged and mechanically compatible.

See the application note 1MA99 for information on how to handle and maintain the
RF port, to minimize measurement deviations and ensure its longevity.

2. NOTICE! Risk of instrument damage. Excessive reverse power or DC voltage at
the RF connector can damage the instrument.
Make sure that the values do not exceed the reverse power and DC limits as given
in the data sheet.

3. Ifthe R&S SMB is switched on, deactivate the RF output, before connecting an RF
cable to the RF connector.
In the home screen, select the block "Level" > "RF ON > Off".

To connect to non-screwable connectors (BNC)

1. Use a high-quality RF cable that matches the RF connector type.
See "Cable selection and electromagnetic interference (EMI)" on page 23.

2. To connect the RF cable with the RF connector, proceed as follows:

a) Carefully align the connector of the cable and the RF connector along a com-
mon axis.

Operating Manual 1407.0806.32 — 23 26


https://www.rohde-schwarz.com/appnote/1MA99

R&S®SMB100A Getting Started

3.1.1

3.1.12

Preparing for Use

b) Mate the connectors along the common axis until the male pin of the connector
of the cable engages with the female socket of the RF connector.

If your instrument is equipped with a test port adapter, see the application note
1MA100.
See "RF 50 Ohm" on page 54.

To prevent RF output switch-off

» NOTICE! If you set a too high output level without a load connected to the instru-
ment, the reverse power can exceed a limit forcing the R&S SMB to switch off the
RF output.

Connect a load with sufficient return loss as given in the data sheet.

Connecting to Ref In/Ref Out

The connector is at the rear panel.

To connect to Ref In/Ref Out
For connection, the R&S SMB provides BNC connectors.

» Follow the instructions in "To connect to non-screwable connectors (BNC)"
on page 26.

Switching On or Off

The following table provides an overview of power states, LEDs and power switch posi-
tions.

Table 3-1: Overview of power states

State LED Position of power switch
Off gray [0]
Standby yellow 1
Ready green 1]

To switch on the R&S SMB

The R&S SMB is off but connected to power. See Chapter 3.1.6, "Connecting to
Power", on page 24.

1. Set the switch on the power supply to position [I].
The switch is at the rear panel.
The LED of the [ON/STANDBY] key is yellow.

2. Wait until the oven-controlled oscillator (OCXO) warms up. For the warm-up time,
see data sheet.
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3. Press the [ON/STANDBY] key at the front panel.
The LED changes to green. The R&S SMB boots.

When starting for the first time, the R&S SMB starts with the default settings. When
restarting the instrument, the settings depend on the instrument configuration
before shut-down.

See Chapter 4.2.8, "Storing and Loading Instrument Data - File Key", on page 127.

When the instrument is switched on, it automatically monitors main functions.

A detected fault is indicated by an "ERROR" message displayed in the info line
together with a brief error description. For in-depth identification of the error, press the
[INFO] key. In response, a description of the error(s) is displayed. In addition to auto-
matic monitoring, you can perform maintenance tasks.

See:

® Chapter 9, "Status Information, Error Messages and Troubleshooting",
on page 499

® Chapter 8.4, "Performing Maintenance Tasks", on page 491

To reboot the instrument
If it is necessary to restart the instrument, e.g. if the firmware stops unexpectedly:

> Press the [STANDBY] key for approx. 5 s.
The R&S SMB reboots.

To shut down the product
The product is in the ready state.

» Press the [ON/STANDBY] key.

The operating system shuts down. The LED changes to yellow.

In the standby state, the power switch circuits and the OCXO are active. To deactivate
them, disconnect the instrument from the power supply.

To disconnect from power

The R&S SMB is in the standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.

Set the toggle switch on the power supply to position [0].
The LED of the [ON/STANDBY] key is switched off.

2. Disconnect the R&S SMB from the power source.
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3.1.13 Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched off. It is also reco-
mended that you use the [PRESET] key to return the instrument to its defined preset
state every time a new configuration is required or the current setup is not anymore rel-
evant.

The R&S SMB offers a two-stage preset concept:

® Preset the instrument to a predefined state
The [PRESET] key calls up a defined instrument setup. All parameters and switch-
ing states are preset (also those of inactive operating modes). The default instru-
ment settings provide a reproducible initial basis for all other settings. However,
functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. GPIB bus address or reference oscillator source settings.

® Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, press the [SETUP] key and select the "Factory Preset".
For more information and an overview of the settings affected by the factory preset
function, see Chapter 4.2.3.16, "Factory Preset", on page 122.

Overview of the Most Important Preset States

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

® "RF frequency" =1 GHz
® "RF level" RF output switched off

e "Level" =30 dBm for instruments including an attenuator
"Level" = -5 dBm for instruments with no attenuator

e "Offsets" =0
® "Modulations State" = Off

® Uninterrupted level settings are switched off
"Level Attenuator Mode" = AUTO

® |Internal level control "Level ALC" = AUTO
® User correction "Level Ucor" = OFF

® "LF output State" = Off

® "Sweep State" = Off

Settings that are not affected by the [PRESET] key

e Reference frequency settings ("Ref Oscillator" menu)

® Power on settings ("Level/EMF" menu)

® Network settings ("Setup" menu)

® GPIB address ("Setup" menu)

e *|IDN? Identification and emulation ("Setup" menu)

® Password and settings protected by passwords ("Setup" menu)

Operating Manual 1407.0806.32 — 23 29



R&S®SMB100A Getting Started

Preparing for Use

e Start/Stop Display Update ("Setup" menu)
® Display and keyboard settings ("Setup" menu)

O User-defined instrument states can be stored and called up in the "File" dialog.

3.1.14 Working with Linux Operating System

The instrument uses an embedded Linux operating system, optimally adapted to the
instrument.

@ Accessing the operating system
No access to the operating system is required for normal operation.

All necessary system settings can be made in the "Setup" dialog.

3.1.15 Setting Up a Network (LAN) Connection

The R&S SMB is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). Provided the appropriate rights have been assigned by
the network administrator and the Linux firewall configuration is adapted accordingly,
the interface can be used, for example:

® To transfer data between a controller and the instrument, e.g. in order to run a
remote control program.
See Chapter 5, "Remote Control Basics", on page 240.

® To access or control the measurement from a remote computer using the R&S
VISA or Ultr@VNC programs (or similar tools, like another VNC client or any Web
browser supporting Java)

® To transfer data from a remote computer and back, e.g. using network folders

This section describes how to configure the LAN interface. It includes the following top-
ics:

® Chapter 3.1.7, "Connecting to LAN", on page 24

® Chapter 3.1.15.1, "Assigning the IP Address", on page 30

3.1.15.1 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.

® |f the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

® |f the network does not support DHCP, the instrument tries to obtain the IP address
via Zeroconf (APIPA) protocol. If this attempt does not succeed or if the instrument
is set to use alternate TCP/IP configuration, the addresses must be set manually.
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By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish a
physical connection to the LAN without any previous instrument configuration.

Risk of network errors!

Connection errors can affect the entire network.

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before connecting the instru-
ment to the LAN.

Contact your network administrator to obtain a valid IP address.

Assigning the IP address on the instrument
1. Press the [Setup] key and select the "Network Settings" dialog.
2. Set the "Address Mode" to Static.

3. Select the "IP Address" and enter the IP address, for example 792.768.0.1..
The IP address consists of four number blocks separated by dots. Every block con-
tains 3 numbers in maximum.

4. Select the "Subnet Mask" and enter the subnet mask, for example 255.255.255.0.
The subnet mask consists of four number blocks separated by dots. Every block
contains 3 numbers in maximum.

O Use computer names to identify the instrument

= In networks using a DHCP server, it is recommended that you address the instrument
by its unambiguous computer name, see Chapter 3.1.15.2, "Using Computer Names",
on page 31.
A computer name (hostname) is an unique dedicated identification of the instrument,
that remains permanent as long as it is not explicitly changed. Hence, you can address
an instrument by the same identification (computer name), irrespectively if a network or
a point-to-point connection is used.

To assign the IP address manually on the remote computer

» Obtain the necessary information from your network administrator. If you use more
than one LAN connector, you need separate address information for each connec-
tor.

For information on how to perform the configurations, refer to the documentation of
the operating system the remote computer uses.

3.1.15.2 Using Computer Names

In a LAN that uses a DNS server (Domain Name System server), each PC or instru-
ment connected in the LAN can be accessed via an unambiguous computer name
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instead of the IP address. The DNS server translates the host name to the IP address.
This is especially useful when a DHCP server is used, as a new IP address may be
assigned each time the instrument is restarted.

Each instrument is delivered with an assigned computer name, but this name can be
changed.

The default instrument name is a non-case-sensitive string that follows the syntax
rs<instrument><serial number>.

The serial number can be found on the rear panel of the instrument. It is the third part
of the device ID printed on the bar code sticker:

&> 1D: 1419.0035K02 -102030]- Zd | seral number

Querying and changing a computer name

1. Press the "Setup” key and select "Network Settings".

The computer name is displayed under "Hostname".

2. Press the "Setup" key, select "Protection" and enable the "Protection Level 1".
The default password is 123456.

The parameter "Hostname" in the "Network Settings" dialog is now enabled for
configuration.

3. Change the "Hostname".

3.1.16 Remote Access via an External Controller

The R&S SMB can be remote accessed from a remote computer (external controller)
via a network link. This allows convenient operation of the instrument from the desktop
although the instrument is integrated in a rack somewhere else.

O For an overview of the instrument's operating concept and the different ways to control
= and operate the instrument, see Chapter 3.4, "System Overview", on page 62.

There are different ways to establish a remote access connection to the signal genera-
tor but all of them require an established LAN connection between the instrument and
the remote computer. The simplest way to remote access the instrument is to use a
Web browser, such as Windows Internet Explorer or Mozilla Firefox for instance. Alter-
natively a remote access via a special application can be used.

For example, the free-of-charge program Ultr@VNC for PCs with Linux/Unix or Win-
dows operating system is available for setting up the remote access connection. Using
this application requires additional installation.
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See the following table for an overview of the different ways to establish a remote
access connection to the signal generator.

Table 3-2: Remote access via an external computer

Remote access via Installation of the additional
LAN application
connec-
tion on the on the remote
instrument computer
Any web browser required no Java Runtime must

be installed and
activated in the
browser settings.

for example Windows Internet Explorer or Mozilla Firefox,
see Chapter 3.1.16.1, "Using a Web Browser for Remote
Access", on page 33

Web browser with HTML5 required no Web sockets must

for example LXI Browser, see "Web Control" on page 45 be supported.

VNC Client required required VNC Viewer

for example Ultr@VNC or other dedicated client software required

for PCs with Linux/Unix or Windows operating system

see Chapter 3.1.16.2, "Remote Access via a VNC Client
Software", on page 34

When the connection is set up with a VNC client software (Ultr@VNC), direct control
on the instrument is possible while remote access is established.

For return to direct operation on the instrument, the connection must be cut. After cut-
ting the connection, it is still enabled and can be established again any time. The con-
nection is disabled only after deactivation of the program.

This section gives an information on how to use the Web browser for remote access,
how to install the applications for remote access and how to establish the connection
between the instrument and an external computer with Windows operating system.
Remote access via an external computer with Linux/Unix operating system is per-
formed accordingly.

O Default password

Remote-access and file access require the user "instrument" with default password
"instrument"”.

Changing the default user and security passwords

It is highly recommended to change the default user and security passwords in the
menu "Setup > Security" before connecting the instrument to the network (see section
Chapter 4.2.3.14, "Security", on page 114).

3.1.16.1 Using a Web Browser for Remote Access

The instrument can be remote-accessed via any web browser, as for example the Win-
dows Internet Explorer or Mozilla Firefox.
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O Alternatively, you can also make use of the LXI browser, as described in "Web Control"
= on page 45.

To remote access the instrument via a web browser:

1. Connect the instrument and the remote computer to a LAN, seeChapter 3.1.7,
"Connecting to LAN", on page 24 .

2. Instal the Java Runtime Environment JRE on the remote computer.

3. Type the instruments’ IP address in the address field of the Web browser on your
PC, e.g. http://10.111.11.1

The "VNC Authentication" screen appears.

(e Tight¥MNC applet - Windows Internet Explorer

€5 v g http:/f10.111.11.1f v/
Fie Edt Wiew Favortes Tools Help

W 4R | @ TightVNC applet

 optons | e | | Ratesn |

VNC Authentication

Password: 0K

4. Enter the password and select "OK".
The default password is "instrument".

After the connection is established, the current signal generator screen with the
block diagram is displayed and the instrument can be remote-accessed from the
remote computer.

3.1.16.2 Remote Access via a VNC Client Software

A VNC client software is an application which can be used to access and control the
instrument from a remote computer via LAN.

The following description explains how to establish the remote access, represented by
means of the client software Ultr@VNC. The software is included in Linux/Unix operat-
ing system, but it is also available as a free-of-charge download on the Internet http://
www.uvnc.com/download/index.html. Thus, it is also available for remote computers
with Windows operating system.

The GUI appearance of Ultr@VNC may vary if you use a later release. Also, similar
programs may deviate in some details, but the basic procedure is the same.
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Risk of unauthorized access

If the VNC service is enabled on the instrument, any user in the network who knows
the computer name and password can access it.

Disable the VNC service on the instrument to prevent unauthorized access.
See "LAN Services" on page 117.

Setting up a VNC connection

1. Connect the instrument and the remote computer to a LAN, see Chapter 3.1.7,
"Connecting to LAN", on page 24 .

2. Install the Ultr@VNC application and enable it on the instrument.
3. Inthe ICF firewall, enable communication on the network via Ultr@VNC program.

4. Install the VNC Viewer on the remote computer with Windows operating system,
see "Installing the VNC Viewer on a Windows PC" on page 37.

5. Set up the VNC connection between the instrument and:

a) the remote computer with Linux/Unix operating system, see "Setting up the
VNC connection on the Linux/Unix remote computer" on page 37;

b) the remote computer with Windows operating system, see "Setting up the VNC
connection on the Windows remote computer" on page 38.

O Enabled Direct Control

The direct control of the instrument is not disabled and the instrument can be control-
led from the front panel and via the remote computer alternately.

Installing the Ultr@VNC application

1. Download the program from the internet and copy it to a directory that can be
accessed.

2. On the instrument, shut down firmware using the ALT+F4 key combination.

3. Double click on the setup file to start the installation.
The setup wizard leads through the installation. This description focus only on the
relevant settings.
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a) Select installation of all components.
tﬁl Setup - Ultr@VHC Release 1.0.0 RC 18 i E )
Select Components

‘Which components should be installed? Q‘E'.'\h

Select the components you want to nstall: clear the components pou do not want to
inztall. Click Mest when vou are ready to confinus.

[Fullinstallation v]
UltraWNE Server 1.8ME
UltraNE Viewer 1.0ME
[l Figpaater a ]

Current selection requires at least 2. 7 MB of disk space.

| < Back ” Next > ][ Cancel

b) In the "Additional Task Panel", enable all entries.

15/ Setup - Ul @VHC Release 1.0.0 RC 18

Select Additional Tasks
Wwhich additional tasks should be perfomed?

Select the additional tasks you would e Setup to perform while installing U@y HC
Releaze 1.0.0 RC 18, then click Mext.

Server configuration:
Re - & a spstem service
Start or restart UIr@VNC service

Additional icons:

Create a U@L Yiewer deskiop icon
Create a Uli@VNC Server desklop icon
Create a UlnEWHE Repeater deskiop icon
File Associations:

[v] Azznciate vne files with UInEWNT Viewsr

[ <Back | Mew> | [ Cancel

A successful installation is indicated by a message.

WinVHC x|

L The WinWNC service was successfully registered |
“‘.;I) The service may be started from the Control Panel, and will |
automatically be run the next time this machine is reset |

At the same time a warning is displayed stating that a password must be set.

WinWHC Error &3

WARMNIMNG : This machine has no default password set. WinWhC will present the Default
. Properties dialog now to allow one to be entered.

4. Select "OK".

The "Default Local System Properties" panel opens.
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WinWHC: Default Local System Properties (®E]%]
Incoming Connections Connection Settings
¥ Accept Socket Connections I Force Yiew Only [disable Viewers Inputs)
P d: lr— I Disable Local Inputs (Keyboard & Mouse]

Display Mumber or Ports to use < Auto I jHemaveleskiopiyallpapet

 Display N° |0 Update Handling
¢ Ports  Main: |[5900 Htip: |'.‘3?3i! ¥ Poll Full Screen [ Fast] = Poll Console
¥ Pall Fo d Wind pagnduyes Onty
MS Logon | A neaToun o Poll On Event

I~ Poll Window Under Cursor " Received Only

¥ System HookDII
¥ Video Hook Driver

¥ Enable Java Viewer (Hitp Connection)
¥ Enable Xdmcp [X11 Connection)

—¥hen Last Client Di t I Low Accuracy [ Turbo Speed )
£ Do Nothing DSM Plugin
¢ Lock Workstation [W2K] I~ Use ]No Plugin detected... j Config I

" Logoff Workstation

-Share only the Window Named :

‘Misc.
¥ Enable Blank Monitor on Viewer Request I” Share ‘
¥ Enable File Transfer S irerg g

I Log debug infos to the Win¥NC.log file
I Allow Loopback Connections
Default Server Screen 11 F 0K Apply | Cancel |

[~ Display Query Window Timeout:| | ! s

5. Enter a password with a length of at least five digits.
This password is used on the remote computer to access the instrument. Other
settings may be changed according to the user-specific security requirements.

After the installation the Ultr@VNC program is automatically started together with
the operating system. On mouse over, the IP address of the instrument is indica-
ted.

This IP address and the user-defined password are the prerequisites to enable
remote access on the remote computer. Terminated connection is indicated by
changed icon color.

Installing the VNC Viewer on a Windows PC

1. Download the Ultr@VNC program form internet and follow the installation instruc-
tions.
Only the program component VNC Viewer is required.

Note: The VNC Viewer program is included in the download for the installation of
the Ultr@VNC program on the signal generator if "Full installation" was selected in
the "Select Component" panel. In this case, the program ultr@vncviewer.exe
can be copied to the Windows PC.

2. Install VNC Viewer program component on the remote computer.

Setting up the VNC connection on the Linux/Unix remote computer
The VNC program is available per default for Linux/Unix operating systems.

1. Start a Web browser on the remote computer and enter the IP address of the
instrument.

2. Enter the following address:
vnc://<IP-address of the instrument>, e.g. vnc://192.168.1.1.
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A dialog is opened and the password for the remote VNC connection is requested.

3. Enter the password as defined in the "Default Local System Properties" panel of
the Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual func-
tions are operated using the mouse and keyboard.

In contrast to remote access via Remote Desktop, the direct control of the instru-
ment is not disabled and the instrument can be controlled from the front panel and
via the remote computer alternately.

Setting up the VNC connection on the Windows remote computer

1. Start VNC Viewer program component on the PC, select "VNC Server" and enter
IP address of the instrument.

|
B nCsever [15278810 = | [

[ hostdisplay or host:port )

" ULTRA [>2Mbit /=] - Experimental

0 LAN [> TMbit/z) - Max Colors |
 MEDIUM  [> 128Kkit/s] - Max Colors

 MODEM (19 -128Khit/s] - 255 Colars

£ SLO0W [« 153kKhbit/s] - 256 Colors. Fuzzy

Cancel

r Duick Options: :
& AUTO [Buto select best settings) | Connect |

™ View Only [~ Auto Scaling Options... |
I~ Use DSHPhigin |No Plugin detected... ﬂ Corfig |
I Prowy/Repeater |

2. To initialize the connection, select "Connect".

A message requesting the password appears.

¥NC Authentication -
.
A ¥ 4 T
Log On Cancel |

3. Enter the password as defined in the "Default Local System Properties" panel of
the Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual func-
tions are operated using the mouse and keyboard.

O Enabled Direct Control

The direct control of the instrument is not disabled and the instrument can be control-
led from the front panel and via the remote computer alternately.
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Terminating VNC Connection

The remote access via VNC connection can be terminated either on the R&S SMB or
on the external PC. Terminating the connection does not disable it. It can be estab-
lished again any time. See the notice above concerning unauthorized access due to
VNC connection!

1. Terminate the connection on the R&S SMB

a) Press the "Windows" key to access the operating system.
b) Right-click on the VNC icon on the task bar and select "Kill all clients".

2. To terminate the connection on the external Linux/Unix PC, close the internet
browser or close the signal generator window.

3. To terminate the connection on the external Windows PC, close the VNC Viewer
program.

The connection is terminated. The color of the VNC icon in the status bar of the
instrument changes.
A message on the external PC indicates the disconnection.

Disabling Remote Access via Ultr@VNC

The VNC connection can be disabled by removing the program on the instrument or by
deactivating the VNC Server service.

1. Remove the VNC program

a) Press the "Windows" key to access the operating system and open the "Add or
Remove Programs" by selecting "Start > Settings > Control Panel > Add or
Remove Programs".

b) Remove the VNC program.

2. Deactivate the VNC Server service

a) Press the "Windows" key to access the operating system and open the "Ser-
vices" by selecting "Start > Settings > Control Panel > Services".
b) Deactivate the VNC Server service.

The connection is disabled, the VNC icon disappears from the task bar of the
instrument.

3.1.17 LXI Configuration

LXI ("LAN eXtensions for Instrumentation" is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology. LXI is
intended to be the LAN-based successor to GPIB, combining the advantages of Ether-
net with the simplicity and familiarity of GPIB.

Like GPIB, LXI determines and standardizes the way the instrument behaves in a LAN.
The LXI implementation by the Rohde&Schwarz signal generators allows you to
change certain LAN settings, to reset the LAN connection as well as to identify the
instrument easily.
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O For information about the LXI standard, refer to the LXI website at http://www.Ixistan-
= dard.org. See also "News from Rohde & Schwarz, article 2006/I1 - 190".

The R&S SMB provides an integrated "LXI Status" dialog for LXI status indication and
reset of the LAN configuration ("LAN Configuration Initialize", LCI). To access the LXI
status dialog, press the [Setup] key and select "Remote > LXI Status".

For further information, see Chapter 4.2.3.12, "LXI| Status", on page 112.

@ Firmware update
After a firmware update, shut down and restart the instrument in order to enable the full
LXI functionality.

Default state of the network settings

According to the LXI standard, an LCI must set the following parameters to a default

state.

Parameter Value

TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled

ICMP Ping Enabled

Password for LAN configuration LxiWeblfc

The LCI for the R&S SMB also resets the following parameters:

Parameter Value

Hostname <Instrument-specific host name>
Description Vector Signal Generator
Negotiation Auto Detect

VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's "LXI Browser Interface".

3.1.17.1 LXI Browser Settings

To access the instrument via the web browser:

» Type in the instrument's host name or IP address in the address field of the
browser on your PC, for example "http://10.113.1.205".
Note: Do not add the missing zeros in the IP address, while opening the instru-
ment home page.

The instrument home page (welcome page) opens.
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Lan Configuration

Status

Utilities
Instrument Control

Web Control

File Download

File Upload
Diagnostics

Device Screenshot
SCPI Remote Trace
SCPI Command Shell

Help

Glossary

Instrument Model
Manufacturer
Serial Number
Description

LXI Version

LXI Extended Features
DNS Host Name(s)
MAC Address

IP Address
Firmware Revision
Current Time

Current Time source

VISA resource string

Device Indicator
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R&S SMB

Rohde & Schwarz GmbH & Co. KG

100011

Rohde & Schwarz Signal Generator SMB100A 100011
1.4 LXI Core 2011

instrument

00:25:64:C3:31:82

10.113.1.150

03.20.390.12

‘Wednesday, 2015/12/02, 11:54:06
Operating System

TCPIP:10.113.1.150:instD::INSTR
TCPIP:10.113.1.150:hislip0::INSTR

ACTIVE (press to toggle) (]

www.rohde-schwarz.com

No error

B 2015 ROHDE&SCHWARZ. All rights reserved.

The navigation pane of the browser interface contains the following elements:
. llLXIll

"Home" opens the instrument home page.
The home page displays the device information required by the LXI standard,
including the VISA resource string in read-only format.

— "Device Indicator" activates or deactivates the LXI status indication.
When activated, the LXI LEDs flash, both in the browser dialog and in the LXI
dialog of the connected instrument. A green LXI status symbol indicates that a
LAN connection has been established; a red symbol indicates that no LAN
cable is connected.

— "Lan Configuration" allows you to configure LAN parameters and to initiate a
ping, see "Ping Client" on page 44.
— "Status" displays information about the LXI status of the instrument.

— "Utilities" provides access to the LXI event log functionality required by the LXI
standard.

® "Instrument Control"

"Web Control" provides remote access to the instrument, see "Web Control"
on page 45.

® "Diagnostics"

"SCPI Remote Trace" records messages exchanged via the remote control
interface, see "SCP| Remote Trace" on page 46.

. llHelpll
"Glossary" explains terms related to the LXI standard.

Operating Manual 1407.0806.32 — 23 41



R&S®SMB100A Getting Started

Preparing for Use

— www.rohde-schwarz.com opens the Rohde & Schwarz home page.

» Press the "INACTIVE (press to toggle)" button to activate the connection.

ACTIVE {press to togale) [ ]

A green flashing status LED indicates the active connection. If the LAN connection
fails, the LED turns red.

The status of the LAN connection is also indicated by the "LAN Status indicator” in
the "LXI Status" dialog.

For further information, see section "LXI Status" in the Operating Manual.

3.1.17.2 LAN Configuration

The "LAN Configuration" web page provides access to the parameters required for
identifying the R&S SMB in the network, and allows modification.

@ Password protection
Changing the LAN configuration is password-protected. The default password is Lxi-
Weblfc (notice upper and lower case characters). This password cannot be changed in
the current firmware version.

It comprises the following navigation entries.

® [P CoNnfigUration........ooeiiiiiiicccie e a e e e e e e e e e aeaee 42
o Advanced LAN Configuration...........uuuuceeeiieieie et 43
L J 1 o 211 o | SR 44
L VA=Y o T o oo ) S 45
L ST O I =T To] (T I = Lo YRS 46

IP Configuration

The "IP Configuration" page displays all mandatory LAN parameters.
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LXI

Home
Lan Configuration

Advanced Config
Ping Client
Status
Litilities

Instrument Control

Web Control
File Download
File Upload

Diagnostics

Device Screenshot
SCPI Remote Trace
SCPI Command Shell

Help
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Hostname

DNS$ Hostname(s)
Domain
Description

IP Address Mode
IP Address
Subnet Mask

Default Gateway

Obtain DNS Server Address
automatically

DNS Server(s)

Register Device at DNS Server
dynamically

HiSLIP Port

Mo error

rssmb100a100020
rssmi100a100020.rsint net

rsint.net

SMB (3.20.x.x) 000000

[DHCP + Aulo IP Address v

10.113.1.150

10.111.1.32

100111.0.1
W]

10.0.2.166
¥

4530

Submit

Preparing for Use

Attention! Changing the hostname reboots
the device!

10.0.23.158

(Password required!)

@ 2015 ROHDE&SCHWARZ. All rights reserved.

The "IP Address Mode" selects a configuration mode for the IP address of the
R&S SMB. With static configuration, the entered IP address, subnet mask, and default
gateway are used. With dynamic configuration, DHCP or dynamic link local addressing

(automatic IP) are used to obtain the instrument IP address.

See Chapter 3.1.15.1, "Assigning the IP Address", on page 30.

Advanced LAN Configuration

The "Advanced Config" page provides LAN settings that are not declared mandatory
by the LXI standard.
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ROHDE&SCHWARZ LXi |
LX1
Home
Lan Configuration
IP Configuration
mDNS and DNS-SD MDNS & DNS-S0 v
Ping Client
ICMP Ping enabled
Status )
Utilities VXI-11 Discovery

Submit (Password required!)
Instrument Control

‘Web Control

Diagnostics

SCPI Remote Trace

Help

Glossary
www.rohde-schwarz.com

Mo error

© 2015 ROHDE&SCHWARZ. All rights reserved.

The following advanced parameters are available:

® "mDNS and DNS-SD": The additional protocols "multicast DNS" and "DNS service
discovery" are used for device communication in zero configuration networks,
working without DNS and DHCP.

® "ICMP Ping enabled": Must be enabled to use the ping utility.
If you disable this setting, the instrument does not answer ping requests. The set-
ting does not affect the LXI ping client. You can ping other hosts from the instru-
ment, even if the setting is disabled.

e "VXI-11 Discovery": Must be enabled to detect the instrument in the LAN.
If you disable this setting, the instrument cannot be detected by the VXI-11 discov-
ery protocol mechanism. The setting does not affect other detection mechanisms.
Setting up a VXI-11 connection via the IP address or the host name is independent
of this setting.

Ping Client

The "Ping Client" page provides the ping utility to verify the connection between the
LXI-compliant instrument and another device.

The ping is initiated from the instrument. Using the TCMP echo request and echo reply
packets, the function checks whether the communication with a device via LAN works.
Ping is useful for the diagnosis of IP network or router failures.

The ping utility is not password-protected.

To initiate a ping from the instrument to the device:

1. Enable "ICMP Ping" on the "Advanced LAN Configuration" page.
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2. Select the "Ping Client" page.

3. Inthe "Destination Address" field, enter the IP address of the device you want to

ping (without the ping command and without any further parameters), e.g.
10.113.1.203.

4. Select "Submit".

%HDE &SCHWARZ LX1

LXI

Lan Configuration

Status

Utilities
Instrument Control

‘Web Control

Diagnostics
SCPI Remote Trace

Help

Glossary

www.rohde-schwarz.com

Destination Address

Clear  Submit

PING 10.111.1.32 (10.111.1.32): 56 data bytes
64 bytes from 10.111.1.32: seg=0 ttl=64 time=0.280 ms

——— 10.111.1.32 ping statistics ---

Result 1 packets transmitted, 1 packets received, 0% packet loss
round-trip min/avg/max = 0.280/0.280/0.280 ms

No error

& 2015 ROHDE&SCHWARZ. All rights reserved

Web Control

The web control functionality provides remote operation via VNC using a Web browser
(with HTML5). This mode does not require additional installation or activation. The
VNC protocol allows simultaneous operation from several remote devices. The instru-
ment remains locally operable.

The GUI of the R&S SMB is visible. To perform the settings, you can operate the
instrument as with the manual control. The instrument controls are available via the
front panel simulation. File upload and download between the instrument and the
remote PC is also available.

Starting a Remote Control via the LXI web browser

This section assumes that the instrument and the controller PC are connected in the
LAN.

1. Start a web browser that supports htmlI5 (W3C compliant).

2. Enter the IP address of the R&S SMB in the browser's address bar.
The R&S SMB's welcome page is displayed.
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3. Inthe navigation pane, select "Instrument Control" > "Web Control".

Remote access to the instrument requires the password. The default password is
instrument.

4. Enter the password.

5. Confirm with the [Enter] key.

After the connection is established, the current screen of the R&S SMB is dis-
played in the browser window.

File  Edit  “iew Favorites  Tools  Help
B v B v =1 d= v Pagew Safetyv Toolsv @~

Connected (unencrypted) to: rssmb100a100020:0
Freq RFON  MODON

| 311.000 000 000 [ | | l][] 0fden |

RfSweep, ALC-Auto Info
F [1:|NRP-ZB1 -59.59 dBmﬁwg]

e | I On

6. Use the mouse cursor and keyboard to access the functionality of the instrument
as you would directly perform the settings on the instruments front panel.

SCPI Remote Trace

The remote trace functionality allows you to trace input and output strings at the
remote control interface of the R&S SMB.

A recorded trace (message log) can be evaluated directly in the dialog. Use the high-
lighting and navigation functions provided in the lower toolbar to locate error messages
and messages containing arbitrary search strings. You can also export the message
log to a * . csv file and evaluate the file using a suitable program.

To trace and display messages:

1. In the navigation pane, select "Diagnostics" > "SCPI Remote Trace".

2. In the toolbar bar of the "SCPI Remote Trace" page, select "live mode" > "on" and
llloggingll > llonll.
"live mode > on" displays all commands and responses, and "logging > on" also
traces messages.
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3. If you now control the R&S SMB with SCPI commands, using an appropriate tool,
the SCPI remote trace records the information sent and received.

ROHDE&SCHWARZ LXi

LXI

Home

Lan Cenfiguration
Status

Utilities

live mode: (@ on (_Joff logging: ® on | off A7 fiter - log file: | & refresh | | ] download | | 3¢ clear =] detaits

rec MT
Instrument Control o

| 'message
1 *idn?
1 Rohde&Schwarz, <instrument, 12345 67890>
Web Control 1 ‘*opt?
1 0
1 Freq?
1
1
1
1

Diagnostics
1000000000

LEY -20
LEW?
-20

ocooooooo
L S R )

Help

Glossary
www.rohde-schwarz.com

20 live records received

® 2015 ROHDE&SCHWARZ. All rights reserved

The function records all sent commands, received responses and messages, and
stores them in an internal database. If "live mode" is disabled, you can display the
recent traces upon request, using the "refresh" button. You can also store the log in
a file.

Note: The diagnostics functionality is extended in later releases, e.g. to download
or upload SCPI command files from / to the instrument.

Toolbars

The toolbar at the top of the dialog provides basic settings and functions.

live mode: (® on (_off logging: ® on off 5¥ fitter ~ log file: | & refresh ¥/ download | 3 clear [E=] details

® "Live mode" / "logging": If logging is switched on, messages are traced. They are
stored in an internal database and can be displayed upon request, using the
refresh button (live mode off) or they can be displayed automatically (live mode
on).

® "Filter": applies a filter to columns and/or rows when working (live mode off)
® "Refresh": reads the message log from the internal database and displays it
® "Download": stores the SCPI trace log to a * . csv file

e "Clear": deletes all message log entries in the database and on the screen

e "Details": displays details of the selected message, for example an SCPI command
in hex format (also possible by double\-clicking a message)
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Columns
The following columns are available if no column filter is applied:

® "Rec": record number of the message within the message log
® |: number of the subinstrument

e "MT": indicates the type of the message. Possible values and related message
contents are:

— > =incoming command
— < =outgoing response to a query
— E = error message, highlighted by red color

— T = execution time, i.e. time required by the instrument to process the com-
mand internally

® "message": indicates the type of the message. Possible values and related mes-
sage contents are:

— > =incoming command
— < =outgoing response to a query
— E = error message, denoted in red

— T = execution time, i.e. time required by the instrument to process the com-
mand internally

3.2 Instrument Tour

3.2.1 Front Panel Tour

The front panel of the R&S SMB consists of the VGA display, some utility keys (left
side) and the hardkey area with connectors and control interfaces (right side). The sub-
sequent sections provide brief explanations on the controls and connectors, the hard-
key area and the front panel.

SMB 100A - SIGNAL GENERATOR - 9kHz..6 GHz

@@@m

ALC-Auto
ONOFF
-- m“ﬁs‘ 4-90 — D [3 [3

a[|[s]:::

El@ﬂ

Figure 3-1: Front panel view
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Utility Keys

The keys to the left of the display cause the R&S SMB to return to a definite instrument
state and provide information on the instrument and assistance.

For more information refer to chapter "Instrument Settings".

[PRESET]
Sets the instrument to a defined state (see Chapter 3.1.13, "Default Settings",
on page 29).

[LOCAL]
Switches from remote control to local (manual) control.

[SETUP]
Opens the "Setup" dialog for configuring presettings.

For more information, see Chapter 4.2.3, "General Configuration of Instrument - Setup
Key", on page 97.

[File]
Activates the menu for storing or loading files (see Chapter 3.5.1.8, "File Manage-
ment", on page 86).

INFO
Displays status messages, error messages and warnings.

[WINBAR]
Toggles between the diagram and active menus.

[HELP]
Displays context-sensitive help text.

Standby LEDs and Standby Key

The standby LEDs and the [ON/STANDBY] key are located in the bottom left corner of
the front panel.

The [ON/STANDBY] key toggles the instrument between standby and ready state (indi-
cated by the standby LEDs).

The standby LEDs indicate the instrument states as follow:
® the green LED (left) is on when the instrument is ready for operation,
® the yellow LED (right) is on in the standby mode.

See Table 3-1.
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3.21.3 Display

The display clearly shows all main settings and signal generator states.

The display is divided into the following sections:

® Frequency and level display with info line
— Frequency and level settings containing offset.
— Status messages

— Brief error messages.
To access an window with detailed information for a message, use the [INFO]
key.
® Block diagram
The block diagram shows the current configuration and the signal flow in the gen-
erator with the aid of function blocks containing an on/off switch. Selecting a func-
tion block opens a list of associated setting menus. Active menus, info windows
and graphs are displayed on top of the block diagram. The block diagram can be
displayed in the foreground anytime with the [DIAGRAM] key.

For detailed information, see Chapter 3.5.1.3, "Display”, on page 71.

3.21.4 Setup Keys

The keys to the right of the display set parameters, select views and control the win-
dows.

Keys for Setting Parameters

These keys provide direct access to the settings in the header of the instrument for fast
setting the RF signal.

For more information refer to chapter "Instrument Functions".

B
§

U

1

[FREQ]
Activates frequency entry.

[LEVEL]
Activates level entry.

[ ON/OFF TOGGLE]

® Switches highlighted elements or a function block on and off.

® Switches between two or more settings, e.g. items of selection lists. At the end of a
list, the cursor is set on the first entry again.
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[BACKSPACE]
Deletes the character to the left of the cursor.

Display Keys

The keys assigned right to rotary knob arrange different windows on the display, and
turn the RF signal and the modulation on and off.

[DIAGRAM]
Brings the block diagram to the foreground. Active menus are minimized.

[ESC]

The function of this key depends on the current cursor position.

® (Calls the next higher selection level.

® Closes the open window without accepting new entries; the old value or parameter
is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or to
the previously highlighted block in the block diagram if no menu is active.

[MOD ON/OFF]
Switches the modulations on and off.

"MOD OFF" is displayed in the info line of the header next to the "Level" field.

[RF ON/OFF]
Switches the RF signal on and off.

"RF OFF" is displayed in the header next to the "Frequency" field.

Keypad for data entry

The keys in the data entry keypad are used to enter alphanumeric data and units.

Data entry keys are only enabled while the cursor is placed on a data input field in a
dialog. Their function depends on the data type of the input field.
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Keys Description
0...9/abc Enters the corresponding numbers (in numeric input fields) or characters (character input
fields).

Inserts a decimal point (numeric input fields) or dot (character input fields) at the cursor
position. Multiple decimal points are not allowed.

Unit keys Selects a unit and thus determine the absolute value, or changes the unit, i.e. trigger a
recalculation without changing the absolute value. The function depends on the time at
which the [Unit] key is used during parameter entry (see "Working with Units" on page 81).

For unit-free values, the [x1] key is equivalent to [ENTER]. It confirms the previous entry
and deactivates the input field.

Adds a blank in a character input field.

L H# Enters special characters. Toggles through the available characters if the key is pressed
several times in a row.

A<->a Toggles between uppercase and lowercase characters.

A, B,C,D, Enters hexadecimal values. The letters assigned to the keys are automatically active when
E,F an entry field with a hexadecimal value is active.

[ENTER]

Pressing the rotary knob has the same effect.

® Concludes the entry of dimensionless entries. For other entries, this key can be
used instead of the default unit key. The new value is accepted.

Confirms ("OK") and closes open input windows.

In a dialog box, selects the default or focused button.

In a dialog box, activates the edit mode for the focused area, if available.

In a dialog box, activates or deactivates the selected option of the focused area, if
the edit mode is active.

® (Calls the next menu level.

3.21.6 Rotary Knob and Navigation Keys

The rotary knob and the arrow keys are alternative control elements for data variation
and navigation in the graphical user interface.
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[Rotary Knob]

The rotary knob has several functions:

® Increases (clockwise direction) or decreases (counter-clockwise direction) numeric
values at a defined step width in editing mode

Moves the cursor, e.g. to a function block in the block diagram

Scrolls within lists, tables or tree views

Acts like the [ENTER] key, when it is pressed.

Shifts the selection bar within focused areas (e.g. lists), if the edit mode is activa-
ted.

Note: Turning or pressing the rotary knob is equivalent to pressing the [Up] and [Down]
keys or the [ENTER] key in the keypad.

[Navigation Keys]

The navigation keys consist of 4 arrow keys which are used for navigation, alternatively
to the rotary knob.

[UP/ DOWN The up and down arrow keys do the following:

Keys] ® In a numeric edit dialog box, increase or decrease the instrument

parameter.
® |n a list, table, window or dialog box, scroll vertically.

[LEFT/ RIGHT The left and right arrow keys do the following:

Keys] ® |n an alphanumeric edit dialog box, move the cursor forward and

back.
® |n a list, table, window or dialog box, scroll horizontally.

3.2.1.7 Front Panel Connectors

The RF and LF output connectors and a connector for external modulation signals are
located on the front panel.

MOD EXT

© n exr

Input for external modulation signals.

[LF]

©

Output for internal LF modulation generator signal.

See also data sheet and Chapter 4.5.1, "Overview of LF Generator", on page 223,
Chapter 4.5.2, "LF Output", on page 224.
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RF 50 Ohm
Output for RF signal.

NOTICE! Maximum Input Levels. Do not overload the RF output.

The instrument is equipped with a reverse power protection that prevents the RF out-
put against back feed, see Chapter 4.3.5.7, "Reverse Power Protection”, on page 167.
Nevertheless, the maximum permisssible reverse power is specified in the data sheet.

Depending on the equipped frequency option, the RF output connectors vary.

RF Option Microwave Option

<) _ RFS0C RFsoc (=

NP 1\ )|

Frequency options Connector Frequency options Connector
type type
test port
R&S SMB- B101 N female R&S SMB-B112/-112L adapter, PC 3.5
mm female
R&S SMB-B102 R&S SMB-B120/-B120L
R&S SMB-B103 R&S SMB-B131 test port
R&S SMB-B140/-140L/-B140N | 2dapter, PC
2.92 mm female
R&S SMB-B106

NOTICE! Risk of RF connector and cable damage. If you tighten the connectors too
strongly, you can damage the cables and connectors. If you do not tighten the connec-
tors enough, the measurement results can be inaccurate.

Always use an appropriate torque wrench suitable for this type of connector and apply
the torque specified in the application note 1MA99.

The application notes are available on the Internet and provide additional information
on care and handling of RF connectors.

Rohde & Schwarz offers appropriate torque wrenches for various connectors. For
ordering information, see the R&S SMB data sheet or product brochure.

3.2.2 Rear Panel Tour

This section gives an overview of connectors on the rear panel of the instrument. Each
connector is briefly described and a reference is given to the chapters containing
detailed information. For technical data of the connectors refer to the data sheet.
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IEEE 488 (ECE)

USB IN

£

Ny

PULSE PULSE INST SIGNAL
VIDEO IS TRIG @ VALD o,

Figure 3-2: Rear panel view

3.2.2.1 Description of the Connectors

m [Fuses]
The R&S SMB is fully fused by two fuses IEC60127-T3.15H/250 V.
CC,

The fuses are accommodated in the fuse holders next to the power connector. Use
only fuses of the mentioned type.

[AC supply and power switch]

When the R&S SMB is connected to the AC supply, it automatically sets itself to the
correct range for the applied voltage (range: see type label). There is no need to set
the voltage manually or change fuses.

The power switch can be set to two positions:
e 0

The instrument is disconnected from the mains.
o |

The instrument is power-supplied. It is either ready for operation (STANDBY) or in
operating mode, depending on the position of the [ON/STANDBY] switch on the
instrument front.

See also data sheet andChapter 3.1.6, "Connecting to Power", on page 24.

USB IN [USB IN]
USB (universal serial bus) interface of type B (device USB).

This interface can be used for remote control of the instrument.

[USB Connectors type A]
USB (universal serial bus) interfaces of type A (host USB).

® Connection of peripherals such as mouse, keyboard, etc.
® Connection of memory stick for file transmission
® Firmware update

See Chapter 3.1.9, "Connecting USB Devices", on page 25.
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[LAN Connector]

Ethernet interface

® Forintegrating signal generators in a network
® Remote control of signal generator

® Remote access to the signal generator

® Firmware update

See also:
® Chapter 3.1.7, "Connecting to LAN", on page 24
® Chapter 5.1.3, "LAN Interface", on page 242

[IEC 625/IEEE 488]
IEC-bus (IEEE 488) interface for remote control of the instrument.

See also Chapter A.1, "GPIB Bus Interface", on page 508 and Chapter 5.1.6, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 246.

Note: In order to avoid electromagnetic interference (EMI) caused by open lines,
always terminate any connected IEC-bus cable with an instrument or a controller.

[Stereo R/L]

Inputs for analog stereo modulation signals. External modulation sources or the inter-
nal LF generator can be used (stereo modulation is available with option R&S SMB-
B5).

See also Chapter 4.4.6, "Stereo Modulation", on page 217.

[S/P DIF]
Input for digital stereo signals (stereo modulation is available with option R&S SMB-
B5).

See also Chapter 4.4.6, "Stereo Modulation", on page 217.

SIP DIF .
Ca

[SIGNAL VALID]
Output of valid signal. This signal marks the valid signal times (valid level and fre-
quency indication). The signal is generated automatically.

[INSTR TRIG]
Input for external trigger for sweeps and list mode.

See also Chapter 4.3.7.4, "List Mode", on page 192 and Chapter 4.3.7.1, "Overview",
on page 178.

[PULSE VIDEO]
Output of internal pulse generator signal or external pulse signal fed in via the [PULSE
EXT] connector (video signal).

See alsoChapter 4.4.5, "Pulse Modulation (PM)", on page 214 .
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[PULSE EXT]
Input of external pulse signal or input of external trigger/gate signal for internal pulse
generator.

See alsoChapter 4.4.5, "Pulse Modulation (PM)", on page 214 .
Hanic.d [REF OUT]

I Output of internal reference signal.

: See also Chapter 4.3.4, "Reference Oscillator", on page 142.
REFIN—&) [REF IN]
Input for external reference signal.

See also Chapter 4.3.4, "Reference Oscillator", on page 142.

[OCXO]
® Oven-controlled reference oscillator (option R&S SMB-B1)
or

® high performance oven-controlled reference oscillator (option R&S SMB-B1H)

The OCXO generates a very precise 10 MHz reference signal. It needs some minutes
of warm-up time to reach its nominal frequency.

Refer also to the data sheet for detailed information.

3.3 Trying out the Instrument

This section provides an example on how to configure the instrument for generating of
an amplitude modulated signal.

Generation of an Amplitude-Modulated Signal
To generate a simple AM-modulated signal, proceed as follow:

1. Activate default (preset) state
Press the [PRESET] key to set a defined instrument state.
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Freq RF OFF | MOD OFF | Level

| 1.000 000 000 0o+ -] [ -30.00 ¢em -]

| ALC-S&H Info
Mod Gen Modulation RF
config... | config... | config... | . RF
+ + —(
" on [T on [T on

2. Select and activate AM modulation

a) Turn the rotary knob and select the "Modulation" block.

Modulation
config...

[~ on

b) Press the rotary knob to open the dialog where the modulation can be selected.
Note: Different modulation modes are available depending on the options
installed.

Modulation
Amplitude Modulation..
Freguency Modulation...
Phase Modulation. ..
Pulse Modulation...

The "Amplitude Mod..." menu is the first menu and is highlighted per default.
c) Turn the rotary knob and highlight "Amplitude Mod...".
Press the rotary knob to open the "Amplitude Modulation" dialog.

O
State Off

AM Source IInt 'I
AM Depth I 30.0 I % vl

AM Source = INTernal

LFGen Freq I 1.000 00 IkHz 'l

d) Turn the rotary knob to select parameter "AM Depth", press the rotary knob to
allow editing and enter the preferred AM depth with the aid of the numeric key-
pad and the unit keys.

Amplitude Modulation

State Off |
AM Source IInt 'I

AM Depth [m % =

AM Source = INTernal

LFGen Freq I 1.000 00 IkHz 'l
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e) Finally, select "State" and press the rotary knob to switch on the AM modula-
tion.

mEd
State

AM Source IInt 'I
AM Depth | 200 |% vI

AM Source = INTernal

LFGen Freq I 1.000 00 IkHz 'l
f) Press the [DIAGRAM] key to display the complete block diagram.

To indicate the active state, the "Modulation" block is displayed in blue. The "RF" is
not yet active, which means that no RF signal is output.

3. Set frequency and level and activate RF signal

a) Press the [FREQ] key to activate the editing mode for frequency entry. The
"Frequency" entry field in the header section of the display is highlighted.

Freq[ RFOFF_|[WMODONT]
1.000 000 000 00/t |

Enter the frequency using the numeric keypad and terminate the entry by
pressing a unit key.
b) Press the [LEVEL] key and enter the level settings in the same way.

|-3[].[][] IdBm v[

c) Press the [DIAGRAM] key to display the complete block diagram.
d) Turn the rotary knob to select the "RF" block.
Press the [RF ON/OFF] key to activate the "RF" block.

The AM modulation signal is now present at the RF output.

Leve

Freq |
| 363.000 000 00 [wz ~|{ -11.00fdem ~|
|

LiSweep, ALC-S&H Info

RF
&

Generation of an RF Frequency Sweep Signal
In the example, an RF frequency sweep is configured. Proceed as follow:

1. Activate default (preset) state
Press the [PRESET] key to set a defined instrument state.
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Freq RF OFF | MOD OFF | Level

| 1.000 000 000 0o+ -] [ -30.00 ¢em -]

| ALC-S&H Info
Mod Gen Modulation RF
config... | config... | config... | . RF
+ + —(
" on [T on [T on

2. Configure and activate RF frequency sweep.

a) Turn the rotary knob and select the "RF" block.

b) Press the rotary knob to open the dialog where the RF frequency sweep can be
selected.

RF Sweep /List
Fregquency Sweep. ..
Lewel Sweep..

List Mode. ..

c) Turn the rotary knob and highlight "RF Frequency Sweep...".
Press the rotary knob to open the "RF Frequency Sweep" dialog.

RF Frequency Sweep

|State off |=
Mode |Autn j
Start Freq 100.000 000 000 | MHz x| —

4

300.000 000 000 [ MHz |
400.000 000 000 [MHz =1 =]

Center Freq

|

Stop Freq | 500.000 000 000 | MHz x|
|
I

Span

All sweep parameters are default except for the sweep mode. The default set-
tings are not changed.

d) Turn the rotary knob to select parameter "Mode", press the rotary knob to open
the selection list and select "Single".

RF Frequency Sweep

State Off | =

|Mnde Single -
Auto

Start Freq | 1008inale. . k...]—
Step

Stop Freq | 500 Extern Single
Extern Step

Center Freq I 300 Extern Start/Stop

Snan [400.000 000 000 [MHz_~1 =]

e) Press the rotary knob to apply the selection.
For triggering, the "Execute Single Sweep" and "Reset Sweep" buttons are dis-
played.
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f) Finally, select "State" and press the rotary knob to switch on the RF frequency

sweep.

RF Freguency Sweep

|State ;
Mode |Sing|e : j

Execute Single Sweep | -

Reset Sweep |

Start Freq | 100.000 000 000 | MHz x|

Ca_ T I connnn ann nnn Tean_ 1

g) Press the [DIAGRAM] key to display the complete block diagram.

-

The "RF" is not yet active, which means that no RF signal is output.
3. Activate RF signal.

a) Turn the rotary knob to select the "RF" block.
b) Press the [RF ON/OFF] key to activate the "RF" signal output.

v

To indicate the active state, the RF block is displayed in blue. An RF signal with the
default frequency and level settings is output, i.e. 1 GHz and -30 dBm.
The sweep is not yet active, it must be triggered in the sweep dialog.

4. Trigger RF frequency sweep

a) Press the [Winbar] key to switch to the "RF Frequency Sweep" dialog.
Turn the rotary knob to select the "Execute Single Sweep" button.

RF Freguency Sweesp
e
Mode | Single |

| Execute Single Sweep | |—

Reset Sweep |

Start Freq | 100.000 000 000 | MHz |

-
Cene (P I ennann nnn ann [ean- 1

Press the rotary knob to trigger (start) the frequency sweep.

A linear single sweep signal is now present at the RF output, starting at 100 MHz.
The sweep is processed in 1 MHz steps with dwell time of 10 ms per step up to the
stop frequency of 500 MHz.

The sweep starts at 100 MHz, stops at 500 MHz in 1 MHz steps is output with a
dwell time of 10 ms per step.
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3.4 System Overview

This section helps you to get familiar with the R&S SMB. It provides an introduction to
the general concept of the instrument with a sample of the possible application fields. It
also describes the main blocks in the signal generation flow.

For information on how to access functions and interact with the R&S SMB, refer to
Chapter 3.5, "Instrument Control", on page 66.

3.4.1 Brief Introduction to the Instrument's Concept

The R&S SMB is a high-performance signal generator developed to meet demanding
customer requirements. Offering excellent signal characteristic and straightforward and
intuitive operation, the signal generator makes signal generation fast and easy.

3.4.2 Signal Flow at a Glance

The R&S SMB is equipped with an intuitive user interface. The central element of the
display is the block diagram that shows the signal flow and processing from the left on
the display to most right, i.e. the generated signal can be seen at a glance.

Each block represents a functional unit of the instrument. Thus you always know the
position at which a parameter affects the signal flow. The main settings of a block are
indicated in the block. The interconnection of employed inputs and outputs is also
shown. The user is thus always informed about the connection of inputs and outputs in
the signal flow and where they can be configured. A window is opened for each menu
where parameters can be set. When the window is opened, an entry is made in the
"Winbar" below the display. All open menus are of equal priority (not modal) and can
be accessed any time.

The block diagram in the figure below shows a fully equipped instrument.

Level

Freq |
| 363.000 000 00 u= || -11.00éom -]
I

LiSweep, ALC-S&H Info

x
Jv| Jv| v |

Figure 3-3: Block diagram of a fully equipped R&S SMB
With the rotary knob, you can navigate in the block diagram and the dialogs, and oper-

ate the instrument with one hand. The cursor is moved line by line through the block
diagram or dialog. Turning the button clockwise advances the cursor. The selected
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block can be activated or deactivated with the [TOGGLE] key. Active blocks are high-
lighted by a colored background.

The instrument comprises a comprehensive info and help system. You can access the
context-sensitive help with the [HELP] ([F1]) key at any time. The help system indi-
cates the currently selected parameter and offers additional services such as cross ref-
erences, index and contents. The content of the help system corresponds to the oper-
ating manual of the instrument.

Warning and conflict messages caused by incorrect operation as well as further infor-
mation are displayed in the "Info" line. A complete list of existing conflicts is displayed
when the [INFO] ([CTRL+I]) key is pressed. Additional information on entries can be

requested from the help system. The history function permits display of all messages.

Assistants simplify the completion of tables. After data entry in the assistant, the table
is modified only after the "Accept” button has been pressed. Pressing the "Accept” but-
ton also stores the assistant data.

See Chapter 3.5, "Instrument Control", on page 66 for an overview on how to work
with the instrument.

For an in-depth description of the dialog boxes and the instrument functions, refer to
section Chapter 4.1, "Overview of Instrument Functions", on page 94.

3.4.3 Application Field of the Instrument
The main field of application of the R&S SMB is the generation of sine wave signals
with very high spectral purity. These signals are needed e.g. for adjacent channel or
phase noise measurements. In addition, the RF signal can be modulated with the inter-
nal modulations waveforms sine waves and rectangular signals.

3.4.4 Description of Individual Diagram Blocks

The signal path of the instrument is configured by installing a frequency option that
comprises all required modules.
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One of the following options must be installed.
@ ® R&S SMB-B101 (up to 1.1 GHz)
® R&S SMB-B102 (up to 2.2 GHz)
® R&S SMB-B103 (up to 3.2 GHz)
® R&S SMB-B106 (up to 6 GHz)
® R&S SMB-B112 (up to 12,75 GHz)
® R&S SMB-B112L (up to 12,75 GHz without attenuator)
® R&S SMB-B120 (up to 20 GHz)
® R&S SMB-B120L (up to 20 GHz without attenuator)
® R&S SMB-B131 (up to 31,8 GHz)
® R&S SMB-B140/-B140N (up to 40 GHz)
® R&S SMB-B140L (up to 40 GHz without attenuator)
Instruments without step attenuator provide a restricted level range at the RF output.
Refer to the data sheet for detailed information.
You can additionally get the following options for microwave instruments:
® upto 20 GHz (R&S SMB-B120/-B120L)
— high output power option R&S SMB-B31
— low harmonic filter option R&S SMB-B25
® up to 40 GHz (R&S SMB-B140/-B140L/-B140N)
— high output power option R&S SMB-B32
— low harmonic filter option R&S SMB-B26

See data sheet for detailed information.

Up-to-date information is available at R&S SMB homepage on the internet http://
www.rohde-schwarz.com/product/smb100a.html.

mMod cenj| Mod Gen block
ml The internal modulation sources are configured in this block. Also, the "LF frequency
I on sweep" can be activated here.

An internal LF generator is available as the internal source for the analog modulations
AM, FM and PHiM. Available modulation shapes are sine and rectangle.

The internal modulation signals are provided at the LF output at the front of the instru-
ment. The LF output signal and the modulations sources for the analog modulations
AM, FM and PhiM can be selected independently from each other.

A pulse generator provides single and double pulse modulation with selectable pulse
widths and periods. Additionally, an option is available to generate pulse train signals.

The R&S SMB offers three different sweep types (frequency sweep, level sweep and
LF sweep) to be activated alternatively. Each type has 6 modes which differ with
respect to the sweep cycle mode (continuous, individual and step-by-step) and trigger-
ing mode (automatic, internal and external). In the "Mod Gen" block, the LF sweep is
configured. Frequency and level sweep settings are accessed via the "RF" block.

Operating Manual 1407.0806.32 — 23 64


http://www.rohde-schwarz.com/product/smb100a.html
http://www.rohde-schwarz.com/product/smb100a.html

R&S®SMB100A Getting Started

System Overview

The status display in the block shows whether LF generator and/or a sweep are active.
The selected internal LF generator and/or noise source are switched on or off with the
[TOGGLE ON/OFF] key.

Modulation] Modulation block
C‘:_Ll The internal and external analog modulations are configured and activated in this
on block. The [MOD ON/OFF] key switches the active modulation(s) on/off.

The internal modulation sources are configured in the "Mod Gen" block. External
amplitude, frequency or phase modulation signals can be fed in at the input connector
[MOD EXT] at the front of the instrument. An external pulse signal is fed in via the BNC
connector [PULSE EXT] at the rear of the instrument. AC or DC coupling for external
feed is possible.

Modulation signals of up to two sources (internal and external source) can be com-
bined for AM/FM and PhiM modulation.

Available internal and external analog modulation modes are:
Amplitude modulation (AM)

Frequency modulation (FM)

Phase modulation (PhiM)

Pulse modulation (Pulse)

Stereo modulation (Stereo)

Note: For modulation modes that can be simultaneously used, refer to the R&S SMB
data sheet.

The status display in the block shows the active modulation(s). Use the [TOGGLE ON/
OFF] key to switch the active modulation of the block on or off.

RF block
In this block, the RF parameters and frequency/level sweep settings are set.

The active sweep is displayed in the block. The [RF ON/OFF] key switches the RF sig-
nal on and off. When the signal is switched off, the switch before the RF output symbol
is open.

RF settings include:

® Frequency and reference frequency

Level settings; if required.

NRP Power Viewer using power sensors

Frequency and level sweep

List Mode settings. In this mode, extremely fast frequency and level settings can be
made.

The [RF 50 Ohm] output connector at the front of the instrument provides the RF sig-
nal. An external trigger/gate signal for sweeps is input via the [INST TRIG] connector at
the rear of the instrument

Note: Frequency and level are set fast with the aid of the [FREQ] and [LEVEL] keys.
Use the [TOGGLE ON/OFF] key to switch the RF output on or off.
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3.5 Instrument Control

The operating concept of the R&S SMB employs the following three ways of instru-
ment control:

® Manual operation
® Remote control
® Remote access

3.5.1 Manual Operation

The R&S SMB can be operated intuitively either via the interactive block diagram or via
a menu tree. All menus are in the form of windows that can be operated in the same
way. Rotary knob, keys and softkeys, or alternatively a mouse, allow direct and there-
fore convenient access to entries and settings.

The display shows the current signal generator state. The embedded online help func-
tions supports you in signal configuration.

This section describes the concept of manual operation of the signal generator. It
includes a description of the general structure of a dialog box, working with dialog
boxes and the block diagram and the setting of parameters.

For an in-depth description of the instrument functions and dialog boxes, refer to Chap-
ter 4, "Instrument Function", on page 94.

3.5.1.1 Legend of Manual Controls
The following table lists all available key combinations used on the PC keyboard to trig-
ger functions on the instrument. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 3-3: Overview of the keyboard key combinations and their function

Key of PC keyboard Short description Function

RV Special characters Enters a special character, e.g. period/
decimal point.

+/- Sign Enters the sign.

-/ (shift+) a—z A<->a Switches between upper-case and lower-
case letters.

ALT + F9 Units G/n / dBuV / dBu Selects the unit Giga/Nano, dBuV for the
RF level and dBu for the LF level.

ALT + F10 Units M/u / uv Selects the units Mega/Micro and uV for
RF levels.

ALT + F11 Units k/m / uV Selects the units Kilo/Milli and uV for RF
levels.
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Key of PC keyboard Short description Function
ALT + F12 Enter function Confirms entries in the base unit and val-
Unit dBm ues without a unit.
Selects dBm for the RF level and dB for
level offset and level step width.

Arrow keys Cursor Moves the cursor.

Backspace Clears entry Clears the last entry (number, sign or deci-
mal point)

CTRL +A Rearrange Arranges open dialogs automatically

CTRL+C Recalculate Starts recalculation of the signal.

CTRL+D Block diagram Sets the cursor on the block diagram and
hides all menus.

CTRL+E Setup menu Opens the setup menu for general instru-
ment settings.

CTRL+F1-F8 Softkey 1 -8 Triggers the function assigned to the soft-
key.

CTRL+ F Frequency Activates the frequency entry.

CTRL+ G Closes menus Closes an active menu.

CTRL+H Hide Minimizes the active menu. Pressing the
respective button in the Winbar opens the
menu again.

CTRL + | Info Opens/closes the info window

CTRL+L Level Activates the level entry.

CTRL+ M Menu Calls the menu selection list.

CTRL+ O Modulation on/off Switches modulation on/off. "MOD OFF" is
indicated in the status line.

CTRL+P Preset Restores a defined basic instrument setup.

CTRL +Q Local Switches the instrument from remote con-
trol to manual control.

CTRL+R RF on/off Switches the RF output signal on/off. "RF
OFF" is indicated in the status line. Both
RF output signals are always deactivated
in the case of two-path instruments.

CTRL+S Storage under Windows Activates the menu for storing instrument
settings.

CTRL+T Toggle on/off Switches a block or parameter on/off.
Toggles between the different possibilities
of setting a selection parameter.

CTRL+Y Hardcopy Opens the menu for configuring and start-
ing a hardcopy.

CTRL +W Winbar Displays the Winbar in the foreground/
background.

Enter Enter Terminates an entry.
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Key of PC keyboard Short description Function

ESC ESC Selects the next higher menu/selection
level. When the editing mode is exited with
ESC, the previous value is restored.

F1 Help Opens/closes context-sensitive help.

Ins Insert Activates the insert mode.

Front Panel Key Emulation

The R&S SMB provides a front panel key emulation to enable execution of the front
panel key functions by mouse e.g. for remote access. The emulation is called on the
external monitor by a right mouse click. The front panel key functions are executed by
a mouse click on the associated button.

Freq Diagram
Level | Menu
File | Rearr.

|
|
el ||
|

Mod 0nIO1'f| Help

Preset

Local

i

Sefup

Hardcopy

i}

On-screen Keyboard

In addition, the Windows XP operating system provides a keyboard emulation that can
be used for system settings if no external keyboard but a mouse is available.

To access the on-Screen Keyboard, select "Start > Programs > Accessories > Accessi-
bility > On-Screen Keyboard".

B8 On-Screen Keyboard |._||_,fg|
File keyboard Settings Help
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3.5.1.2 Key Elements

The manual operating concept of the R&S SMB enables the user to make settings as
intuitively as possible and at the same time gives a permanent overview of characteris-
tics of the generated signal and of the current instrument state. Numerous online help
functions support user settings.

Block diagram
The block diagram is the core of the operating concept.

A graphics display shows the current configuration and the signal flow in the form of a
block diagram. All graphical elements can be accessed for operation. An element is
selected by means of the arrow keys and the associated setting function is called by
pressing Enter. Required menus and graphs are displayed on the block diagram which
is displayed again in the foreground whenever the [DIAGRAM] ([CTRL+D]) key is
pressed.

The main characteristics of the RF signal, frequency and level, are permanently dis-
played in the header section of the screen and can be directly set in the display fields
after the [FREQ] (CTRL+F) or [LEVEL] (CTRL+L) key is pressed. Status messages for
the output signal are displayed in addition to frequency and level.

freq(_RFON )(__MODON ) Level

[1.000 000 000 000/ etz ~1|-30.00]éem -]

Operation via Graphical User Interface

® Functional blocks
Menus are assigned to the specific function blocks in the block diagram. The func-
tion blocks represent elements of signal generation. Function blocks displayed with
a blue frame can be directly switched on and off by means of the [TOGGLE ON/
OFF] (CTRL+T) key. The menus of the highlighted function blocks can be called by
pressing the [ENTER] key.

— Example:
The "Modulation" block contains all menus required for modulation signal con-
figuration.

In this block all modulations can be selected.

Modulation
Amplitude Modulation..
Freguency Modulation...

Phase Modulation. ..
Pulse Modulation...

e Signal flow
The signal flow between the function blocks and the employed inputs and outputs
are also shown.
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® Menu tree
The menu tree can be opened and closed with the [MENU] (CTRL+M) key. The
menu tree is organized in the same way as the directories under Windows. The
function blocks correspond to the first directory level, the menus to subdirectories.

=+Mod Gen
Madulation Generator —
LF Generator / Output...
LF Frequency Sweep...
Pulse Generator...

Operation corresponds to the Windows concept

To offer the user a familiar environment, operation is very similar to operation of Win-
dows user interfaces. All menus and tables are made up of known elements, such as
selection lists, check boxes and entry fields.

A blue frame indicates that the selected item is active. In the highlighted element,
entries can be made.
Rotary knob

T~ Operation is possible via front-panel keys, an external keyboard and the mouse. How-
ever, most of the settings can be easily made with the rotary knob:

® Turning the rotary knob shifts the entry focus to the target element.

® Pressing the rotary knob activates the selected entry field.
Depending on the parameter, the submenu is called, the numeric value varied, the
list entry selected or the check box activated or deactivated.

® |f avalue is entered, the entry is stored by another click on the rotary knob and the
editing mode is exited.
Settings in subdialogs

A separate window is opened for each dialog and subdialog. The dialogs can be oper-
ated independently of each other, i.e. none of the dialogs requires that settings in other
dialogs be completed before it can be closed. This ensures flexible operation at all
times.

Keys with assigned simple functions

Most keys on the front panel of the R&S SMB directly perform a simple function.

Since a great number of settings can thus be made by a keystroke, operation is easy.
For instance, the [CLOSE] (ESC) key closes the active menu; with the [RF ON/OFF]
(CTRL+R) key the RF output signal can be switched on or off.
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An exception are keys that call a menu such as the [MENU] (CTRL+M) key which
opens the complete menu tree of the instrument, the [SETUP] (CTRL+E) key which
opens the menus for general instrument settings or the [FILE] (CTRL+S) key which
opens the menu for file management.

Help functions for user support
Numerous help functions support the user in signal configuration.

® Value ranges
The valid setting range is displayed for each numeric parameter. This requires a
short wait after activation of the entry field. The range is then displayed automati-

cally after a few seconds.
Phase Seftings

Delta Phase Wo||deg +
Reset Delta Phad Min =-720.0 deg

Max =720.0 deg

insert mode

If the entered value is outside the permissible range, the next permissible value is
automatically set and a message is output.

® Context-sensitive help
Context-sensitive help for each parameter can be called with the [HELP] or [F1]
key.

® Comprehensive online help
Each help page is part of a comprehensive online help function which can be
called by means of an index, a content tree or the "Previous/Next" buttons.

Info line with messages for indication of the current instrument state

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. With the aid of the
[INFO] (CTRL+I) key, help pages can be called for most of the messages. They pro-
vide background information on the message and indicate operating steps that may be
required. All messages are explained in the online help which can be called with the
[HELP] (F1) key.

Freq((_REON ) WMODOFF ] Level

[1.000 000 000 000tz ~{[-30.00]éem |

| ALC-Auto Infa |

3.5.1.3 Display

The display shows the current signal generator state and offers graphical elements for
direct operation. It is divided into three sections:

® The frequency and level display with info line indicates the main output signal
parameters and reports the current state with status, error and warning messages.

® The block diagram shows the instrument configuration, the signal characteristic as
well as the inputs and outputs used and permits interactive operation via graphics
elements. Active menus and graphs are displayed on top of the block diagram.
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® Winbar with labeled softkeys for menu display.

The block diagram in the figure below shows a fully equipped instrument.

Freq Level
[ 1.000 000 000 0 |ctz~|| -30.00 | d&m -]
| ALC-S&H Info |

MOD

Mod Gen
I on v Iv|

Figure 3-4: Block diagram of a fully equipped R&S SMB

Settings Displayed in the Header Section

Frequency/level settings and a few status messages (see "Status Information and

Messages" on page 72) are displayed in the header field of the screen. The display

may vary depending on the instrument's operating mode:

® |n the sweep mode, the current frequency or level of the output signal is displayed.
The status message "SweepMode" is displayed in the info line.

® In the list mode, neither the current frequency nor level is displayed, the indication
is dimmed.

® |f user correction is active, the status message "UCorr" is displayed in the info line.

@ The values displayed in the "Freq" and "Level" fields include a set offset or multiplier
factor.

For more See alos Chapter 4.3.2, "RF Frequency", on page 138 and Chapter 4.3.5.1,
"Overview of RF Level", on page 146.

The frequency and level indication can be enlarged so that it covers the complete dis-
play of the R&S SMB by using the [DIAGR] key. This key toggles between block dia-
gram, magnified frequency and level indication and the display of the active dialog.
This requires the "Summary Screen Toggle" to be enabled.

See also "Toggle Summary Screen" on page 108.

Status Information and Messages

The instrument indicates status information and messages in the header section of the
screen. The messages differ with respect to their importance (errors, warnings, info)
and the time of their appearance (brief and permanent messages), and require differ-
ent treatment

For additional information refer to the info window (see "Info Window" on page 73).

Refer to Chapter 9, "Status Information, Error Messages and Troubleshooting”,
on page 499 for an overview of all status information and messages and corrective
actions.
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Status Information

The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status information is displayed between the frequency and level fields, at the left of the
info line or in the info line itself.

Messages

Messages indicate errors in the instrument. They are displayed in the info line in differ-
ent colors depending on their importance and display duration. Errors (e.g. no calibra-
tion data) are displayed in red, information (e.g. file not found) and warnings in black.
Warnings indicate less significant errors (e.g. the instrument operates outside specified
data).

Volatile messages

Brief messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument
(e.g. range violations). They are displayed in the info line on a yellow background.
They are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

These messages can be read from remote using the commands : SYSTem:ERRor | :
NEXT]? and :SYSTem:ERRor :ALL?.
Permanent Messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signalled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

These messages can be read from remote using the command : SYSTem:ERRor :
STATic?.

Info Window

A few operating states and the current message are displayed in the info line.

The [Info] window with a list of current permanent messages and a detailed description
of each message can be opened with the [INFO] (CTRL+I) key.
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The upper section of the info window contains a list of all current permanent messages
in the order of their occurrence, i.e. the most recent message is displayed first. In the
lower section of the window, additional information on the highlighted message is dis-
played. A history of all messages that have occurred since instrument switch-on can be
called with the "History" key. The most recent message is displayed first.

The messages are color-coded according to their level. Device-specific messages are
red, info and remote control error are black. The level is also indicated in the "Lev"
column (Err, Sys or Info). Column "SCPI" indicates the SCPI error code.

With the aid of the softkey buttons, error messages can be cleared and a history of all
messages called.

Delete
Clears the highlighted message.

This button is available only if the history of the messages is displayed.

Delete All
Clears all messages.

This button is available only if the history of the messages is displayed.

Remote command:
:SYSTem:ERRor:HISTory:CLEar on page 441

History

Calls the list of all messages that have occurred since instrument switch-on. The most
recent messages are displayed at the top of the list. When the button is pressed again,
the list of current messages is displayed.

Remote command:

:SYSTem:ERRor [ :NEXT] 2 on page 440 or : STATus : QUEue [ : NEXT] ? on page 436
:SYSTem:ERRor:HISTory? on page 440

Each time a SYST:ERR? or STAT : QUE? query is sent, the oldest entry in the error
queue is returned and at the same time cleared in the list.

Block Diagram

The block diagram shows provided options, signal configuration and the currently
selected signal flow of the generator with inputs and outputs used. Signal generation
can be completely operated from the block diagram. The highlighted function block can
be directly switched on and off with the [TOGGLE ON/OFF] (CTRL+T) key. Pressing
the Enter opens the associated setting menu.
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Figure 3-5: Block diagram of the R&S SMB

Function Blocks in the Block Diagram

Each block represents a function of signal generation. The function is indicated in the
headline of the block. In the check box, the respective function can be quickly activa-
ted/ deactivated with the [TOGGLE ON/OFF] (CTRL+T) key. After activation, the block
is displayed in blue. Status information is displayed below the check box. It is different
for the different blocks.

Pressing the rotary knob (front panel) or the "Config..." button (mouse) opens the asso-
ciated setting menu.

Example: Modulation block

Modulation
Amplitude Modulation...
Freguency Modulation. ..
Fhase Modulation...
Fulse Modulation...

In this block, the modulation signals are set. The status information of the "Modulation”
block indicates the selected modulation.
Signal Flow and Input/Output Symbols in the Block Diagram

The input/output symbols in the block diagram show the currently used inputs and out-
puts of the signal generator. Unused inputs and outputs are not shown. The lines indi-
cate the signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.

Example:

The symbols indicate the input for the external pulse signal on the
instrument rear panel.
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Structure of the Dialogs

The parameters are set in the menus. Menus are accessed either via the function
blocks in the diagram or by means of the [MENU] (CTRL+M) key. The menus are dis-
played on top of the block diagram.

The [WINBAR] key toggles between the active menus. The [REARR] key toggles
between the enlarged and normal sized menus.

Working with menus and dialog boxes is described in Chapter 3.5.1.4, "Accessing Dia-
logs", on page 76; the setting of parameters in Chapter 3.5.1.5, "Setting Parameters",
on page 77.

The menus are in Windows format. The menus differ in details depending on their
function but they consist of the same main elements. Each menu consists of a menu
header and one or more menu areas with various fields for setting parameters.

The header line contains the name of the menu and the buttons for minimizing and
closing the menu. To operate the buttons, use the mouse or the front key [CLOSE]
(ESC).

Several fields of associated but separately set parameters are organized in menu
areas. A menu area is framed and labelled with the function common to all parameters.

Example: Pulse Generator

Fulse Generator
Fulse Mode ISingIe vl

Fulse Period I 1.0000 Ims vl
FPulse Width I 500.0 Ius vl

Each of the setting fields is assigned a parameter name. The kind of setting varies
depending on the parameter to be set. Some settings can only be made in a specific
configuration. If setting is not permitted with the specific configuration selected, the
respective item is disabled and displayed in gray and the entry or selection field cannot
be accessed.

3.5.1.4 Accessing Dialogs
The [MENU] (CTRL+M) key opens the complete menu tree. Selecting a functional
block and pressing the [Enter] key opens the menu associated with this block.

An alternatively way to access a dialog is to use the [CLOSE] (ESC), [DIAGRAM]
(CTRL+D) and [REARR] (CTRL+A) keys on the front panel.

For a quick access to the dialogs, use one of the following alternative methods.

Displaying the block diagram or a dialog in the foreground

» Press the [DIAGRAM] (CTRL+D) key to move the cursor to the block diagram.

All active menus are minimized.

Operating Manual 1407.0806.32 — 23 76



R&S®SMB100A Getting Started

Instrument Control

Enlarging the indication of the header section

» Press the [DIAGRAM] key twice to enlarge the indication of the header section.

Tip: Use the [REARR] key to toggle between the enlarged and normal sized dia-
logs.

Accessing the menu tree

» Press the [MENU] (CTRL+M) key to open the complete menu tree.

Calling the File or Setup dialog

» Use the [FILE] (CTRL+S) or [SETUP] (CTRL+E) keys to open the respective dia-
log.

Closing an active menu

» Press the [CLOSE] key to close an active menu.

Tip: If the cursor is at the highest menu level, you can also use the [ESC] key to
close the active menu.

Accessing the header area

» Press the [FREQ] (CTRL+F) and [LEVEL] (CTRL+L) keys to activate the "Fre-
quency" or "Level" entry fields in the header area.

O Keyboard Shortcuts

Keyboard shortcuts (e.g. "Ctrl + D" for the displaying the block diagram in the fore-
ground) provide direct access to all utility dialogs of the instrument (see Chap-
ter 3.5.1.9, "Legend of Front-Panel Controls", on page 90).

3.5.1.5 Setting Parameters

The R&S SMB offers several and sometimes alternative possibilities for setting param-
eters. Operation is possible from the front panel, with the aid of a mouse and/or from a
PC keyboard.

@ The examples whitin this description focus on the operation from the front panel.
o For more information, refer to:

® Chapter 3.5.1.9, "Legend of Front-Panel Controls", on page 90 for an overview of
key functions and a cross-reference between the front panel keys and the key-
board shortcuts

® section "Instrument Functions" for a detailed description of key functions.

Most of the parameters are set in the different menus. The R&S SMB provides alterna-
tive ways for accessing the dialogs. Turn the rotary knob and navigate to the corre-
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sponding block in the block diagram and press the knob to open the dialog or perform
a mouse click on the "Config..." button.

An exception are the "Setup" and "File" dialogs. In the "Setup" dialog, general settings
are made which are not directly concerned with signal generation, e.g. setting of the
GPIB-bus address. In the "File" dialog, files and lists are managed.

These menus can only be called with the [SETUP] (CTRL+E) and [FILE] (CTRL+S)
keys.

Frequency and level are directly set in the header area of the display using the [FREQ]
and [LEVEL] keys.

Specific settings can also be made directly in the block diagram, e.g. activating a func-
tion block by means of the [TOGGLE ON/OFF] (CTRL+T) key or switching the RF out-
put on and off with the aid of the [RF ON/OFF] (CTRL+R) key. Changes affecting the
signal flow are immediately visible in the graphics display.

This section provides an information about the parameter handling that comprises of
the following main steps:

® "Working with the Cursor" on page 78

® "Selecting a Control Element" on page 79

® "Switching Parameters On/Off" on page 79

® ‘"Entering a Value" on page 79

® "Working with Units" on page 81

® "Selecting a Value from a List" on page 81

® "Terminating Entries with Confirmation" on page 82

® "Restoring the Previous Value" on page 82

Working with the Cursor

After the instrument is switched on, the cursor is always on the first function block of
the diagram (default setting).

Moving the cursor on the display

» To move the cursor, use one of the following alternative methods:

a) Use the rotary knob or the arrow keys.
b) Use the [Winbar] key to toggle between the active dialogs.
c) Use the [ESC] key.

Tip: Be aware that the function of the [ESC] key depends on the current cursor
position.

The function of this key depends on the current cursor position.

e Calls the next higher selection level.

e Closes the open window without accepting new entries; the old value or param-
eter is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.
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e Shifts the entry cursor from the header display to the previously active menu, or
to the previously highlighted block in the block diagram if no menu is active.
Moving the coursor to the heading area
» Press the [FREQ] (CTRL+F) or [LEVEL] (CTRL+L) key to move the cursor to the
header area.
Selecting a Control Element

Control elements are always selected in the same way no matter whether a function
block in the diagram, a menu in the menu tree, a parameter in the menu or an entry in
a list or table is concerned.

» To activate an element, put the cursor on it.

Source Ilmemal jl

An active element is highlighted by a blue frame.

Switching Parameters On/Off

A parameter can be activated and deactivated using a button or a check box.

1. Select the parameter.

2. To change the state of a parameter, use the "Enter" function of the different control
media:
e Press the rotary knob
e Press [ENTER]
e Press the [TOGGLE ON OFF] (CTRL+T) key.

Colour and label of a button change, the check box is ticked or the tick is removed.

Entering a Value

Numeric and alphanumeric values can be edited in the entry fields. In the editing
mode, cursors of different colour are used. A blue cursor indicates the overwrite mode,
a green cursor the insert mode.

Numeric and alphanumeric values can either be newly entered or the existing value
can be changed. Incorrect entries are cleared with the [BACKSPACE] key.

Entering a new numerical value
1. Select the parameter.
2. Press a numeric key to activate the editing mode.

The previous value is cleared and the new value can be entered.

Editing a value in the insert mode (default setting)

1. Press the rotary knob (= Enter) to activate the editing mode.
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If the cursor is placed at the right of the total value, the insert mode is always
active.

2. Set the cursor to the left of the number to be changed using the [Left/Right] arrow
keys.

The cursor is displayed in green.

3. Click on a numeric key to insert a new value.

|IDweIITIme | 1o.ocofms =|[owall Time | sl m= |

Editing a value in the overwrite mode
1. Activate the editing mode.

2. Set the cursor on the numeric digit to be changed using the [Left/Right] arrow keys.

The cursor is displayed in blue and the number to be replaced is highlighted.

3. Click on a numeric key to overwrite the highlighted value.

||Dwe||T|me | 10.000|ms Lﬂ"nwallﬂma | 1D.DD|mE: |

Varying a value
1. Activate the editing mode.

2. Set the cursor to the left of the number to be changed using the [Left/Right] arrow
keys.

The value at the cursor position is varied.
3. To vary the selected value, use the [Up/Down] arrow key or turn the rotary knob.

The value is increased or decreased.

Entering a new alphanumerical value
1. Select the parameter.
2. Press an alphanumeric key to start the editing mode.

The new value is entered.

Editing an alphanumerical value

An existing value, e.g. a file name, can be changed in the insert mode (see example)
or in the overwrite mode.

1. Select the paramter and activate the editing mode.

2. Set the cursor to the left of the alphanumerical value using the [Left/Right] arrow
keys.

Tip: If hexadecimal values are to be entered, the numeric front-panel keys are
automatically changed to hexadecimal values.

3. Click on an alphanumeric key to insert a new alphanumerical value.
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Terminating the entry of a numeric value
To terminate the entry of a numeric value:
1. Press the rotary knob (= Enter).

2. Press a [UNIT] key on the front panel.

3. Select a "Unit" in the selection field next to the parameter value.

Working with Units

The unit of a parameter is displayed next to the value. When the parameter is edited,
the unit is selected either from the list or by means of the front-panel keys. When the
entry is completed, the unit can be changed. In this case the value remains unchanged
but is automatically adapted to the new unit.

O While operating the instrument by means of a mouse, assign the unit to the selected
= parameter before entering its value.

Assigning a unit
To assign a unit to a value, use one of the following alternatives:

1. Press a [UNIT] key on the front panel.

B
Frequency 10 |GHz =|| + w =|Frequency I 10.000 000 DDDIMH;: v||

2. Select a "Unit" in the selection field next to the parameter value.
Press the [ENTER] key.

The unit displayed in the entry field next to the value is assigned.

Changing a unit

To subsequently change a unit, i.e. after the entry has been terminated and when the
editing mode is not active, use one of the following alternatives:

1. Press a [UNIT] key on the front panel.
2. Select"Unit" in the selection field next to the parameter value.

The value remains unchanged but the display is automatically adapted to the new
unit, i.e. the value is recalculated to suit the new unit.

B
Frequency |  10000.000 000 [kHz ||+ H =[Froquency | 10.000 000 DUDlMHzL"

The new unit is indicated in the value field of the menu.

Selecting a Value from a List

Selection lists provide a list of predefined values for the selected parameter.
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Source Internal  «

Internal
External

Cutput

To select a item from a list, proceed as follow:
1. Press [ENTER] key to open the list.

2. Use one of the following alternatives to navigate through the list:

a) Turn the rotary knob or use the [Up/Down] arrow keys.
The selected item is highlighted.

b) Press [TOGGLE ON/OFF] key several times until the preferred entry is dis-
played in the selection field.

3. To confirm the selection, press the [ENTER] key.

Terminating Entries with Confirmation

The instrument behaves different by the termination of entries deppending on the
parameter type and the way this parameter is set.

Confirming settings

» To confirm the settings, press the rotary knob or one of the [Unit] keys (see also
"Working with Units" on page 81) .

Note: Variations by means of the rotary knob are immediately set.

Confirming multiple values

In some cases, like for instance when editing data in a user correction table, it is useful
first to enter few values and to confirm them together. Such settings require additional
confirmation. Not yet confirmed settings are displayed on a yellow background as an
indication that the currently displayed values do not represent the target signal.

» To confirm these settings, select the "Save" or "Accept" button, respectively.

Confirming parameters with On/Off state

Most of the instrument functions with enabled and disabled states are calculated and
effective only after this functions have been enabled. However, there are functions like
the frequency variation of the reference oscillator for instance, that are immediately set
after confirmation.

» To confirm a parameter with On/Off state, enable the parameter.

Restoring the Previous Value

Parameter variations with the rotary knob are immediately set and therefore not rever-
sible.

Normally, values cannot be restored in the case of mouse control because no explicit
confirmation is required in this case and entries are automatically confirmed when the
entry or selection field is exited.
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Restoring values

In the case of front-panel control or operation from the keyboard, previous values can
be restored as long as the new value is not confirmed, i.e. the entry is not completed.

» To restore the values, press the [ESC] key.

Restoring values that require confirmation

All settings that are not confirmed with the "Accept" button but require this additional
confirmation can be restored.

1. Press the [ESC] key.

A confirmation query is displayed.

You changed some parameter(s) which require a new calculation of the signal.
Do you really want to abort your changes without ACCEPT ?

oK Cancel |

2. Confirm with "OK" to abort the changes.
Select "Cancel" to return to the dialog. The previous selected settings are dis-
played.

Restoring values after an extended calculation has been started

Calculation and setting might require different period of time. Many settings are made
without noticeable calculation times; such operations are indicated by a "BUSY" mes-
sage displayed in the status field of the header section.

A window with a progress indicates that the instrument performs an extended calcula-
tion that requires longer calculation time. The termination of such a calculation restores
the previous values.

» Press the [Abort] button to terminate the calculation.

All previous values are restored.

3.5.1.6 Editors

The R&S SMB provides user-friendly editors for defining lists. Lists containing fre-
quency and level value pairs are used for the list mode and the user-defined level cor-
rection.

The lists are saved to files and may thus have any length. The file name of the lists and
the directory to which the files are saved are user-selectable. The file prefix is different
for each list type and is permanently assigned by the system.

For information about file handling and overview of the automatically assigned file pre-
fixes, refer to Chapter 3.5.1.8, "File Management", on page 86.
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Working with List Editor

The "User Correction" and "List Mode" dialogs provide a list editor for defining the fre-
quency/level value pairs.

Editing list mode data lists

1. To access a list editor and open an existing data list for editing, use the cursor keys
to select the associated button "Edit User Correction Data..." or "Edit List Mode
Data..." (if available) in the individual menu.

The selected list is displayed and the cursor marks the first row of the
"Frequency/Hz" column.

FreguencyHz Fower/dBm |=
100 000.000: -140.00
100 010.000 -140.00
100 020.000 -140.00
100 030.000 -140.00
100 040.000 -140.00
100 050.000 -140.00
100 060.000 -140.00
100 070.000 -140.00
100 080.000 -140.00)

L= == el = S I P )

Goto |  Edt |  sae |

If no list has been selected, a blank list of only one row is displayed.

2. Press the [Left/Right] arrow keys to change between the colums.
Use the [Up/Down] arrow keys to mark a row.

3. Use the numeric keys to enter the value for the value pairs in the "Frequency/Hz"
and "Power/dBm" table columns. A blank row is inserted at the end of the list.
Terminate the entry by pressing a [Unit] key.

4. To select a row, select the "GoTo" button and press the [ENTER] key.
Use the numeric keys to enter the row index in the entry field and press the
[ENTER] key to confirm the entry.

The cursor moves to the selected row.

5. Toinsert a new row in the table, select the row above which the new row is to be
inserted and select "Insert Row(s)".

A row is inserted above the currently marked row.
If no row has been selected, a row is inserted at the beginning of the list.

6. Use the "Save" function to save the edited list under its current name.
Enter the file name in the "File Select" dialog and select the directory (see "File
Select Dialog" on page 88).

Only complete value pairs are taken into consideration; rows containing an entry in
only one column are ignored.
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Creating a new list mode data list

A new list can be created under a new name either by generating a blank file in the
"File Select" menu (see section Chapter 3.5.1.8, "File Management", on page 86) or
by changing an existing list which will then be saved under a new name.

1. To create an empty data list, select "RF > List Mode > List Mode Data... > New
List" or respectively "RF > User Correction > User Cor. Data... > New User Correc-
tion Data" and enter the file name of the new data list.

2. To open the data list for editing, select the associated button "Edit User Correction
Data..." or "Edit List Mode Data..." in the individual menu.
Edit the list and save it under a new name.

3.5.1.7 How to Use the Help System

The R&S SMB is equipped with a context-sensitive help function. A help page is avail-
able for each parameter and can be called any time during instrument operation.

Calling context-sensitive and general help

» To display the general help dialog box, press the [HELP] (F1) key.

The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

elp - State =1E3
Contents Index Back =

Instrument Function > Modulations =
Amplitude Modulation (AM) > Amplitude
Modulation Menu > State

State

Activates/deactivates AM modulation.

SCPI command: o

[:S0URce<hw>7:AM:S5TATe j

On top, the help dialog box contains a navigation bar with:

® "Contents" - accesses a table of help contents

® "Index" - switches to an index table

e "Back "/"Previous"/"Next" for navigation to further help topics

Navigating in the table of contents

1. To navigate within the table of contents entries, use the [Up/Down] keys. Entries
that contain further entries are marked with a plus sign.

2. To display a help topic, press the "ENTER" key.

The corresponding help topic is displayed.
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Navigating in the help topics
1. To scroll through a page, use the [Up/Down] arrow keys.
2. To follow a cross-reference, select the link text.

3. To return to the previous page, select "Back".
This function scrolls back all steps that you have performed before.

4. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.

Using the Index

1. Select "Index".

2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Press the [ENTER] key to change the focus.
4. Use the [Up/Down] keys to navigate and select the suitable keyword.
5. Press the [ENTER] key to display the help topic.

The corresponding help topic is displayed.

Closing the help window

> Press the [HELP] (F1) key.

3.5.1.8 File Management

The R&S SMB uses files to save all instrument data, i.e. system and user data.
The user data includes saved instrument settings and lists and the user correction.

The files are stored in the internal memory of the instrument or on a USB memory
stick. The /var directory can be used to save user-defined data; any subdirectory
structure can be created on /var. Some default subdirectories are predefined, but can
be changed at any time.

The /opt directory is a protected system drive and therefore unaccessible system
directory. The files on this directory contain data that must not be changed. Therefore,
this drive should not be accessed, since reconstruction of the system partition will lead
to data loss. To prevent inadvertent deletion or overwriting of system files, this drive is
not specified in the file menus.

Files can be exchanged either via a memory stick or a connected network. A memory
stick is connected to the USB interface and is assigned the var/usb/ drive. In the
case of a connected network, all network drives that can be accessed are available.
The files are accessed in a "Save/Recall" dialog in the individual menus.

The files are differentiated according to their extensions; each type of file is assigned a
specific file content. The extension is usually of no consequence to the user since
access to the files occurs in the individual menus where only the relevant type of file is
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available. See "Extensions for User Files" on page 89 for an overview of the suppor-
ted file extensions.

The user data can be roughly divided into the following data types:
® Settings

Instrument settings can be saved and loaded. In case of saveing, the current set-
ting is saved to the specified file.

e Lists
Lists, e.g. user correction lists, can be loaded. They can be generated either exter-
nally or internally. For internal generation, a new list must be created in the "File
Select" dialog which will then be edited in the list editor of the individual menu.

O For more information, refer to:

® Chapter 3.5.1.9, "Legend of Front-Panel Controls", on page 90 for an overview of
key functions and a cross-reference between the front panel keys and the key-
board shortcuts

® {0 section "Instrument Functions" for a detailed description of key functions.

Accessing files with user data

1. To access an editable user data file, select the "Save/Recall" or "File Manger" func-
tion in the individual dialog.

Recall Settings
Save Settings
File Manager...

2. To access a loadable data file, select the "Select/New" or "File Manager" function in
the individual dialog.

Select User Correction Data
Mew User Correction Data
File Manager...

3. To access the "File Manager" function, press the [SETUP] (CTRL+E) key and
select "Save/Recall > File Manager".

A "File Select" window for loading, saving or creating a file or the "File Manager"
dialog for managing all files is displayed.

O Saving and loading of all instrument settings
s All instrument settings are saved and loaded in the "File" menu.
To access the "File" menu, press the [FILE] (CTRL+S) key.

For more information, see Chapter 4.2.8, "Storing and Loading Instrument Data - File
Key", on page 127.
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File Select Dialog

The "Save/Recall" dialaog displays the available drives and directories. In the upper
part, "Recent Data Sets", the files last used are listed.

Save/Recall x SaveRecall EE3
Operation MndeISave 'l Recent Files Operation Mode IRecaII vI Recent files |
fvarluser/SavRcl Iv?rfu.serIListsISa\chl
» [ Lists - 03 DME B
» {3 Pulse Trains .
» [ SavRcl
b [ UCS2010
ﬁl fvar/volatile =
File Name:
[presetsettings | ! w.[% SunCalikNats A
- Save Save File Exclude Frequencyl™ Exclude Level[™
ave Imm 1 Imm 2 Magr... Recall Recall File
Recall
Imm 1 Imm 2 Mar...

The available drives and directories and the files of the selected directory are dis-
played. The currently selected path is displayed above the window. Only the relevant
files without file extensions are displayed. If the area is opened several times, the path
last selected is displayed. When a file is saved or created, its name is user-selectable;
the extension is assigned automatically and cannot be entered. The file is saved to the
selected path.

In addition to the files saved by the user, some menus also offer files containing prede-
fined contents. These files are saved to a specific directory on system drive; for this
reason, this directory cannot be chosen from the "File Select" menu.

Working with the File Select dialog
1. Access the "File Select" dialog (see "Accessing files with user data" on page 87).

2. Navigate in the "File Select" dialog.

3. Load an existing file.
In the "Recall Settings" dialog, mark a file and press the "Select" button.

4. Save afile.
In the "Save Settings" dialog, enter file name in the "File Name:" field.
Select the directory to which the file is to be saved and then select the "Save" but-
ton.

5. Create a new file.
To create a new file, use the "Save Settings" functionality, i.e. specify file name and
directory and save the file.

The created file is empty; it must be filled with the necessary values in the individ-
ual editor.

File Manager

The "File Manager" allows general file management such as copying, shifting, renam-
ing and deleting files as well as generating new directories.
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age =1 E3
File Type Instrument State (* savrcltxt) -

fvarfuser/Lists/SavRq Al Files (")
Tl e o e at Instrument State (Y savrcltxt)

&3 DME ARB Waveform (*.wv)

(3 LevelcalD| NRP Setting (*.nrp)
(3 LiGenCall List Mode List (*.1sw)

! & Rt All Files (™
E| Q SavRel
a0 SynCalibData
Cut | Copy | Paste |
Rename | Delate | Create New Dirl

Use the "File Type" to select a file type from the list. This can be used to process either
all files (all files (*) selection) or a specific selection of files. See "Extensions for User
Files" on page 89 for an overview of the supported file extensions. The available
drives and directories and the files of the selected directory are displayed. The cur-
rently selected path is displayed above the windows. If the area is opened several
times, the path last selected is displayed. Unlike the "File Select" window, the "File
Manager" displays the full file names including extensions.

Working with the File Manager dialog

1. Accessing the "File Manager" dialog (see "Accessing files with user data"
on page 87).

2. Navigating in the "File Manager" dialog.
Operation is very similar to the operation of a standard Windows explorer.

3. Moving, duplicating, deleting or renaming files
To move a file, select the file and press the "Cut" button. Mark the directory to
which the file is to be moved and select the "Paste" button. If the target directory
already contains a file with the same name, a confirmation query is displayed to
confirm overwriting of this file.
Perform the similar steps and cut/copy/rename/delete the file.

Tip: The operation corresponds to the Windows concept.

4. Creating a new directory
Mark drive or directory level where the new directory is to be created, select the
"Create New Directory" button and enter the name of the new directory in the entry
window that opens. Confirm with [ENTER].

Extensions for User Files

The following table lists all available file extensions for user files. The currently availa-
ble files on the instrument depend on the installed options.

Table 3-4: List of the automatically assigned file extensions in the instrument

Function List type Contents File suffix
Instrument State Settings Instrument settings *.savrcltxt
"User Correction" List User-defined level correction values *.uco
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Function List type Contents File suffix
Export Data * txt Or *.csv
"List Mode" List User-defined frequency/level value pairs *.lsw
Export Data * . txtor *.csv
"Pulse Train List" User-defined offtime/ontime/repetition values *.pulstrn
SMZ Settings Settings Data (firmware) of a connected SMZ frequency | *.efmfirm
multiplier
NRP Settings Settings NRP Settings *.nrp

3.5.1.9 Legend of Front-Panel Controls

The following table lists all key functions available on the front panel. Key combinations
used on the PC keyboard to trigger key functions on the instrument front panel are also
described. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 3-5: Cross-reference between the front panel keys and keyboard shortcuts

Front-panel key Key of PC keyboard Function
Turning the rotary Tab key (towards the right) Sets the cursor with the rotary knob.
knob Shift + Tab (towards the left)
Pressing the rotary Enter Pressing the rotary knob confirms an entry; it has
knob the same function as the ENTER key.
Arrow keys Arrow keys Moves the cursor.
ENTER /*1 /dB(m) Enter Terminates an entry.
ALT + F12 Confirms entries in the base unit and values with-
out a unit.

Selects dBm for the RF level and dB for level offset
and level step width.

RV - L H# Enters a period/decimal point. Enters a special
character.

-/ A<->a -/ (shift+) a—z Enters the sign.
Switches between upper-case and lower-case let-
ters.

0-9/a..z CTRL+ 0-9/a...zCTRL Enters the number/letter.

[BACKSPACE] Backspace Clears the last entry (number, sign or decimal
point)

[ESC / CLOSE] ESC/CTRL + G Selects the next higher menu/selection level. When

the editing mode is exited with ESC, the previous
value is restored.

Closes an active menu.
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Front-panel key

Key of PC keyboard

Function

[DIAGR] CTRL+ D Sets the cursor on the block diagram and hides all
menus.

[FILE] CTRL+S Activates the menu for storing instrument settings.

[FREQ] CTRL+ F Activates the frequency entry.

G/n / dBuV ALT + F9 Selects the unit Giga/Nano, dBuV for the RF level
and dBu for the LF level.

[HELP] F1 Opens/closes context-sensitive help.

[INFO] CTRL +1 Opens/closes the info window

k/m / mV ALT + F11 Selects the units kilo/milli and mV for RF levels.

[LEVEL] CTRL +L Activates the level entry.

[LOCAL] CTRL+Q Switches the instrument from remote control to
manual control.

M/u / uV ALT + F10 Selects the units Mega/Micro and uV for RF levels.

[MOD ON/OFF] CTRL + O Switches modulation on/off. "MOD OFF" is indica-
ted in the status line.

[TOGGLE] CTRL+T Switches a block or parameter on/off.
Toggles between the different possibilities of set-
ting a selection parameter.

[PRESET] CTRL+P Restores a defined basic instrument setup.

[RF ON/OFF] CTRL+R Switches the RF output signal on/off. "RF OFF" is
indicated in the status line.

[SETUP] CTRL+E Opens the setup menu for general instrument set-
tings.

[WINBAR] CTRL + W Toggles between the active menus.

Front Panel Key Emulation

The R&S SMB provides a front panel key emulation to enable execution of the front
panel key functions by mouse e.g. for remote access. The emulation is called by a right
mouse click. The front panel key functions are executed by a mouse click on the asso-

ciated button.
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3.5.2

3.5.3

Instrument Control

Freq Diagram |
Lewel | Menu |
File | Rearr. |
RF OnfOff | winBar |
Mod OnsOff | Help |

Preset
Local
Setup

Hardeopy

Infa

i

Remote Control

Remote control is an operation of the instrument by means of remote control com-
mands or programs that automatize repeating settings. The instrument is connected to
a computer running the program.

The R&S SMB supports various remote control connections:

Connecting the instrument to a (LAN) network

Using the LXI browser interface in a LAN network
Connecting a PC via the IEC-bus (IEEE 488) interface
Remote control via the USB interface

Tip: For remote control over LAN or USB, you can use the R&S VISA (Virtual Instru-
ment Software Architecture) library provided for download at the Rohde & Schwarz
website http://www.rohde-schwarz.com/rsvisa.

This way of operation and the instructions how to set up a connection for remote con-
trol are described in the Chapter 5, "Remote Control Basics", on page 240. The
description of the remote control commands is provided in Chapter 6, "Remote Control
Commands", on page 283.

Remote Access

Remote access is the operating of the instrument from a remote computer. Both the
R&S SMB and the computer are connected in a LAN.

Remote access in contrast to remote control does not use remote-control commands
but a separate software which is installed on the remote computer. After its start, the
software simulates the user interface of the instrument. The instrument can thus be
operated from the remote computer as on the unit itself. The individual functions are
operated using the mouse and keyboard. Specific instrument functions can be execu-
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Instrument Control

ted using specific key combinations on the keyboard or a front panel key emulation that
can be operated with the mouse.

This way of operation and the instructions how to set up a connection for remote
access are described in Chapter 3.1.16, "Remote Access via an External Controller",
on page 32.
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4 Instrument Function

4.1 Overview of Instrument Functions

This chapter explains the functions of the R&S SMB and the options available in the
setting menus. The associated SCPI command is specified for each parameter (where
applicable).

The description starts with the general instrument settings which do not directly affect
signal generation. The majority of these settings can be accessed by means of front-
panel softkey menus and not by means of function block menus.

The signal generation functions are then described, beginning with the functions which
affect the RF signal ("RF" block) and the analog modulations ("Mod" block). The config-
uration of the modulation generators (LF generators and pulse generator) and of the
LF sweep is offered in the "Mod Gen" block. The clock synthesis signal is set in the
"Clock Synthesis" block.

The general instrument settings include various functions, such as:

® Setting a defined basic setup using the [PRESET] key
see Chapter 4.2.2, "Default Instrument Settings - Preset Key", on page 96

® Switching from remote control to manual control using the [LOCAL] key
see Chapter 4.2.4, "Switching to Manual Control - Local Key", on page 123

® Configuring the generator and its interfaces in the "Setup"” dialog - e.g. setting the
GPIB address, starting an adjustment, querying instrument data
see Chapter 4.2.3, "General Configuration of Instrument - Setup Key", on page 97

® Calling up the online help using the [HELP] key
see Chapter 4.2.7, "Help System - Help Key", on page 126

® Querying messages using the [INFO] key
see Chapter 4.2.6, "Messages - Info Key", on page 126

® | oading and storing complete instrument settings in the "File" menu

see Chapter 4.2.8, "Storing and Loading Instrument Data - File Key", on page 127
The RF signal and the reference oscillator are configured in the "RF" function block:
e CW mode

see Chapter 4.3.1, "Overview of RF Signal", on page 136

® List mode
see Chapter 4.3.7 .4, "List Mode", on page 192

® Frequency and Level Sweep mode
see Chapter 4.3.7.1, "Overview", on page 178

® Reference Oscillator

see Chapter 4.3.4, "Reference Oscillator", on page 142
® RF Level

see Chapter 4.3.5.1, "Overview of RF Level", on page 146
® RF Level Sweep

Operating Manual 1407.0806.32 — 23 94



R&S®SMB100A Instrument Function

General Instrument Settings

see Chapter 4.3.7.3, "RF Level Sweep", on page 187

e ALC
see Chapter 4.3.5.4, "Automatic Level Control - ALC", on page 153

® Power Sensors
see Chapter 4.3.6.2, "NRP Power Viewer", on page 170

® User Correction
see Chapter 4.3.5.6, "User Correction”, on page 159

The analog and external digital modulations are activated in the "Modulation" function
block:

® Amplitude Modulation
see Chapter 4.4.2, "Amplitude Modulation (AM)", on page 204

® Frequency Modulation
see Chapter 4.4.3, "Frequency Modulation (FM)", on page 207

® Phase Modulation
see Chapter 4.4.4, "Phase Modulation (PhiM)", on page 211

® Pulse Modulation
see Chapter 4.4.5, "Pulse Modulation (PM)", on page 214

® Stereo Modulation
see Chapter 4.4.6, "Stereo Modulation", on page 217

The internal LF generators, the LF frequency sweep and the pulse generator are con-
figured in the "Mod Gen" function block:

® |F Frequency Sweep
see Chapter 4.5.3, "LF Frequency Sweep", on page 225

® | F output
see Chapter 4.5.2, "LF Output", on page 224

4.2 General Instrument Settings

4.2.1 Overview of General Instrument Settings

This section describes the settings which do not directly affect signal generation. Most
of these settings can only be accessed by means of menus which are opened using
keys or key combinations on the external keyboard or keys on the front panel key emu-
lation.

The general instrument settings therefore affect various functions, such as storing
instrument settings using the [FILE] key or setting the GPIB address in the menu of the
[SETUP] key. The order in which the descriptions are given corresponds to the layout
of the keys on the front panel of the R&S SMB (from top left to bottom right).
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4.2.2 Default Instrument Settings - Preset Key

The [PRESET] key performs a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument set-
tings provide a reproducible initial basis for further settings.

However, functions concerning the integration of the instrument in a measurement
setup are not changed, for example the GPIB address or reference oscillator settings.

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched on.

User-defined instrument states can be accessed and stored in the "File" menu.

O Resetting the instrument to the factory state is possible with the Factory Preset func-
= tion.

Preset
Presets all parameters and switching states.

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

® "RF frequency" =1 GHz

® "RF level" RF output switched off

e "Level" = 30 dBm for instruments including an attenuator

"Level" = -5 dBm for instruments with no attenuator

"Offsets" = 0

"Modulations State" = Off

Uninterrupted level settings are switched off

"Level Attenuator Mode" = AUTO

Internal level control "Level ALC" = AUTO

User correction "Level Ucor" = OFF

"LF output State" = Off

"Sweep State" = Off

Settings that are not affected by the [PRESET] key

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings ("Setup" menu)

GPIB address ("Setup" menu)

*IDN? Identification and emulation ("Setup" menu)

Password and settings protected by passwords ("Setup” menu)
Start/Stop Display Update ("Setup" menu)

Display and keyboard settings ("Setup" menu)

Remote command:
*RST on page 286
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4.2.3 General Configuration of Instrument - Setup Key

- The "Setup" menu provides access to basic instrument settings, regardless of the cur-

System
mmasemens. rently set operating mode or measurement. It contains information on the insstrument's
Hardware Config

Software / Oions... equipment, and comprises all settings for the general configuration of the instrument
and its interfaces.

To access the "Setup" menu, press the [SETUP] key.

The "Setup" menu is divided into functional sections as follows:

® "System": covers general instrument parameters.

® "Test": used to perform function tests.

® "Environment": used to configure the controller interfaces.

® "Remote": used to configure the remote control interfaces.

® "Protection": used to set the protection level for service functions and security set-
tings.

® "Settings": used to save or recall instrument settings or to preset the instrument to
factory settings.

Most submenus of this key can be accessed only via the [SETUP] key or the menu

tree ([MENU] key), with the following exceptions:

® The "Reference Oscillator" dialog can also be accessed in the "RF" block and is
therefore described in the section on this block (see Chapter 4.3.4, "Reference
Oscillator", on page 142).

® The "Save/Recall" dialog can also be accessed with the [FILE] key and is therefore
described in the section on this key (see Chapter 4.2.8, "Storing and Loading
Instrument Data - File Key", on page 127.

4.2.3.1 Hardware Config

In the "Hardware Config" dialog, the installed assemblies together with their variants
and revision states can be displayed for servicing purposes.

To open the "Hardware Config" dialog, select "System" and press the [SETUP] or

[MENU] key.
Counter
(Operation Time /h 5]
Power On Count ]
Common Assembly

Assembly Fart Mumber | Revision
SMB100A 1406.6000k02 |——
Basis Board [1406.6600.00 (00.00

COM-FPGA 00.00.00
RF Assembly
Assembly Fart Mumber | Revision
RF Board 1406.7220.06 |01.01
MOD-FPGA 20.20.00

Baseband Assembly

Assembly Fart Mumber | Revision
Sterec Coder [1407.3240.00 [00.00
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Section "Counter" in the upper part of the menu shows the "Operation Time" (in hours)
and the number of power-on ("Power On Counter").

The second part of the menu is a table that lists the installed assembilies. It is divided
into the sections:

® "Common Assembly"

® "RF Assembly"

® "Baseband Assembly"

Operation Time / h
Displays the operation time in hours.

Remote command:
:DIAGnostic:INFO:0TIMe? on page 294

Power On Count
Displays the number of power-on.

Remote command:
:DIAGnostic:INFO:POCount? on page 294

Assembly
The tables list the installed assemblies.

"Assembly" Assembly name
"Part Number" Part Number of assembly
"Revision" Revision state of assembly

Remote command:
:DIAGnostic<hw>:BGINfo? on page 293

4.2.3.2 Software / Options

The "Software/Options" dialog shows the firmware version of the instrument software
and all installed hardware and software options.

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option.

How to install options is described in chapter 4 "Software Update / Installing Options"
of the service manual.

The installation of hardware options purchased at a later stage is also described in the
service manual. Most hardware options need to be installed at an authorized
Rohde&Schwarz service shop.

To access the "Software/Options" dialog, select "System" and press the [SETUP] or
[MENU] key.

The menu is divided into the following sections:
* "Firmware"
® "Hardware Options"

Operating Manual 1407.0806.32 — 23 98



R&S®SMB100A Instrument Function

General Instrument Settings

e "Software Options"

Package More...
SMB100A FW 02.05.19 beta (Release..
R&S COMPASS | 2.1.59.0 (Release)

— Hardware Options

Option More...
SMB-B106 9 kHz to 6 GHz

— Software Options {Internal)

Option More...

SMB-K22 Pulse Modulator (Desl..

SMB-K23 Pulse Generator (Desi..
Firmware

The firmware section of the menu shows the firmware version and the version of the
software platform.

Note: Your instrument is delivered with the latest firmware version available. Firmware
updates and the "Release Notes" describing the improvements and modifications are
provided on the Internet at the download site of the Rohde & Schwarz signal generator
home page. This home page always offers the latest information on your signal gener-
ator, e.g. also on changes of the firmware update procedure.

Remote command:
n.a.

Hardware Options / Software Options
The tables in the sections "Hardware" and "Software" list the installed hardware and
software options.

"Option" Short name of option
"Designation”  Name of option

Remote command:
*OPT? on page 285
*TDN? on page 285

Versions
The "Versions" tab shows the versions of the technical specification of the R&S SMB
and of the software components that comprise the firmware.

"Package" Name of the component.
"Version" Current issue of the component.

Remote command:
n.a.

Show Open Source Acknowledgments

Accesses the list of the used open source software packages and the corresponding
verbatim license texts.
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4.2.3.3 Manage License Keys

This dialog is the central dialog for managing licenses, like enabling newly purchased
and/or newly registered options or performing the required instrument related steps
during the process of unregistration of licenses.

i x]
|Device ID 1405.5000K02-000000-ED)|

Enter License Key
Enter License Key

Import License Key From File... |

Export Deaclivation Response To File... |

An option is ready to operate after it is enabled by means of a license key code sup-
plied with the option. The license key is delivered as a file or on paper. Unregistered
licenses must be registered for a particular instrument prior to the corresponding option
can be enabled for operation.

@ License Registration
If your purchased license is delivered unregistered, you must register it before you can
activate the option.

For detailed information about the license registration, refer to the installation instruc-
tions provided with the option (Supplement A) and the documentation of the online tool
"Manage Licenses" (https://extranet.rohde-schwarz.com/service).

Only if the R&S SMB is equipped with an older firmware version, a firmware update
prior to enabling the software option may be required. The information on the valid
firmware versions for the purchased software option is provided together with the
option.

The firmware update is described in the service manual, chapter 4.

Device ID
Displays the instrument specific identification number. The device ID is an unique
string with the following structure:

<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.

For license keys delivered as a file, use Import License Key from File....

Import License Key from File...
Opens a dialog for selecting the file with the license key.
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Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file manage-
ment dialog to save the file. This key is required during the unregistration process.

Status Information
Displays status information.

NRP Info/Update

The "NRP Info/Update..." dialog covers information on connected power sensors, like
serial number, revision state and features of the particular sensor. You can directly
update the sensor firmware.

Access:

» Select "Setup > System > NRP Info/Update...".

—————— Current Sensors —— Rev:17.11.27.03
Peak: Yes
SensorType | Serial Numbe | More__. | Interface: LAN
NRP18SN 101748 17.11.27.03
NRP18AN 100992 17.11.27.03
A
Update

[NRP18AN-100992 | Run Update

None| Select NRP File |

The "NRP Info / Update" dialog indicates the connected R&S NRP power sensors
with specific information and contains the functions to update the firmware of a
connected sensor.

The remote commands required to remotely configure the power sensor settings are
described in Chapter 6.12, "SENSe, READ and INITiate Subsystems", on page 318.

How to update an R&S NRP sensor

To perform an R&S NRP sensor update proceed as follows:

1. Open the R&S website http://www.rohde-schwarz.com in section "Power Meters &
Voltmeters > R&S NRP Sensors".

2. Select the respective sensor, e.g. R&S NRP18SN.
3. Select "Downloads > Firmware" and the offered firmware suitable for your sensor.

4. Transfer and save the firmware on the instruments, for example in
the /var/user/ directory.

5. Connect the sensor to the R&S SMB and select "Setup > System > NRP Info
Update" to open the dialog.

6. Select the sensor in the left sensor selection field.
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7. Select the update file with "Select NRP File".
8. Start the update procedure with "Run Update".

The update starts and a bar indicates the progress.
How to restart an interrupted update of an R&S NRP sensor

An accidental removal of the sensor during the update process interrupts the update.

If no other sensor is connected to the instrument, proceed as follows to restart the
update process:

1. Do not reconnect the sensor but keep it ready to be connected.

2. Inthe "Setup > System > NRP Info Update" dialog, select "Rescue" in the left sen-
sor selection field

3. Activate "Run Update".
4. Confirm query in message box
5. Connect sensor within 4 seconds

The update starts, a bar informs about the progress.

Current Sensors
Shows the sensors that are connected to the generator with information on serial num-
ber, the revision state and some features.

Tip: Click on a sensor to get quick information about the firmware version and whether
this sensor measures the peak of the signal.

Remote command:

SENSe<ch>[:POWer] : TYPE? on page 329
SENSe<ch>[:POWer] : SVERsion? on page 329
SENSe<ch>[:POWer] : SNUMber? on page 328

Update

Section "Update" provides access to the file system in order to select a file for an

R&S NRP sensor update (Button "Select NRP File"), the selected file is indicated to the
left of the button. On the left side, the sensor to be updated is selected.

Button "Run Update" starts the update.

Note: If the update is interrupted for example by accidental removal of the sensor dur-
ing the process, the button "Rescue" appears. Thus, you can restart the update proc-
ess.

Prerequisite is that no other sensor is connected to the instrument.

Refer to "How to update an R&S NRP sensor" on page 101 and "How to restart an
interrupted update of an R&S NRP sensor" on page 102 for detailed instructions.

Remote command:
n.a.
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4.2.3.5 SMZ Info Update

The "SMZ Info/Update" dialog covers information on a connected frequency multiplier,
like type, serial number revision state, frequency range and firmware version. You can
directly perform an update of the multiplier firmware.

I_i

Bl Setup -
- System

Reference Oscillator...

Internal Adjustments...

Hardware Config... J

Software/Options...

Manage License Keys...

Start/Stop DisplayUpdate. ..

NRP-Z Info/Update. ..

SM{ Info/Update.

Update... Ll

Toct

To access the "SMZ Info/Update" dialog, perform one of the following
® On the front panel, press the [SETUP] key and select "SMZ > SMZ Info Update".
® |n the block diagram, select "RF Block > Configure > SMZ Info Update"

SMZ Info / Update O]
[ Available Multipliers

IMuh\pherType Serial Number| Revision |Min Freq Max Freq FW-Version BL-Version
IWVSMZNU 101643 01.00 75GHz  110GHz FW_ 18 BL 186

SMZ Input Cable Compensation Standard -
Cable Loss (10GHz) 10|dB =

Update

1-SMZ110 | Run Update |

MNone Select SMZ File |

® Where you can find the description...
Since this section is relevant when an R&S SMZxxx frequency multiplier is connec-

ted, you can find a detailed description in the user manual of the frequency multi-

plier. It is included in the online help of the R&S SMB, but can also be found in pdf
format on the CD, or on the R&S website http://www.rohde-schwarz.com/product/
SMZ.html.

4.2.3.6 Display Update

The "Start/Stop Display Update" dialog provides the possibility to switch off update of
the displayed parameters to increase speed for certain settings.

The indicated values are not updated and may therefore differ from the intern, used
values.
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Start / Stop Display Update _ X

Display Update is

Please, be aware:
If "Display Update is OFF", the values of displayed parameters could differ from their internal, used values.
This mode is mainly provided to support unjittered signal output, e.g. in fast sweep or list mode.

Remote state changes switch the "Display Update is" to ON.

Display Update is On/Off
Switches on/off the update of the displayed parameters.

Switching off the update of the displayed parameters increases the speed for certain
settings.

Note: For optimum sweep performance with short dwell times and for fast settling
times, it is recommended to switch off the display update.

Remote command:
:SYSTem:DISPlay:UPDate on page 454

4.2.3.7 Shutting Down and Rebooting the Instrument

The [Power On/Standby] front panel key switches the instrument from the standby to
the ready state or vice versa. In remote operation form a remote computer or in manual
control, the R&S SMB provides you with another possibility to shut the instrument
down or to reboot the system.

» To access the required settings, select "Setup > Environment > Shut Down".

ET |
Shut down

Reboot |

Remote control commands:

® :SYSTem:SHUTdown on page 453

® :SYSTem:REBoot on page 453

® seealso :SYSTem:RESTart on page 453

4.2.3.8 Network Settings

The "Network Settings" dialog shows the parameters relevant for identifying the instru-
ment in a network. The R&S SMB is equipped with a network interface and can be
connected to an Ethernet LAN (local area network).

How to connect the signal generator to the network is described in Chapter 3.1.7,
"Connecting to LAN", on page 24 .
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Risk of network errors!
Connection errors can affect the entire network.

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP

configuration, you must assign valid address information before connecting the instru-
ment to the LAN.

Contact your network administrator to obtain a valid IP address.

» To access this dialog, press the [setup] or [menu] key and select "Environment >

Network Settings".
|Network Status 2 Cannected |
Haostname |r55ma1ﬂﬂa1ﬂﬂ{]21
Warkgraup [INSTRUMENT
Address Mode | Auto (DHCP) |
IP Address | 10.111.10.136
Subnet Mask | 255.255.0.0
Default Gateway | 10.111.0.1
DNS Suffix [rsint net
DNS Server | 10.0.23.159
MAC Address [oo2564C33182

Restart Netwark

In the "Network Settings" dialog, you can configure the settings of the general net-

work environment and specific identification parameters of the instrument in the
network.

The remote commands required to remotely configure the network are described in
Chapter 6.15, "SYSTem Subsystem", on page 437.

Network Status

Indicates that the instrument is connected to the network.
Remote command:

:SYSTem: COMMunicate:NETWork: STATus? on page 447

Hostname
Displays the host name.

Each instrument is delivered with an assigned host name, a logical name which can be
used instead of the IP address. With the default network settings, the IP address is
allocated by the DHCP server. This address may change each time the instrument is
reconnected. Unlike the IP address, the host name does not change.
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Note: Since the host name of the instrument is a protected parameter, you must first
unlock protection level 1 to enable the entry (see Chapter 4.2.3.13, "Protection”,

on page 113).

It is recommended that you neither change the default network settings nor the host
name in order to avoid problems with the network connection.

However, if you change the host name be sure to use an unique name.

Remote command:
:SYSTem:COMMunicate :NETWork [ :COMMon] : HOSTname on page 445

Workgroup
Sets the individual windows workgroup name of the R&S SMB. This parameter is
required in case the instrument is integrated in a windows network.

Note: Since the workgroup name of the instrument is a protected parameter, you must
first unlock protection level 1 to enable the entry (see Chapter 4.2.3.13, "Protection”,
on page 113).

Remote command:
:SYSTem:COMMunicate :NETWork [ : COMMon] : WORKgroup on page 445

Address Mode
Selects the mode for assigning the IP address.

"Auto (DHCP)" Assigns the IP address automatically, provided the network supports
DHCP (Dynamic Host Configuration Protocol)
The network used must support automatic assignment of the IP
address via DHCP or APIPA (Zeroconf) in order to use this function.

"Static" Enables you to assign the IP address manually.

Remote command:
:SYSTem:COMMunicate:NETWork: IPADdress : MODE on page 445

IP Address
Displays the IP address.

By default, the R&S SMB is configured to use dynamic TCP/IP configuration and to
obtain the whole address information automatically.

If the network does not support DHCP or the attempt does not succeed, the instrument
tries to obtain the IP address via Zeroconf (APIPA) protocol. IP addresses assigned via
Zeroconf start with the number blocks 169.254 . * . *,

Note: An IP address that is assigned via the Zeroconf protocol while the network
requires an IP address assigned via the DHCP server may cause network connection
failures.

See Chapter 9.5, "Resolving network connection failures", on page 505.

To assign the IP address manually, select Address Mode "Static".

Remote command:
:SYSTem:COMMunicate:NETWork: IPADdress on page 446

Subnet Mask
Displays the bit group of the subnet in the host identifier.

To assign the subnet mask manually, select Address Mode "Static".
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Remote command:
:SYSTem:COMMunicate:NETWork[: IPADdress] : SUBNet : MASK on page 446

Default Gateway
Displays the gateway address.

To assign the gateway address manually, select Address Mode "Static".

This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.

Remote command:
:SYSTem:COMMunicate:NETWork[:IPADdress] :GATeway On page 446

DNS Suffix
Displays the primary DNS (Domain Name System) suffix, that means the DNS name
without the host name part.

The DNS system uses the suffix for registration and name resolution to uniquely iden-
tify the instrument in the entire network.

To assign the DNS suffix manually, select Address Mode "Static".

Remote command:
:SYSTem:COMMunicate :NETWork [ :COMMon] : DOMain on page 444

DNS Server

Determines the preferred server for name resolution. The DNS server contains the
underlying numerical values that are required for name resolution of the host name as
part of the IP address.

To select the DNS server manually, select Address Mode "Static".

Remote command:
:SYSTem:COMMunicate:NETWork[: IPADdress] : DNS on page 445

MAC Address
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the R&S SMB.

Remote command:
:SYSTem:COMMunicate:NETWork:MACaddress on page 446

Restart Network
Terminates the network connection to the instrument and subsequently re-establishes
it.

Used this function to resolve network problems.

Note: Only the connection of the instrument to the network restarts, the network itself
is not affected.

Remote command:
:SYSTem:COMMunicate :NETWork:RESTart on page 447
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4.2.3.9 Display/Keyboard Settings

In the "Display/Keyboard Settings" dialog the power-save mode and external keyboard
settings are made. It is opened using the [SETUP] or [MENU] key under "Environ-
ment".

Display/Keyboard ¥
Display Settings

Screen Saver [~ Active

Wait time [10] min =]

Toggle Summary Screen [ Active

Gui Language |Eng|ish (US}j
USE Keyboard Settings
Layout |English (US) =]

Screen Saver Active
Activates/deactivates the screen-save mode of the display.

If activated, the display including backlight is completely switched off after the elapse of
the "Wait Time" when no entries via front panel, external mouse or external keyboard
are made.

This mode is recommended for preserving the display especially if the instrument is
exclusively operated via remote control.

Remote command:
:DISPlay:PSAVe[:STATe] on page 296

Wait Time
Enters the idle time that must elapse before the display lamp is shut off when no
entries are made.

Remote command:
:DISPlay:PSAVe:HOLDof f on page 296

Toggle Summary Screen
Activates/deactivates the magnified frequency and level indication. If activated, the fre-
quency and level indication covers the complete display.

Remote command:
n.a.

GUI Language
Selects the language of the graphical user interface.

Remote command:
n.a.

Layout (USB Keyboard Settings)
Selects the keyboard layout for the selected keyboard language.

The assignment of some keys depends on the selected layout and language.
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Remote command:
:KBOard:LAYout on page 304
:KBOard:LANGuage on page 304

Remote Channel Settings

The "Remote Channel Settings" dialog provides access to the settings for remote con-
trol. The dialog is opened using the [SETUP] or [MENU] key under "Remote".

» To access this dialog, press the [setup] or [menu] key and select "Remote >
GPIB,...".

[GPIB Channel Address | 28

RS232 using USB Adapter

Baud Rate |1152[]U vI
Parity INone 'I

Stop Bits

]

VISA Resource Strings

HISLIP |TCP|F’::1[].111.1[].135::hi5|ip0::|NSTR
VX1 |TCPIF’::1{].111.1{].138::in5t{]::INSTR

Socket |TCP|F’::1[].111.1[].135::5[]25::SOCKI:_F
GPIB |GP|B::28::INSTR

USB |USB::D)-:[]AAD::E]X[]MB::10{1[121::INSTR
SERIAL |ASRL1 CINSTR

GOTO LOCAL

The "Remote Channel Settings" dialog contains the GPIB address and displays the
VISA resource strings provided for remote control via the various interfaces.

GPIB channel address
Sets the address of the GPIB channel the instrument is connected to.

Remote command:
:SYSTem:COMMunicate:GPIB[:SELF] : ADDRess on page 444

RS232 using USB adapter

Remote control via a serial interface is possible via a USB. The controller and the
instrument must be connected with the external USB/serial-adapter R&S TS1-USB
(see recommended extras in the data sheet) and a serial crossover (null modem)
cable. A USB connection requires the VISA library to be installed on the controller.
VISA will detect and configure the R&S SMB automatically when the USB connection
is established.

In addtion, you can also use a Bluetooth connection for remote control via the serial
interface. The settings are effective for both interfaces (see also Chapter 4.2.3.14,
"Security", on page 114 ).
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Baud Rate «— RS232 using USB adapter
Sets the baudrate for the serial remote control interface.

Remote command:
:SYSTem:COMMunicate:SERial:BAUD on page 449

Parity — RS232 using USB adapter
Sets the parity for the serial remote control interface.

Remote command:
:SYSTem:COMMunicate:SERial:PARity on page 449

Stop Bits < RS232 using USB adapter
Sets the number of stop bits for the serial remote control interface.

Remote command:
:SYSTem:COMMunicate:SERial:SBITs on page 449

VISA Resource Strings

Displays the VISA resource strings, used for remote control of the instrument. Each
interface requires an individual unique address, to identify the instrument for remote
control.

Remote command:
:SYSTem:COMMunicate:HISLip:RESource? on page 448
:SYSTem:COMMunicate:NETWork:RESource? on page 448
:SYSTem:COMMunicate:SOCKet :RESource? on page 450
:SYSTem:COMMunicate:GPIB:RESource? on page 447
:SYSTem:COMMunicate:USB:RESource? on page 448
:SYSTem:COMMunicate:SERial :RESource? on page 448

Goto Local
Switches the instrument to operate in local control mode.

Switching from remote to local control mode can be also done with one of the following
actions:

® manually with the [LOCAL] key on the front panel

® with the interface command &«GTL via the remote control interface

e with the key combination [CTRL + Q)].

Remote command:
&GTL

4.2.3.11 Instrument Emulations

It is also possible to remotely control the R&S SMB via the command set of another
signal generator, as for example of an HP generator. With this function you can, for
example, replace a signal generator with an R&S SMB in an automated test setup,
without adjusting the command scripts used. You find all the remote control command
sets supported by the R&S SMB in a selection list.
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For more information on this topic, the application note 1GP89: Remote Emulation with
the R&S SMB100A RF and Microwave Signal Generator describes in detail how to use
this feature.

The selected instrument also defines the identification string that is retrieved with query
*IDN?. In addition to the preset values, you can enter a user-defined identification
string, for example to provide individual identification for each generator, like

'MY_R&S SMB' (see Mode and IDN String).

As any other parameter, you can additionally change the remote control command set
to be emulated via the Language command. However, once you have switched to an
emulation, the R&S SMB specific command set is disabled, that means this command
is no longer effective. To return, you need to know the corresponding remote control
command of the simulated instrument. If you emulate an HP generator for example,
the HP command EX returns to the SCPI command set.

» To access this dialog, press the [setup] or [menu] key and select "Remote > Instru-
ment Emulations".

Instrument Emulations X
Language SCPI
— “IDN?FOPT? Identification -mﬂ
Mode Auto :E%g%i
1D String AF2030 =

Fohde&Schwarz, SMB100A,1406.6000k02/00000 ;I

0,2.1.17.1-02.01 113 beta (Debug) |
QPT String

SMB-B5, SMB-B106, SMB-K22, SMB-K23

The "Instrument Emulations" dialog enables you to emulate a remote control com-
mand set of several other signal generators.

The remote commands required to remotely configure the emulation settings are
described in Chapter 6.15, "SYSTem Subsystem", on page 437.

Language
Selects the instrument whose remote command set is emulated by the R&S SMB.

Remote command:
:SYSTem: LANGuage on page 452

Mode
Selects the way the instrument identification is performed.
"Automatic” Sets the "IDN String" and the "OPT String" automatically for the

instrument selected with the parameter Language.

"User Defined" Enables you to define the "IDN String" and the "OPT String" for the
instrument selected with the parameter Language.

Remote command:
:SYSTem: IDENtification on page 450
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Set to default

Enables you to reset the *IDN and *OPT strings in user defined mode, see "Mode"
on page 111.

The default strings vary depending on the selected emulation mode (Language)

Remote command:
:SYSTem: IDENtification:PRESet on page 450

IDN String

Indicates the identification string of the instrument when queried with the common
command *IDN?.

To assign a user defined identification string, select Mode "User defined".

Remote command:
*TDN? on page 285
:SYSTem: IRESponse on page 450 (user defined mode)

OPT String
Indicates the option string of the instrument as queried with the common command
*OPT?.

In "User defined" (see Mode) IDN String, you can create a user defined option string in
addition to the automatically created one.

Remote command:
*OPT? on page 285
:SYSTem:ORESponse on page 451

4.2.312 LXI Status

The "LXI - LAN eXtensions for Instruments - Status..." dialog displays the settings and
status of the LAN and allows to reset the LAN connection.

For more information on LXI, see Chapter 3.1.17, "LXI Configuration”, on page 39.

LXI - LAN eXten..rjuments - Status X

Hostname rssmx100a100020 |
MAC Address | 008D b8 1a 11 cf

IP Address I 10.111.1.32

LAN Reset |

LAN Status
The LED indicates the LXI status.

"green"” normal operation

"green (flashing)"
device identification

"red" LAN fault
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Remote command:
n.a.

LAN Reset
Initiates the network configuration reset mechanism for the instrument and resets the
hostname, MAC address, and IP address.

According to the LXI standard, a LAN Reset must place the following network settings
to a default state:

Parameter Value

TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled

ICMP Ping Enabled

Password for LAN configuration LxiWeblfc

The LAN Reset for the R&S SMB also resets the following parameters:

Parameter

Hostname Instrument-specific host name
Description RF and microwave signal generator
Negotiation Auto Detect

VXI-11 Discovery Enabled

The LAN settings are configured using the instrument's LX| Browser Interface descri-
bed in Chapter 3.1.17, "LXI Configuration", on page 39.

To open the "Instrument Home Page" (welcome page), type the instrument's computer
name (host name) or IP address in the address field of the browser on your PC, for
example http.//10.111.10.175.

Note: Do not add the missing zeros in the IP address, while opening the Instrument
Home Page.

Remote command:
n.a.

4.2.3.13 Protection
This "Protection" dialog provides access to the unlocking of different protection levels .

Access:
» Select "Setup > Protection”
After power on the instrument, all protection levels are locked. To unlock the protection,

the correct password must be entered, see "To unlock or lock a protection level..."
on page 114.

Operating Manual 1407.0806.32 — 23 113



R&S®SMB100A Instrument Function

General Instrument Settings

Protection

Protection Level 1 W Cn IPasswordI I

Protection Level 2 ¥ Cn  Password I—
Protection Level 3 W On Password Im
Protection Level 4 W Cn  Password Im
Protection Level 5 ¥ Cn  Password Im

The following functions are protected in the respective levels:

® Protection Level 1
Protects against accidental changes to certain settings, e.g. clock and date, net-
work settings or instrument names. You can access this protection level with the
password 723456.

® Protection Level 2
Provides access to the unlocking of protected service functions. It is accessible for
authorized personnel of Rohde & Schwarz service departments.

® Protection Level 3-5
Are reserved for factory internal use.

To unlock or lock a protection level...

1. In the "Password" entry field, enter the password for the corresponding protection
level.
2. Confirm with the [Enter] key.

The checkbox of the protection level is disabled, i.e. the protection is unlocked.

3. Tolock a protection level again, select the checkbox.

Protection Level/Password
Locks or unlocks the corresponding protection level.

E.g. protection level 1 expands the functionality of the internal adjustment and to
access the selftests.

The password is 123456.

For access to service functions of protection level 2, see the service manual of your
R&S SMB.

Remote command:
:SYSTem: PROTect<ch>[:STATe] on page 452

4.2.3.14 Security

The security concept of the R&S SMB helps you to protect your instrument against
uncontrolled access and changes. All provided security services require that you enter
the security password.

Provided security services are:
® Password management secures controlled user access to the instrument
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With the two-step password concept, you can assign a user-defined password for
the operating system, as well as a security password for accessing the mass stor-
age of the instrument.

For more information concerning the security password, see the description
Resolving Security Issues when Working with an R&S SMB. You can find this
document on the R&S SMB product page at "Downloads" > "Manuals".

® LAN Services secures controlled network access.
You can individually lock and unlock the supported LAN interface services, see
"LAN Services" on page 117.
Remote control via LAN interface requires that the interface is activated, but you
can enable the required services specifically.

® General security parameters as:

— USB Storage secures controlled access to the mass memory of the instru-
ment.

— Volatile mode protects against modification or deletion of data in the file sys-
tem.

— Annotation frequency and amplitude prevents reading the display.
— User Interface prevents front panel operation and/or reading the display

— Secure Update Policy check that verifies the integrity and origin of the firm-
ware package to be installed.

— Bluetooth enables operation of the instrument via Bluetooth.

Changing the password for the operating system or the security password requires that
you enter the old password, the new password and that you confirm the new pass-
word.

To assign the password, press the "Accept" button. This action can not be undone!

Keep also in mind, that security settings are never reset, even if you perform a factory
preset.

» To access this dialog, press the [SETUP] or [MENU] key and select "Protection " >
"Security".
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Change User Password
Valid for VNG, FTP and SMB (Samba) access
User Name |instrument

Old Password I
MNew Password I
Confirm Passwordl

Change Passwordl

Change Security Password

Old Password |
MNew Password I
Confirm Password I

Change Passwordl

Security Settings

LAN Services... |

USB Storage IEnabIed 'l
Volatile Mode IEnabIed 'l

Annotation Frequency Im
Annotation Amplitude Im
User Interface Im
Secure Update Policy Im'
Security Password l—

Accept |
Bluetooth
Bluetooth Pin I ]

The "Security" dialog comprises the parameters for configuring the passwords, as
well as the security settings of the mass storage and the LAN services.

The settings in this dialog will not be assigned until you enter the Security Password
and confirm with the Accept button.

User Name
Indicates the user name used for access to the Linux operating system.

The user name and password are required for remote access to the instrument via
VNC, FTP or SAMBA.

Change User Password
Allows you to change and confirm the user password.

Old Password < Change User Password
Enters the current user password. The default password is "instrument".

Note: It is highly recommended to change the default user password before connect-
ing the instrument to the network.

New Password < Change User Password
Enters the new user password.
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Confirm Password < Change User Password
Confirms the new user password by reperating.

Note: The new password will not be assigned until you select the Change Password
button.

Change Password < Change User Password
Changes the user password accordingly.

Note: Keep in mind, that a changed password is never reset, even if you perform a
factory preset.

Change Security Password
Enables you to change and confirm the security password.

Old Password — Change Security Password
Enters the currently used security password. The default password is '123456'.

Note: It is highly recommended to change the default security password before con-
necting the instrument to the network.

The security password is required when changing the status of the USB and LAN inter-
face.

New Password «— Change Security Password
Enters the new security password.

The security password may contain decimal characters only.

Confirm Password «— Change Security Password
Confirms the new password by repeating.

Note: The new password will not be assigned until you select the Change Password
button.

Change Password — Change Security Password
Changes the password accordingly.

Note: Keep in mind, that a changed password is never reset, even if you perform a
factory preset.

LAN Services

Opens the "LAN Services" dialog for individually enabling or disabling the available
LAN interface services.
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I

LAN Services

|Enab|e LAN Interface ¥ On |
SCP! aver LAN [Enabled ~]
VNC [Enabled ~]
SSH [Enabled ~]
HTTP [Enabled ~]
FTP [Enabled ~]
SMB (Samba) [Enabled ~]
Awvahi (Zeraconf) lm
Software Update lm
Security Passwaord l—
Accept |

Enable LAN Interface < LAN Services
Enables the LAN interface in general, and thus provides remote access via all
unlocked services.

Note: The activated LAN services will not be assigned until you enter the Security
Password and confirm with Accept.

Enable LAN Services individually — LAN Services
Enables or disables the following interface services individually.

"SCPI over LAN"
activates access over LAN to remotely control the instrument using
SCPI (Standard Commands for Programmable Instruments) com-
mands.

"VNC" activates access via VNC (Virtual Network Computing) interface, a
graphical desktop sharing system that uses RFB protocol to remotely
control the instrument.

"SSH" activates access via SSH (Secure Shell), a network protocol for
secure data communication.

"HTTP" activates access via HTTP (Hyper Text Transfer Protocol), the appli-
cation protocol for hypermedia information systems.

"FTP" activates access via FTP (File Transfer Protocol), used to transfer
files from a host to the instrument and vice versa.

"SMB (Samba)"
activates access to SMB (Server Message Block), used for providing
shared access to files, printers and serial ports of a network.

"Avahi (Zeroconf)"
activates Avahi, a service for automatic configuration of the instru-
ment in a network environment.

"Software Update"
allows updating the instrument firmware via the LAN interface.
For more information on this topic see the release notes of the instru-
ment, provided on the Internet at the download site or the Rohde &
Schwarz Signal Generator home page.
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USB Storage
Activates the access to external USB storage media.

This setting has no effect on a mouse or a keyboard, connected via USB.

Note: The setting will not be assigned until you enter the Security Password and con-
firm with Accept.

Volatile Mode
Acitivates write protection on the file system to prevent modification or erasure of val-
uable data.

Note: The setting will not be assigned until you enter the Security Password, confirm
with Accept, and reboot the instrument.

Remote command:
:SYSTem:SECurity:VOLMode [ :STATe] on page 443

Annotation Frequency
Enables/disables the display of the currently used frequency in the header of the
instrument.

Note: The setting will not be assigned until you enter the Security Password and con-
firm with Accept.

Remote command:
:DISPlay:ANNotation:FREQuency on page 295

Annotation Amplitude
Enables/disables the display of the currently selected level in the header of the instru-
ment.

Note: The setting will not be assigned until you enter the Security Password and con-
firm with Accept.

Remote command:
:DISPlay:ANNotation:AMPLitude on page 295

User Interface
Allows you to lock the manual of the controls of the instrument, and to hide even the
entire display.

The setting requires the entry of the security password 723456 and is only accepted
after the "Accept" button is pressed.

Tip: Section "Enabling a locked user interface for manual operation” on page 120
describes how you can unlock the control elements and the user interface.

"Enabled" Enables the display and all controls for the manual operation of the
instrument.

"VNC Only" Locks the keys at the front panel and externally connected keyboard
and mouse.

The display on the screen remains and shows the current settings
and changes.
Unlocking is possible via VNC or turning off and on again.
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"Display only"

Locks the manual operation of the instrument. The display on the
screen remains and shows the current settings and changes.

This security feature protects the instrument against unauthorized
access, but still shows the current settings and processes, for exam-
ple when you operate the instrument via remote control.

The function disables:
® the keys at the front panel of the instrument
® the external mouse and keyboard

The instrument indicates the locked controls by a padlock & softkey
in the taskbar.

"Disabled" Locks the display and all controls for the manual operation of the

instrument.

This security feature protects the instrument against unauthorized
reading and access, for example when you operate the instrument via
remote control.

The function disables:

® the display

® the keys at the front panel of the instrument

® the external mouse and keyboard

The screen shuts off and shows a padlock instead.

Remote command:

:SYSTem:ULOCk on page 442
:SYSTem:DLOCk on page 442
:SYSTem:KLOCk on page 442

Enabling a locked user interface for manual operation
To unlock the user interface for manual operation you have the following options:

On the instrument's keypad or external keyboard, enter the security password
123456.

Even if you press any key, the instrument prompts you to enter the security pass-
word for unlocking.

Security password to unlock

(R

ok | cancel |

Note The character of the first key you pressed is immediately added in the input
field. Prior to inserting the password delete this entry.

In remote control mode, send the command SYST : ULOC ENABled to release all
locks at once.

Alternatively, you can use the command SYST:KLOC OFF to unlock the keyboard,
Oor SYST:DLOC OFF to release the display.
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Via remote control, there is no password required.

Remote command:

:SYSTem:ULOCk on page 442
:SYSTem:DLOCk on page 442
:SYSTem:KLOCk on page 442

Secure Update Policy
Allows you to configure the automatic signature verification for firmware installation.

To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.

See also:
® Chapter 4.2.3.14, "Security", on page 114 for more information on the security con-
cept.

® The release notes for details on signature verification when installing new or former
firmware versions, available at www.rohde-schwarz.com/firmware/smb100a.

"Confirm Unsigned"
Performs the signature verification.
If the check detects any discrepancies, the instrument issues a warn-
ing message. You can still update the firmware or reject updating.
This setting also enables you to downgrade the firmware version.

"All Packages" Accepts all packages without signature verification.

"R&S Signed Packages"
Performs the signature check.
If the check detects any discrepancies, the instrument issues a warn-
ing message and locks the update to this firmware.

Remote command:
:SYSTem: SECurity:SUPolicy on page 452

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is '123456'.

Note: It is highly recommended that you to change the default security password
before connecting the instrument to the network.

All settings are only accepted after the "Accept" button is pressed.

Accept
Applies the modified settings, provided the security password is entered correctly.

Note: This action can not be undone. Keep in mind, that a changed password is never
reset, even if you perform a factory preset.

Bluetooth Pin
Sets the Bluetooth pin of an external Bluetooth device. The pin is required to enable
remote control via an external Bluetooth device.

Requires a Bluetooth adapter (recommended extra, see data sheet) .
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4.2.3.15 Save/Recall

The "Save/Recall" submenu can also be called up with the [FILE] key and is therefore
described in the section of this key (see Chapter 4.2.8, "Storing and Loading Instru-
ment Data - File Key", on page 127).

4.2.3.16 Factory Preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to
their factory state. This function is activated by pressing the "Execute Factory Preset"
button.

Factory Preset

Execute Factory Preset

Resets instrument to factory configuration.
Security settings and user data are not effected.

Factory Preset
Reset the instrument's settings to their factory state.

Note: "Factory Preset" resets the "Remote Channel" and network settings to the
default values.

Executing "Factory Preset" via remote control terminates the connection to the instru-
ment, if these settings had been configured to values different to the default ones.

The factory preset function resets nearly all instrument settings. In addition to the regu-
lar preset by means of the [PRESET] key, a "Factory Preset" resets also the following
values:

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings including hostname ("Setup" menu)

Remote channel settings including GPIB address ("Setup" menu)

Start/Stop display update ("Setup" menu)

Display and keyboard settings ("Setup" menu).

To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings
files, created for example by means of the Save/Recall function.

Remote command:
:SYSTem: FPReset on page 289

4.2.317 Help
The "Help" dialog offers comprehensive online help for the R&S SMB. A desired topic
can be selected via the table of contents (select "Manual") or the index (select "Index").

For context-sensitive information about a marked parameter, press the [HELP] key. For
a description of the "Help" menu, refer to the section covering to the [HELP] key (see
Chapter 4.2.7, "Help System - Help Key", on page 126).
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4.2.4 Switching to Manual Control - Local Key

The local key switches from remote control to manual control (local state).

In remote control mode the instrument indicates the remote state in the display header.
The rest of the display remains unchanged and shows the current instrument status,
that means the status which exists under the remote control settings. The instrument
can be operated (for example dialogs can be opened). However, it is not possible to
enter or change values.

The status message additionally indicates whether the [LOCAL] key is disabled or
enabled.

The following states are indicated:

e "REMOTE"
The [LOCAL] key switches the instrument from remote control to manual control.
The current command must be fully processed before the mode is switched, other-
wise the instrument switches immediately back to remote control.

e "REM-LLO"
The [LOCAL] key is locked, inititated by the «1.1.0 (local lockout) command. The
instrument can be switched from remote state to local state only via remote control,
for example with &GTR or the Visual Basic command CALL IBLOC
(generator%). The [LOCAL] key has previously been locked by the remote com-
mand &LLO.

When switching from remote to manual control, the display update function is automati-
cally deactivated ("SETUP" > "Start/Stop Display Update" > "Off").

4.2.5 Generating a Hard Copy of the Display
The save/recall function enables you to store the settings in a file. In addition, you can

create a hard copy of the current display to save the most important settings of a per-
formed signal generation in an image file.

4.2.51 Hard Copy Settings

Creating a hard copy of the display requires that you have an external keyboard con-
nected to the instrument.

» To access the dialog, use the key combination [CTRL+Z], or [CTRL+Y] depending
on the used keyboard settings.

vaan‘usen‘SMB}_?O180’B24(]{K)_ ong

IAutomatic Maming ¥ On |

Format IPNG 'I | Options... |

| Save |
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The dialog contains the parameters for configuring the output format and location
of a hard copy.

The remote commands required to define the hard copy settings are described in
Chapter 6.8, "HCOPy Subsystem", on page 299.

Options
Opens the "Hard Copy Options" dialog for configuring the corresponding parameters
(see "File Options" on page 125.

Remote command:
n.a.

File
Some configuration parameters are already offered in the "Hard Copy" dialog. All con-
figuration parameters are available in "File Options" on page 125.

Automatic Naming

Activates automatic generation of the file name. Automatic naming is configured in the
"Options..." sub dialog , see "File Options" on page 125.

Remote command:

:HCOPy:FILE[ :NAME] : AUTO: STATe on page 303

File Info

Indicates the file name. The file name can be entered either manually via the file man-
ager (button "File...") or generated automatically (Automatic naming checkbox). Auto-
matic naming is configured in the "Options..." submenu.

Remote command:

:HCOPy:FILE[:NAME] on page 301

:HCOPy:FILE[:NAME] : AUTO: FILE? on page 302

4.2.5.2 Hard Copy Options

This section describes the "Hard Copy Options" dialog.

Image ——
|IFDrmat IF'NG jl Region IFuII Screenj

Automatic Naming
Automatic Maming ¥ On

Path... | vaarfuser
Delete All Image Files In Path Clear Path |

Prefic ¥ On |sgl

Year M On Month™ On Day W On
Current Auto Number W
Resulting File Name

59.... png
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Dialog for setting the file parameters.

"Format"

Selects the output file format, for example * . bmp,
*.Jjpg*.xpm*.png

Remote command:
:HCOPy: IMAGe : FORMat on page 300
:HCOPy:DEVice:LANGuage on page 300

"Region”

Selects the snapshot area, either the entire screen or the currently
active dialog.

Remote command:
:HCOPy :REGion on page 303

"Automatic
Naming"

"Path..."

If enabled, creates the output filenames automatically according to
rules following the activated components.

Selects the directory.

Note: To select the destination path, you have to specify a file name
as well. Otherwise an error message is displayed and the selection is
canceled.

Directory, path and file name are displayed in the infoline right to the
"Path" button.

Remote command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory on page 301
:HCOPy:FILE[:NAME] : AUTO? on page 301

"Clear Path"

Deletes all image files with extensions bmp, img, png, xpm and csv
in the directory set for automatic naming.

Before deleting the image files a warning message is displayed
requiring the confirmation.

Remote command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory:CLEar on page 302

"Prefix, Year,
Month, Day"

Determines the rules for "Automatic Naming".

Per default, the automatically generated file name is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>, where
Y, M and D mean Year, Month, Day; Number is the "Current Auto
Number".

You can deactivate/activate each component separately.

The "Resulting File Name" indicates the current file name syntax.

Remote command:

:HCOPy:FILE[:
:HCOPy:FILE
:HCOPy:FILE
:HCOPy:FILE
:HCOPy:FILE

NAME] :AUTO[:FILE] : PREFix:STATe on page 303
:NAME] : AUTO[ :FILE] : PREF1ix on page 303

:NAME] : AUTO[:FILE] : YEAR: STATe on page 302
:NAME] : AUTO[:FILE] :MONTh:STATe on page 302
:NAME] :AUTO[ :FILE] : DAY : STATe on page 302
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"Current Auto  Indicates the number which is used in the automatically generated file
Number" name.

Note: When initially switching on the instrument the number is reset
to the lowest possible value. Starting with number 0 the output direc-
tory is scanned for already existing files. As long as files with the
same name are existing the number is increased by 1. The number is
automatically set so that the resulting file name will be unique within
the selected path. The current number is not in the save/recall file but
will be temporarily stored within the database. At following save oper-
ations the number is increased.

Remote command:
:HCOPy:FILE[:NAME] : AUTO[ :FILE] : NUMBer? on page 302

"Resulting File Indicates the automatically generated file name.
Name"

Remote command:
:HCOPy:FILE[:NAME] : AUTO: FILE? on page 302

Save
Saves the hard copy.

Remote command:
:HCOPy [ :EXECute] on page 301

4.2.6 Messages - Info Key

The [INFO] key opens a window containing a detailed description of every message
displayed in the info bar, see "Info Window" on page 73 and Chapter 9, "Status Infor-
mation, Error Messages and Troubleshooting", on page 499.

4.2.7 Help System - Help Key

The [HELP] key opens a browser window containing a context-sensitive description of
the highlighted parameter.

elp - State = !]

-

Contents Index Back | =
Instrument Function > Modulations >
Amplitude Modulation (AM) > Amplitude
Modulation Menu > State

State

Activates/deactivates AM modulation.

SCPI command:

[:S0URce<hw>]:AM:5TATe |

Operating Manual 1407.0806.32 — 23 126



R&S®SMB100A Instrument Function

4.2.8

General Instrument Settings

The context-sensitive page which is opened with the [HELP] key is part of a compre-
hensive help system. It is possible to move from this context-sensitive page to any
page of the help system. The following navigation aids are available:

® Internal links in the text
They open pages which are directly linked to the described function. In this way it
is possible, for example, to call up the description of the GPIB command for any
particular function.

® Back
The "Back" button calls up the page last viewed.

® Contents in the navigation panel
The contents list is used to open the individual help pages. It has a hierarchical
structure. The highlighted line indicates where the currently displayed page is
within the contents list.

® |ndex in the navigation panel
The index is used to call up all pages which contain the selected entry. The index
has an alphabetical structure and also contains all GPIB commands.

® Find
The find function allows you to look for freely selectable terms in all help pages. A
list of the pages containing the entered term is displayed as the search result. The
search can be limited to words in the page title to increase the number of hits.

Storing and Loading Instrument Data - File Key

The R&S SMB allows complete instrument settings to be saved in files either on the
internal flash memory or on external USB memory devices.

Defined and complex instrument settings can then be reproduced at any time by load-
ing this data. If required, these settings can be loaded to various signal generators.

The corresponding menu is available under "Save/Recall" in the "Setup" menu. The
instrument settings are saved in files which can be saved in data directories.

Additionally there are intermediate memories in which the current instrument setting
can be saved and then called up again by just pressing a key. This provides fast
switching between different instrument settings.

Only settings which differ from the preset values and configuration data for the operat-
ing elements (e.g. window positions) are saved. As a result the files remain relatively
small. Furthermore, instrument settings can easily be transferred between different
equipped signal generators since the files contain only relevant information. When loa-
ded, the referenced settings are implemented and all non-referenced parameters are
set to the associated preset values.

If list data is part of the instrument settings, e.g. a list of user correction data, a refer-
ence to this list is saved, not the list itself. The list is reactivated when the associated
settings are loaded, but the list may have been modified or deleted in the meantime or
may not be available on a different instrument. If the list has been modified, the new
entries will be used. An error message appears if an attempt is made to access a non-
existing list or to activate settings which are not supported by the instrument.
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@ ® Network settings and remote settings are not saved and restored.

® Lists are saved and loaded in the appropriate menus. For example, the user cor-
rection data list is created and saved in the "User Correction" menu.

When loading an instrument setting, it is possible to select whether the current fre-
quency and level setting is to be retained or whether the saved settings are to be acti-
vated. It is possible to delete saved instrument settings. A file can be copied by loading
it with "Recall" and then storing it under a new name.

Settings can be transferred easily between instruments with different equipment
options and/or firmware versions because only the settings which differ from the preset
values are affected. When settings are loaded, only those which are possible on the
instrument are implemented. Error messages indicate the settings which cannot be
implemented.

The saved file is transferred from one instrument to another using the memory stick.

General file management functions such as copying and moving data are available in
the "File Manager" dialog.

4.2.8.1 Save/Recall Menu

The settings available in the File menu "Save/Recall" depend on the selected "Opera-
tion Mode".

Operation Mode ISave hd I

For more information, see "File Select Dialog" on page 88.

Operation Mode
Selects the file function.

Accesses the settings for storing ("Save") and loading ("Recall") of the instrument set-

tings.

"Save..." Calls the menu for storing the current instrument setting (see Chap-
ter 4.2.8.2, "Saving Instrument Settings", on page 128).

"Recall..." Calls the menu for calling up a saved instrument setting (see Chap-

ter 4.2.8.3, "Loading Instrument Settings", on page 130).

4.2.8.2 Saving Instrument Settings

In "Operation Mode > Save", you can save the current instrument setting in a file.

Operating Manual 1407.0806.32 — 23 128



R&S®SMB100A Instrument Function

General Instrument Settings

Operation MudelSave 'l ecent Files

Ivar/user/SavRcl
» [ Lists -
» [ Pulse Trains

» [ SavRel

» [J UCs2010

3@ /varivolatile =

File Name:
Ipresetsettings |

Save Save File
Imm 1 Imm 2 Magr...

Save ‘

Recent files
Displays the files last used.

Directory, File List and File Name

Note:

You access this generic standard function each time you perform one of the following:
® store or load (settings) files

e define a folder these files are to be stored in or

® navigate through the file system.

The name of the dialog is context sensitive but the provided functions are self-explana-
tory and very similar.

With the provided settings, you can perform the following:

® {o navigate through the file system, use the directory tree

® {0 load and store files, use the dedicated functions "Select", "Save" and Recent
files

® to perform standard file management functions, like create new directories, move,
copy, delete files and/or directories, use the standard "File Manager" function (see
"File Manager" on page 130).

Remote command:

to list all files in a directory:

:MMEMory:CDIRectory on page 309

:MMEMory:CATalog? on page 308

[ :SOURce] :CORRection:CSET:CATalog? on page 335

Save
Saves the current instrument settings in the specified file and path.

Remote command:
:SYSTem: SAV on page 443
:MMEMory: STORe: STATe on page 313

Save Immediate x
Saves the current instrument setting in one of the three intermediate memories.

These instrument settings are retained until a different instrument setting is saved in
the intermediate memory. When the instrument is switched off, the contents of the
intermediate memories are retained.
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Remote command:
*SAV on page 287

File Manager
Accesses the "File Manager" dialog, see Chapter 4.2.8.4, "File Manager",
on page 132.

Remote command:
n.a.

4.2.8.3 Loading Instrument Settings

In "Operation Mode > Recall", you can load complete instrument settings, and select
whether the current or saved frequency and level settings are to be used.

Save/Recall = E3

Operation Mode IRecaII vI Recent files |

Mvar/user/Lists/SavRcl

- =0 DME ]
ffh LevelCalData

ﬁ[ LfGenCalData

D e RS

: SavRel

+ﬁl wnCali LI
Exclude Frequencyl™ Exclude Level ™
Recall Recall Recall File
I 1 Imim 2 Mar...
Recent files

Displays the files last used.

Directory, File List and File Name

Note:

You access this generic standard function each time you perform one of the following:
® store or load (settings) files

® define a folder these files are to be stored in or

® navigate through the file system.

The name of the dialog is context sensitive but the provided functions are self-explana-
tory and very similar.

With the provided settings, you can perform the following:

® {o navigate through the file system, use the directory tree

® toload and store files, use the dedicated functions "Select", "Save" and Recent
files

® to perform standard file management functions, like create new directories, move,
copy, delete files and/or directories, use the standard "File Manager" function (see
"File Manager" on page 130).

Remote command:
to list all files in a directory:
:MMEMory:CDIRectory on page 309
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:MMEMory:CATalog? on page 308
[ :SOURce] :CORRection:CSET:CATalog? on page 335

Exclude Frequency
The current frequency is retained when a saved instrument setting is loaded.

Remote command:
[ : SOURce<hw>] : FREQuency [ :CW|FIXed] : RCL on page 348

Exclude Level
The current level is retained when a saved instrument setting is loaded.

Remote command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] : RCL on page 386

Recall
Loads the selected configuration.

If an instrument setting in which a sweep was activated is saved, the sweep starts
when the recall command is called.

If an instrument setting which accesses lists is saved, this list is also loaded.

If the list has been deleted in the meantime, an error message appears when the
instrument setting is loaded. If the list has been overwritten in the meantime, the new
entries will be used.

Remote command:
:MMEMory:LOAD: STATe on page 312
:SYSTem:RCL on page 443

Recall Immediate x
Loads the selected configuration from one of the three intermediate memories.

If an instrument setting in which a sweep was activated is saved, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is saved, this list is also loaded.

If the list has been deleted in the meantime, an error message appears when the
instrument setting is loaded. If the list has been overwritten in the meantime, the new
entries will be used.

A message appears if no instrument configuration is saved in this memory.

Remote command:
*RCTL on page 286

File Manager
Accesses the "File Manager" dialog, see Chapter 4.2.8.4, "File Manager",
on page 132.

Remote command:
n.a.
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4.2.8.4 File Manager

The "File Manager" is a tool very similar to a standard Windows Explorer and helps
you manage mass storage media and files saved on the R&S SMB.
You can perform the following tasks:

® Copying multiple files from disk to other media and vice versa, see Chapter 4.2.8.5,
"Accessing the File System of the Instrument and Transferring Files from and to the
Instrument", on page 133

® Copying files into another directory, see Copy and Paste
® Renaming and deleting files, see Rename and Delete
® Creating new directories on the follwoing drives:

— hard disk

— internal flash memory

— memory stick

See Create New Directory

anage (= 4
File Type Instrument State (*.savrcltxt) =
fvarfuser/Lists/SavRq All Files (")
=g oroyrea Instrument State (7 savrcltxt)
-3 DME ARB Wavefarm (*.wv)
(3 LevelcalD EJRtF’MSEJtng g*-(*nrlp) )
ist Mode List (*.|sw]
S LiCenCall 5Ty (v
=0 R
= ‘a SavRcl
%0 SynCalibData
Cut | Copy | Paste |
Rename | Delete | Create New Dirl

For more information, see "File Manager" on page 88.

File Type
Selects the file type to be listed. If you select a file type with a specific file extension,
only files with this extension are listed in the directory.

Remote command:
n.a.

Directory and File Name

Selects the directory in which the file to be deleted or copied is located. The dialog lists
all files in this directory. Selected files are highlighted. The path is indicated above the
directory window.

Unlike the "Save/Recall" and "File Select" dialogs, the "File Manager" displays the full
file names including extensions.

Remote command:
:MMEMory:CDIRectory on page 309
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Cut
Cuts the selected file. It can be pasted into a different directory using the "Paste" but-
ton.

Remote command:
:MMEMory:DELete on page 311

Copy

Copies the selected file. It can be pasted into a different or the same directory using
the "Paste" button. When pasting the file into the same directory file name

Copy of <file name> is given automatically. When pasting the file into a different
directory, the original file name is kept.

Remote command:
:MMEMory : COPY on page 309

Paste
Pastes the file that has been copied or cut before.

Remote command:
n.a.

Rename
Renames the selected file or directory. The new name can be entered in the "New File-
name" dialog.

Remote command:
:MMEMory :MOVE on page 312

Delete
Deletes the selected file. Before the file is deleted, a message appears prompting the
user to confirm deletion of the file.

Remote command:
:MMEMory:DELete on page 311

Create New Directory
Creates a new directory. The name of the new directory can be entered in the "New
Directory" dialog.

Note: When the subdirectory is entered, it is possible to enter an absolute path name
(e.g. /var/MEAS) or the path relative to the current directory (e.g. . . /MEAS).

The directory is created as a subdirectory in the selected level.

Remote command:
:MMEMory:MDIRectory on page 312

4.2.8.5 Accessing the File System of the Instrument and Transferring Files from and to
the Instrument

To access files and the file system of the instrument or to use the general file manage-

ment functions such as copying and moving data, use the standard "File Manager" dia-
log.
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To transfer files from and to the instruments or to exchange files, use one of the follow-
ing alternatives:

® Connect a memory stick to one of the USB interfaces.
The instrument recognizes automatically a connected memory stick.

® Connect the instrument to a LAN.
For information on how to set up a LAN connection, refer to Chapter 3.1.7, "Con-
necting to LAN", on page 24 .

An instrument connected to a LAN supports the standard file transfer methods from
a remote client:

— FTP (file transfer protocol)
see "To access the file system of the R&S SMB via ftp" on page 134

— File sharing according to the SAMBA/SMB (server message block) protocol
see "To access the file system of the R&S SMB via SMB (Samba)"
on page 135

Both file transfer methods access the folder /var/user/share.

This section provides an introduction to this topic. For comprehensive information, refer
to the Application Note 1GP72 "Connectivity of Rohde&Schwarz Signal Generators".

To access the file system of the R&S SMB via ftp

If the R&S SMB is connected to a LAN and the required configurations are completed,
you can use File Transfer Protocol (ftp) to access the file system and to transfer files
from and to the instrument.

1. Connect the instrument and the remote PC to a LAN.

2. Find out the "IP Address" of the instrument:
a) Select "Setup > Environment > Network Settings".
b) Write down the "IP Address" of the instrument, e.g. 10.7113.10.105.
3. On the remote PC, start the Windows Explorer.
4. Inthe address field, enter ftp://<"IP Address" of the Instrument>,e.g.
ftp://10.113.10.105
A log on dialog opens and requests a password.

Tip: Default password. The FTP file access use the user instrument with default
password instrument.

It is highly recommended that you change the user password in the "Security" dia-
log before connecting the instrument to the network!

See Chapter 4.2.3.14, "Security", on page 114.

5. Enter the password to access the /var/user/share directory.
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File Edit WView Favorites Tools Help ,’

—_ »»
> > i v
Qs - © - ¥ G F| Do
Address (@] fip://10.113,10. 105/ v| B co
MName Size | Type

Sbin File Folder

File Folder

< I >

User: instrument ‘:g Local intranet

You can access the files in the /var/user/ directory, perform standard function
like creating directory, etc.

6. Openthe /var/user/share directory and create a new directory, e.g. testftp.

7. On the instrument, press the [File] key and open the /var/user/share directory.

The dialog displays the testftp dircetory.

E% Save/Recall

Select Operation IRecaII 'I Recent ﬁlesliI
d: Avarfuserfshare

= varuser/share |

- testit
. P
Exclude Frequency [T Exclude Level I_ZI
Recall Recall Recall Recall File
ECa Imrm 1 Imm 2 Imm 3 Manager...

To access the file system of the R&S SMB via SMB (Samba)

The SMB (Samba) protocol is an alternative way to access the file system of the instru-
ment form a remote PC, if both the instrument and the PC are connected to a LAN.

1. Connect the instrument and the remote PC to a LAN.

2. Find out the "IP Address" of the instrument:

a) Select "Setup > Environment > Network Settings".
b) Write down the "IP Address" of the instrument, e.g. 70.113.70.105.

3. On the remote PC, start the Windows Explorer and open the "Map Network Drive"
dialog.
a) Select avalid "Drive", e.g. W.
b) In the "Folder" field, enter:
//<"IP Address" of the Instrument>/share or
//<"Hostname" of the Instrument>/share, e.g./10.113.10.105/share
c) Select "Finish".

A log on dialog opens and requests an user name and a password.
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4. Enter the user name and the password of your instrument.
The default user name and password is instrument.
Tip: Default password. The SAMBA/SMB file access use the user instrument with
default password instrument.
It is highly recommended that you change the user password in the "Security" dia-
log before connecting the instrument to the network!

See Chapter 4.2.3.14, "Security", on page 114.

The /var/user/share directory of the instrument is mapped to and displayed as
a network drive of the remote PC.

You can access the files in this directory, perform standard function like creating
directory, storing files, etc.

4.3 RF Block

4.3.1 Overview of RF Signal

Settings for the RF output signal and analog modulation are made under "RF Signal".
These settings can be accessed in the block diagram by way of the "RF" function
block, or by means of the menu with the same name which is opened using the
[MENU] key.

The function block is available for the basic unit (R&S SMB + frequency option) without
additional equipment options.

4311 RF Output

Basically, the RF output signal is deactivated. The previous state is restored, when the
signal is reactivated.

Activating RF Signal Output

If the settings for the RF signal are done, you can activate RF signal output via:
® the [RF ON/OFF] key (the current entry focus is irrelevant)
® the checkbox in the "RF" block (see "RF On" on page 137)

® the "RF Frequency > RF ON" checkbox in the RF block (see "RF Output State"
on page 137).
To open the menu, select the "Configure" button in the RF block.

The current state of the RF output (activated and deactivated) is indicated in the block
diagram by means of the different block color and the status of the "On" checkbox.

Operating Manual 1407.0806.32 — 23 136



R&S®SMB100A Instrument Function

4.3.1.2

RF Block

An active sweep is also indicated in the block.

RF
config... | RF RF
I_ On @_) e

To query the impedance of the RF outputs, use the command : OUTPut<hw>:
TMPedance? on page 316.

RF On
Activates RF signal output.

This function corresponds to the [RF ON /OFF] key.
See also Chapter 4.3.1.1, "RF Output”, on page 136.

Remote command:
:OUTPut<hw>[:STATe] on page 317

RF Output State
Activates the RF output signal by selecting the RF checkbox in the "Configure" dialog
of the "RF" block.
RF Freguency

W RF ON
Frequency f Phase...

Remote command:
:OUTPut<hw>[:STATe] on page 317

RF Signal Modes and Characteristics

e Cw
The RF signal is generated with the set frequency and level. This is the default
mode.

® Sweep

The RF signal is generated as a sweep with the set parameters.
It is not possible to activate frequency, level and LF sweep simultaneously.
® List Mode

The RF signal is generated on the basis of a list of predefined frequency and level
values. The duration of the individual steps can be predefined.

Instruments connected downstream can be taken into consideration when setting the
frequency and level by entering a frequency and/or level offset.

Automatic level control ("ALC") ensures maximum level accuracy.

User-specific lists which contain level correction values for any frequency range ("User
Correction") can be created to, for example, compensate the cable attenuation in a test
assembly setup.
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The R&S SMB generates the RF signal in unmodulated or analog form. The signal
generator is equipped therefore with the following sources for analog modulations:

® aninternal LF generator
® aninternal pulse generator
® the external modulation inputs [MOD EXT] and [PULSE EXT].

An external trigger signal for the sweeps and the LIST mode can be provided at the
[INST TRIG] input.

The input [REF IN] is used to input an external instrument reference, and the output
[REF OUT] serves as the output of the reference frequency (internal or external).

4.3.2 RF Frequency

The value of the RF frequency is displayed in the header of the display ("Freq"). This
field provides the direct input of the RF frequency. Alternatively, you can enter the RF
frequency in the "Frequency/Phase" dialog.

Frea(_REON )(__MODON ) Level
11.000 000 000 000{e#z -/ ]-30.00]éem =

Note that the displayed RF frequency in the header, and the RF output frequency,
entered in the "Frequency/Phase" dialog can be different, as explained in the following
section.

4.3.21 RF Frequency vs. RF Output Frequency

If you are working with a downstream instrument, e.g. a mixer or a frequency multiplier,
you can enter the related parameter value in the frequency settings dialog ("Offset",
"Multiplier").

The generator includes these parameters and displays the result in the "Freq" field in
the status bar, as if the downstream instrument and the generator were one unit. This
displayed frequency corresponds to the value at the RF output of the downstream
instrument. However, the frequency provided at the RF output of the signal generator
corresponds to the frequency value set in the "Frequency/Phase" dialog.

The instrument activates the "Freq Offset" icon in the status bar, when a frequency off-
set or multiplication factor is set.

The correlation between the RF frequency, the RF output frequency and the frequency
offset is as follows:

"Freq" (in header) = "RF output frequency" (Frequency in dialog) * "Multiplier" factor
(Multiplier in dialog) + "Freq offset" (Offset in dialog)

Downstream instrument:
- frequency offset / multiplication factor

—= - "Offset"/"Multiplier" in the settings dialog
= [S) [_[_[_ 8/ B9
S Hu\j g & €] 23 RF output (downstream instrument)
ey Ba 2 " oo connector frequency
E LLUBW“’ = Mixer/Multiplier "Freq" in the display of the signal generator

(status bar)
RF output

- connector f’f‘ECME‘HCy

- "Frequency"” in the seltings dialog
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If you have the R&S SMB equipped with one of the microwave frequency options
R&S SMB-B112, -B120, -B131 or -B140, you can, in addition, operate an R&S SMZxx
frequency multiplier.

xx represents the multiplier type that you can use according to the target frequency
range.

Note: Instruments with option R&S SMB-B112 only support the R&S SMZ75(M/E) fre-
quency multiplier models.

4.3.2.2 Setting the RF Frequency

To change the RF frequency, press the [FREQ] key and enter the desired frequency.
Changes to the RF frequency have an immediate effect (without confirmation with the
[Enter] key) on the output signal.

RF Freq

Enters the RF frequency, considering the frequency offset.

Note: The SCPI command sets the level of the "Freq" display, that means an entered
frequency offset and multiplier factor are considered in the frequency value.

Remote command:
[ :SOURce<hw>] : FREQuency [ :CW | FIXed] on page 347

4.3.2.3 RF Frequency Dialog

The combined "RF Frequency / Phase..." dialog contains the parameters required for
configuring the frequency and settings like a frequency offset, or a multiplier factor of
an externally connected multiplier, see Chapter 4.3.2.4, "Frequency Settings",

on page 140.

RF Frequency / Phase 3
Frequency Settings

|»

Frequency 403.000 000 000 Msz
Offset 0.000[Hz =]
Multiplier [ 1000
User Variation -
Variation Active r
Variation Step | 1.000 000 000 |MHz x|

Phase Settings ————
Delta Phase | D.O|deg |

Reset Delta Phase Displayl —

=l

Furthermore, the dialog provides additional settings parameters which are described
in:

® (Chapter 4.3.3, "Phase", on page 142
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4.3.2.4 Frequency Settings

RF Frequency —]  Access:
VRO
Frequency / Phase... » Select "RF > config... > RF Frequency > Frequency/Phase".
Frequency Settings
Frequency | 1.000 000 000 000 |GHz x|
Offset | 0.000[Hz ~|
Multiplier | 1.000

In the upper section of the combined "RF Frequency / Phase ..." settings dialog,
you can configure the frequency of the RF signal.

The remote commands required to define the settings are described in Chapter 6.13.4,
"SOURce:FREQuency Subsystem”, on page 346.

Frequency

Sets the RF frequency of the RF output connector. The frequency entered and dis-
played here corresponds to the frequency at the RF output, that means any offset entry
is not considered.

Note: Suppressed values in the status bar

For security concerns or certain operating modes, you can hide the frequency and
level display in the status bar.

® kkkkkk

The display has been disabled for security reasons.
See:

— Annotation Frequency

— Annotation Amplitude

©
The display is disabled when list mode is running, see "State - List Mode"
on page 194.

Remote command:

[ :SOURce<hw>] : FREQuency [ :CW|FIXed] on page 347

Note: This command sets the frequency of the "FREQ" display, that is the frequency
containing offset and multiplier.

Offset
Sets the frequency offset relative to the RF frequency. The frequency offset of a down-
stream instrument (for example a mixer) is entered.

The entry does not change the value of the RF frequency at the RF output. It only
changes the RF frequency displayed in the display header. The value of the RF fre-
quency in the header corresponds to the frequency at the output of the downstream
instrument, see also Chapter 4.3.2.1, "RF Frequency vs. RF Output Frequency",

on page 138.
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Remote command:
[ :SOURce<hw>] : FREQuency: OFFSet on page 350

Multiplier
Sets the multiplication factor for the RF frequency.

In the frequency field of the status bar, the instrument adjusts its frequency display
according to the set multiplication factor. This frequency value shows the frequency at
the output of the downstream multiplier. The entry does not change the RF frequency
at the RF output of the R&S SMB, see also Chapter 4.3.2.1, "RF Frequency vs. RF
Output Frequency", on page 138.

Remote command:
[ :SOURce<hw>] : FREQuency:MULTiplier on page 350

User Variation Settings

Access:

» Select "RF > config... > RF Frequency > Frequency/Phase".

User Variation———————
\ariation Active -
Variation Step | 1.000 000 000 | MHz ¥|

The combined "RF Frequency / Phase ..." settings dialog contains the parameters
determine the step size for adjusting the frequency with the rotary knob.

Variation Active
Activates the user-defined step width used when varying the frequency value with the
rotary knob.

"ON" The frequency value set with the rotary knob is varied using the user-
defined step width which is entered under "Variation Step".

"OFF" The frequency value set with the rotary knob is varied in steps of one
unit at the cursor position (standard operating mode).

Remote command:
[ :SOURce<hw>] : FREQuency: STEP : MODE on page 353

Variation Step

Sets the user-defined step width. This step width is used when entering the RF fre-
quency using the rotary knob. Frequency variation with this step width must also be
activated with "Variation Active".

Remote command:
[ : SOURce<hw>] : FREQuency:STEP [ : INCRement] on page 352
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4.3.3 Phase

The phase of the RF output signal can be changed in the "Phase Settings" section of
the "RF Frequency/Phase" dialog.

4.3.3.1 Phase Settings

[“S;g’jmmm ] » To access the dialog for configuring the phase settings, perform one of the follow-
ing:
e Select "RF > config... > RF Frequency > Frequency/Phase".
e Press the [menu] key and select "RF > RF Frequency > Frequency/Phase".

Phase Settings
IDeIta Phase | 0.0 | deg ;"
Reset Delta Phase Display |

The combined "RF Frequency / Phase ..." settings dialog contains the parameters
to configure the phase settings of the RF signal.

The remote commands required to define the settings are described in Chap-
ter 6.13.10, "SOURce:PHASe Subsystem", on page 378.

Delta Phase

Sets the phase of the RF signal. The current phase of the signal is used as the refer-
ence. This function allows, for example, the phase of the output signal to be synchron-
ized with the phase of a signal from a second signal generator.

Remote command:
[ : SOURce<hw>] : PHASe on page 378

Reset Delta Phase Display
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.

Remote command:
[ : SOURce<hw>] : PHASe : REFerence on page 378

4.3.4 Reference Oscillator

The R&S SMB is equipped with an internal reference oscillator that generates a refer-
ence frequency of 10 MHz. It is used as internal reference source for the synthesizer
and the local oscillator. Alternatively, you can apply an external reference signal.

Regardless of the used reference source (internal or external), the R&S SMB always
provides the configured reference frequency at the output. You can use it, for example
to synchronize several interconnected instruments.

@ The settings of the reference oscillator are not affected by an instrument preset ("PRE-
SET" key).
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The following examples briefly explain the possible test setups and the settings to be
considered.

® Internal f.; = 10 MHz (10 MHz [REF OUT])

Rohde & Schwarz Signal Generator Measurement
= Instrument
2 = [
10 MHz 10 MHz Oy |~ p| £10 MHz 2
Internal - 1t L
e T8
= Reference i o W
J h o
12 RF

JRF1

Figure 4-1: Synchronizing a subsequent instrument using the internal 10 MHz reference signal of
the R&S SVB

The internal reference oscillator supplies the reference frequency.
Settings:
— Source: "Internal"

® External f,s = 10 MHz (10 MHz [REF OUT])
If you have a clean external reference signal with 10 MHz frequency, you can
directly pass it to the output. The signal quality remains the same.

Rohde & Schwarz Signal Generator Measurement
e e ; Instrument e
10 MH=z ] 10 MHz Eb : = E-m MHz E:.'T__._
10 MHz 3, [= o 14 o
g
o> RF
10 MHz External Reference ‘

(o o T v RF
. Reference Frequency Source !
| (Rohde & Schwarz Spectrum

| Analyzer, for example) i
4

Figure 4-2: Synchronizing instruments by means of an externally applied reference signal having
10 MHz

Settings:
— Source: "External"
— External Reference Frequency: "10 MHZz"

Set the additionally provided parameters, as for example the synchronization band-
width according to the requirements of the application.

e External . = 5/10 MHz (5/10 MHz [REF OUT])

If you have an external reference signal with 5 or 10 MHz, you can directly pass it
to the output. The signal quality remains the same.

Operating Manual 1407.0806.32 — 23 143



R&S®SMB100A Instrument Function

RF Block
Rohde & Schwarz Signal Generator Measurement
ALe 5 s Instrument =
5,10 MHz 510MHz Q- ol =5 10 MH o}
5 10 MHz _ =|= = i iy ’ T
5, 10 MH N ES o o o
o
x RF
_L__5 or 10 MHz External Referance v R

,rReference Frequency Source
| (usertest system for example} 1

o i
Figure 4-3: Synchronizing a subsequent instrument an externally applied reference frequency of

5 or 10 MHz

Settings:
— Source: "External"
— External Reference Frequency: "5 or 10 MHz"

Input and output connectors of the reference frequency

The appropriate connectors are located at the rear panel, see "[REF IN]" on page 57
and "[REF OUT]" on page 57.

4.3.41 Reference Oscillator Settings

o . To access the settings dialog for configuring the reference signal, perform one of the
Frequency / Phase fO”OWing:
Reference Oscillatar

® |n the block diagram, select "RF > config... > RF Frequency > Reference Oscillator
® Press the [menu] key and select "RF > RF Frequency > Reference Oscillator"
® Press the [setup] key and select "Setup > System > Reference Oscillator”

Reference Oscillator 3 Reference Oscillator {
Source Internal = Source External =
) Deactivate RF Qutput
) . Adjustment ——————— (if external reference is missing) L
ST I External Reference Frequency |1 0 MHz "I
Adjustment DAC Value 476 o . -
Synchronisation Bandwidth |W|de "I

In the "Reference Oscillator Settings" dialog, you can select the signal source and fre-
quency to be used as the reference frequency, and determine a user-defined adjust-
ment value.

The remote commands required to define the reference oscillator settings are descri-
bed in Chapter 6.13.14, "SOURce:ROSCillator Subsystem", on page 409.

Source
Selects the source of the reference frequency.
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See Chapter 4.3.4, "Reference Oscillator", on page 142, which provides an overview of
the different test scenarios for configuring the reference frequency.

"Internal” Uses the internal 10 MHz reference signal, either with the calibrated
or a user-defined adjustment value.

"External” Uses an external reference signal.
The frequency of the external reference signal must be selected
under "External Reference Frequency" on page 145.

Remote command:
[ :SOURce] :ROSCillator:SOURce on page 412

Deactivate RF Output (if external reference is missing)
Turns the RF output off when the external reference signal is selected, but no signal is
supplied.

This function prevents that no improper RF signal due to the missing external refer-
ence signal is used for measurements. A message indicates that the external signal is
missing and the RF output is deactivated.

This setting is not affected by a reset.

Remote command:
[:SOURce] :ROSCillator:EXTernal :RFOFf[:STATe] on page 410

External Reference Frequency
Determines the frequency of the external reference signal.

You can select an external reference signal having a frequency of 5 MHz or 10 MHz.

Note: The installed hardware determines the available settings. Use the Hardware
Config dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[:SOURce] :ROSCillator:EXTernal : FREQuency on page 410

Synchronization Bandwidth
Selects the synchronization bandwidth for an external reference signal.

"Narrow" Synchronization bandwidth is 50 Hz.

"Wide" The synchronization bandwidth is approximately 350 Hz.
This mode is useful for very precise reference sources of high spec-
tral purity.

Remote command:
[:SOURce] :ROSCillator:EXTernal:SBANdwidth on page 411

Adjustment Active
Selects the adjustment mode.

"OFF" Uses the calibrated internal reference frequency.

"ON" Allows you to apply a deviation to the internal reference frequency,
according to your requirements. To enter the value, use Adjustment
DAC Value.
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Remote command:
[:SOURce] :ROSCillator[:INTernal] :ADJust[:STATe] on page 411

Adjustment DAC Value

Sets a user-defined deviation for the internal reference frequency. This value takes
effect when it is activated with Adjustment Active. "0" represents the calibrated state.
The setting range depends on the reference oscillator type and its factory calibration
value.

Note: A factory preset resets this setting to the calibration value of the instrument.

Remote command:
[:SOURce] :ROSCillator[:INTernal] :ADJust:VALue on page 411

RF Level

Overview of RF Level

Message "Level overrange/underrange”

If this message appears in the status line, the set level ("Level") is out of range (see
data sheet).

In this case, the signal level at the output can deviate from the set value.

The value of the RF level is displayed in the level field in the header of the display
("Level"). This field provides the direct input of the RF level value. Alternatively, you
can enter the level in the "Level/EMF/..." dialog.

Note that the displayed RF level in the header, and the RF output level, set in the
"Level/EMF" dialog can be different, as explained in the following section.
RF level vs. RF output level

If you are working with a downstream instrument, e.g. an attenuator or amplifier, you
can enter the related parameter value in the level settings dialog ("Offset").

The generator includes these parameters and displays the result in the "Level" field in
the status bar, as if the downstream instrument and the generator were one unit. This
displayed level value corresponds to the value at the RF output of the downstream
instrument. However, the level provided at the RF output of the signal generator corre-
sponds to the level value set in the "Level/EMF/..." dialog.

The instrument activates the "Level Offset" icon in the status bar, when a level offset is
set.

The correlation is as follows:

"Level" (in header) = "RF output level" (Level in menu) + "Level offset" (Offset in menu)
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Downstream instrument
- level offset
- "Offset" in the seftings dialog

e o cee Bl e[ e
pooo el ) el

2 000 8| SEa E]L.
EJLUU(B‘G.:D[;-‘L’

RF output (downstream instrument)
- output level
- "Lev"in R&S signal generator's display (status bar)

RF output:
Attenuation/gain  ——— - level at the connector
- "Amplitude"” in the settings dialog

The RF output is protected against overloading by an external signal applied to the RF
output (see Chapter 4.3.5.7, "Reverse Power Protection”, on page 167).

Setting the RF level

To change the RF level, press the [LEVEL] key and enter the desired level. Changes to
the RF level have an immediate effect (without confirmation with the Enter key) on the
output signal.

RF Level

Enters the RF level, considering the level offset (see "RF level vs. RF output level"
on page 146).

dBm, dBuV, mV and pV can be used as the level units. The four unit keys are labeled
with these units.

Note: The SCPI command sets the level of the "Level" display, i.e. an entered level off-
set is considered in the level value.

Remote command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] [ :AMPLitude] on page 384
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4.3.5.2 RF Level Dialog

Access:

» Select "RF > config... > RF Level > Level/Attenuator".

RF L evel / EMF x
Level Settings
Mode |Normal |

Amplitude I -3U.UU|dBm vl
Limit I SU.UﬂldBm vl
Offset I U.UUIdB vl

Ignore Level Range Warnings [~ On

Attenuator Settings

Mode IAuto "I
Fixed Range (PFPY In-
4865 .. | -2965 dBm

RF OFF Mode |FuIIAttenuati0n vl

UserVariation
Variation Active

l_
Yariation Step | 1.00|dB 'I

Power-On [ EMF Settings

Power-0On State |RF off "I

Display Level as Voltage of EMF [~

Ext Level Adjustment

Adjustment Data |Fa:tor\r 'I

The offset-free level, level offset and level limit are set in the top section of the dia-
log. The attenuator mode is set in the "Attenuator Settings" section.

In section "User Variation", you can determine the step size for adjusting the level
with the rotary knob (with "Variation Active On").

The power-on behavior of the instrument and the level display in the display
header are set in the "Power-On / EMF Settings" section (see Chapter 4.3.5.3,
"Power-On/EMF Settings", on page 153).

The remote commands required to define the settings are described in Chap-
ter 6.13.12, "SOURce:POWer Subsystem", on page 382.

Level Settings

The offset-free level, attenuation mode, level offset and level limit are set in the top
section of the dialog.

If you have the instrument equipped with a harmonic filter, you can also configure the
filter.

RF Mode
Selects the level mode for signal output.

This function allows you, to optimize the RF output signal for applications, where
improved harmonic suppression or a low Signal-to-Noise ratio is required.
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Note: The modes "Low Distortion" and "Low Noise", for improving harmonic suppres-
sion or the S/N ratio require that an attenuator is fitted.

"Normal" The generator provides an RF output signal with high signal to noise
ratio as well as low distortion, according to the data sheet.

"LOW Noise" This setting forces the generator to optimize the signal to noise ratio.

"LOW Distortion"
The generator reduces distortion (harmonics) of the RF signal.

Remote command:
[ : SOURce<hw>] : POWer : LMODe on page 387

Amplitude
Sets the RF level of the RF output connector.

The level entered and displayed here corresponds to the level at the RF output, that
means any offset entry is not considered.

Note: Suppressed values in the status bar

For security concerns or certain operating modes, you can hide the frequency and
level display in the status bar.

® kkkkkKkK

The display has been disabled for security reasons.
See:

— Annotation Frequency

— Annotation Amplitude

-
The display is disabled when list mode is running, see "State - List Mode"
on page 194.

Remote command:

[ :SOURce<hw>] : POWer : POWer on page 388

Note: The SCPI command [ : SOURce<hw>] : POWer [ :LEVel] [ : IMMediate] [ :
AMPLitude] sets the level of the "Level" display, that is the level containing offset.

Limit - RF Level
Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter
an RF level above this value, the instrument limits the output power to this specified
value, and generates a warning message.

However, the level indication in the status bar is not affected.

Note: The limit value is always effective, regardless of whether you work with "NRP
Power Control" or not.

The value is not affected by an instrument preset ((PRESET] key), *RST and the
"Save/Recall" function. It is influenced only by the Factory Preset and the factory value
is equal to maximum level.

Remote command:
[ :SOURce<hw>] : POWer:LIMit [:AMPLitude] on page 386
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Offset (Level)
Sets the level offset relative to the RF level.

The level offset of a downstream instrument (for example an attenuator or amplifier) is
entered.

The entry does not change the value of the RF level at the RF output. It only changes
the RF level displayed in the display header. The value of the RF level in the header
corresponds to the level at the output of the downstream instrument.

Remote command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] : OFFSet on page 385

Ignore Level Range Warnings

Suppresses warnings the instrument generates when either the level, or the PEP value
are out of range. This function prevents automated measurements from being stopped
due to a level warning.

The following warnings are suppressed in both, the history and in the error queue:

® |[evel overrange / level underrange

® PEP value greater than defined upper bound / PEP value less that defined lower
bound (fix range)

Remote command:
[ :SOURce] : POWer : WIGNore on page 386

Low Harmonic Filter Settings

In 20 GHz or 40 GHz instruments (option R&S SMB-B120(L) /-B140(L)), you can install
a low harmonic filter (option R&S SMB-B25 /-B26), to improve the harmonic perfor-
mance.

See the website http://www.rohde-schwarz.com/product/smb100a.html or the data-
sheet for more information on the options available according to the features of your
instrument.

For a fitted low harmonic filter, you can define its operating mode in section "Low Har-
monic Filter" of the "RF Level / EMF" dialog. Otherwise, the section is hidden.

RF Lewel

Levet/ Attsnntor » To access the filter settings, select "RF > Config > RF Level > Low Harmonic Fil-
. ter".

armonic Filter.

Lowe Harmanic Filter

Mode IManuaI 'I

State On =

Mode
Selects between automatic or manual switching of the filter.

"Auto" The filter switches automatically on and off, according to the given
operating conditions. It is active within a certain frequency and level
range and automatically turns off, if the frequency falls below the
lower limit, or the level exceeds the upper limit.

The corresponding limit values are given in the data sheet.

Note: The State field shows the current state of the filter.
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"Manual" In this mode, you can switch the filter individually.

Remote command:
:OUTPut<hw>:FILTer:AUTO on page 315

State
Switches the filter in manual mode.

Note: If you work in the "Auto" Mode, this parameter shows the current state of the fil-
ter. If you then change the state, the operation mode automatically turns to manual
operation.

Remote command:
:0UTPut<hw>:FILTer [:LPASs] :STATe on page 316

Attenuator Settings

The R&S SMB can be configured to provide level settings without interruption. It is pos-
sible for instruments with or without step attenuator. The attenuator mode is set in the
"Attenuator Settings" section of the "RF level / EMF" dialog.

Attenuator Mode
Sets the attenuator mode at the RF output.

"Auto" Standard mode.

"Fixed" When this operating mode is switched on, the attenuator, relays and
amplifier stages are fixed in their current positions to provide level
settings without interruption. The resulting variation range is defined
and displayed under "Attenuator Fixed Range".

Note: The function is effective when automatic level control is activa-
ted ("ALC State = On").

If the normal variation range is overranged or underranged, level
errors increase considerably and the warning "Level under/over-
range" appears in the info line. The spectral purity of the output signal
decreases with high attenuation.

Remote command:
:OUTPut<hw>:AMODe on page 315

Fixed Range (PEP) In
Displays the level range in which the level is set without interruption for the "Attenuator
Mode fixed" setting.

Remote command:

:OUTPut<hw>:AFIXed:RANGe:UPPer? on page 314
:OUTPut<hw>:AFIXed:RANGe:LOWer? on page 314

RF OFF Mode

Selects the attenuator mode, when the RF signal is switched off.

The setting of the RF OFF mode is not affected by an instrument preset ([PRESET]
key), *RST and the "Save/Recall" function. This parameter is influenced only by the
Factory Preset.
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"Unchanged" Freezes the setting of the attenuator when RF is switched off. The
attenuator is only activated when RF is switched on.
This setting is recommended if a constant VSWR (Voltage Standing
Wave Ratio) is required.
Furthermore, on instruments equipped with a mechanical attenuator,
it provides fast and wear-free operation.

"Full Attenuation”
Sets attenuation to maximum when the RF signal is switched off. This
setting is recommended for applications that require a high level of
noise suppression.

Remote command:

[ : SOURce<hw>] : POWer:ATTenuation:RFOFf :MODE on page 384

User Variation

If the level is set using the rotary knob, the step width is defined in the "User Variation"

section.

Variation Active
Activates the user-defined step width used when varying the level value with the rotary

knob.

"ON" The level value set with the rotary knob is varied using the user-
defined step width which is entered under "Variation Step".

"OFF" The level value set with the rotary knob is varied in steps of one unit

at the cursor position (standard operating mode).

Remote command:
[ :SOURce<hw>] : POWer : STEP: MODE on page 392

Variation Step
Sets the user-defined step width for entering the RF level using the rotary knob. Level
variation with this step width must also be activated with "Variation Active".

Remote command:
[ :SOURce<hw>] : POWer: STEP [ : INCRement] on page 391

External Level Adjustment

The external level adjustment provides information about the data that has been used
for calibrating the RF level.

By default the instrument uses correction data obtained in the factory before delivery.
In exceptional cases, you can determine the calibration values with an R&S NRP
power sensor, and use these values for the external level correction. This feature is a
protected function (see Service Manual, chapter 2, "Adjustment").

Adjustment Data
Indicates what data has been used for level calibration.

Remote command:
:CALibration<hw>:LEVel :EXTern:DATA on page 292
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4.3.5.3 Power-On/EMF Settings

The power-on behavior of the R&S SMB and the level display in the display header are
set in the "Power-On / EMF Settings" section of the "RF Level/EMF" dialog.

To open the "RF Level/EMF" dialog, select "RF > Configure > EMF" or use the [MENU]
key under "RF".

Power-On / EMF Seftings

Fower-On State IPrevious Setting v|

Display Level as Voltage of EMF r

Power-On State - RF Signal
Selects the state which the RF output is to assume after the instrument is switched on.

"RF Off" The output is deactivated when the instrument is switched on.

"Previous Set- When the instrument is switched on, the output assumes the same
ting" state as it had when the instrument was switched off.

Remote command:
:OUTPut<hw>[:STATe] : PON on page 317

Display Level as Voltage of EMF - RF Level
Activates display of the signal level as voltage of the EMF (no-load voltage). If this set-
ting is deactivated, the level is displayed as a voltage over a 50 Ohm load.

Note: This setting is not affected by an instrument preset ([Preset] key), *RST) or the
"Save/Recall" function. Only the Chapter 4.2.3.16, "Factory Preset", on page 122
resets the setting.

Remote command:
[ :SOURce<hw>] : POWer : EMF: STATe on page 384

4.3.5.4 Automatic Level Control - ALC

Your signal generator is equipped with an automatic level control unit to obtain best RF
level accuracy.

Automatic Level Control (ALC) is an adaptive control system to stabilize the RF output
level. It continuously monitors the current level and adjusts it to keep a steady state
over temperature and time.

ALC is active in almost all applications by default. However, the Pulse Modulation
mode excludes ALC, as the control loop would detect incorrect values and result in
level deviations.

Also note that ALC may detect incorrect values in multi-transmitter test setups. If mul-
tiple generators are coupled, reverse power may affect the ALC readings. Based on
incorrect values, ALC would have an impact on the signal to intermodulation ratio.
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ALC States

The following description basically explains the ALC states and their principle of opera-
tion. In particular ALC OFF (Sample & Hold) gives an overview on the function in
terms of the equipment of the generator.

The R&S SMB offers the ALC states:

® AUTO

automatically adjusts the output level to the operating conditions.
e On

enables ALC permanently, regardless of the currently selected mode.
o Off

deactivates ALC.

The instrument switches to Sample & Hold (S&H) state, which still allows to main-
tain a constant output level.

The following section explains the functionality of "Sample & Hold", to provide an over-
view and to indicate what is to be considered. "On" and "Auto" require no additional
explanation. Furthermore, find the ALC state settings described in detail in State - ALC.

ALC OFF (Sample & Hold)

In "S&H" mode, the signal generator switches for a short period of time into CW mode
and activates ALC. ALC adjusts the level to the set value and the generator holds the
value (freeze). Then, the generator switches ALC off again and back to the operating

mode.

RF output behavior during Sample & Hold depends on the configuration of your instru-
ment. Instruments equipped with...:

® an electronic step attenuator
The level is decreased by 30 dB.

® a mechanical step attenuator
By default, the mechanical step attenuator is not switched during S&H cycles to
optimize the settling time. The instrument provides the output power for 3 ... 5 ms.
However, you can affect the attenuation at the output by the setting "RF during
Power Search" to "Minimum", see RF During Power Search - ALC. Then the gen-
erator decreases the level by 30 dB with the mechanical attenuator. Note that this
may take a certain period of time.
High frequency instruments, such as the R&S SMB with one of the high frequency
options R&S SMB-B120 or R&S SMB-B140, are equipped with a mechanical step
attenuator.

® no step attenuator
The signal generator outputs the set level for 3 to 5 ms after level or frequency set-
ting during a Sample & hold measurement.
Instruments equipped with one of the options R&S SMB-B112L, R&S SMB-B120L
or R&S SMB-B140L come without step attenuator.

The level control status is permanently displayed as a status message in the info line.

| ALC-Auto Infa

Operating Manual 1407.0806.32 — 23



R&S®SMB100A Instrument Function

RF Block

Automatic Level Control Settings

RF Level

e 10 Open the "Automatic Level Control" dialog, select "RF" > "Configure” > "Automatic
Alemeriemlentils — Level Control" or use the [MENU] key under "RF".

The combined dialog "ALC / UCOR" is divided into the several sections and provides
access to the "Automatic Level Control" settings and to function "User Correction", see
Chapter 4.3.5.6, "User Correction", on page 159).

‘Automatic Level Control
State On o
Rf During Power Search INorrnaI %
Search Once |
State - ALC

Activates/deactivates internal level control.

"Auto" The instrument selects the most appropriate ALC mode automatically.
ALC is on in most operating conditions. Default state.

"On" Activates ALC, regardless of the operating conditions.

"Off (Sample & Hold)"
Deactivates internal level control.
Sample & hold closes the level control loop at every frequency and
level change for a short period of time. The level control voltage is
sampled and then clamped.

Remote command:
[ :SOURce<hw>] : POWer:ALC[:STATe] on page 383

RF During Power Search - ALC
Activates the mode for the mechanical step attenuator and for output during ALC
power search.

"Normal" The RF output is active during power search.
"Minimum" The RF output is inactive during power search.

Remote command:
:0UTPut<hw>:ALC:SEARch:MODE on page 315

Search Once - ALC
Forces the generator to execute level adjustment once, although the "Sample & Hold"
mode is active.

Remote command:
[ :SOURce<hw>] : POWer :ALC: SONCe on page 383

4.3.5.5 NRP Level Control

With the NRP Level Control function, you can achieve a very stable and accurate RF
power supplied to your DUT. With the aid of a downstream control circuit, a CLPC
(Closed Loop Power Control), you can detect frequency response characteristics of the
used components, such as losses due to cables, modules or components like power
amplifiers, and compensate these effects accordingly.
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Example: How to set up a closed loop power control

R&S SMB100A Signal

Generator \\/

-7 Armplifier ODUT 4 Antenna
RF lzvel [ ["=xdBE ] inputlevel
L [ Coupler|
R&S NRPxx
Power Sensor
L.

POWEF controf: pi ",
: .
o,

\J‘% target level
D EVE

S Parameter (optional)

Figure 4-4: Example of a test setup with NRP Level Control

As shown in the example, the sensor measures a proportional power in defined time
intervals, derivated from a coupler. It considers optionally given S-parameters and
returns the results to the generator. The signal generator compares the measured level
with the set value and adjusts its output level accordingly.

This allows you to control the external signal level continuously and reliably reach a
constant input level at the DUT in real time.

@ Impact of the NRP Level Control and the Operating Modes

Since the frequency and level of the RF output signal are continuously adjusted during
"NRP Level Control", this operating mode interferes those with varying frequency and
level values.

The reason is, that the generator regularly transmits the output frequency to the con-
nected R&S NRPxx power sensor, which in turn requests the signal generator to adjust
the output level according to its measurement. In contrast to this real time control loop,
for example the list operating mode already generates the RF output signal on previ-
ously optimized frequency and level value pairs. In this case, the "NRP Level Control"
as a second control loop would impact the already determined RF signal values and
also considerably slow down the measurement. Similar impacts occur in sweep mode,
and also the "NRP Power Viewer" and "NRP Level Control" affect each other's func-
tionality.

Hence, the operating modes exclude each other as follows:

® "NRP Level Control" automatically disables NRP Power Viewer, and vice versa.

® Activating the RF frequency sweep, RF level sweep or the list mode instantly deac-
tivates a running "NRP Level Control".

® A running list or RF sweep mode blocks "NRP Level Control". It can not be activa-
ted.

Also keep in mind that modulated signals may differ from CW signals regarding mean
power and peak power. This affects the operation of "NRP Level Control".
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NRP Level Control Settings

» To access the dialog for configuring the level control settings, perform one of the
following:

e Select "RF > config... > RF Level > NRP Level Control".
e Press the [menu] key and select "RF > RF Level > NRP Level Control".

0 ol (R

1-NRP18SN S/N 101748 d
Measured Level | -54.53 dBm
Zero |
Target Level | -10.00|/dBm x|
Rf Level Limit | 30.00|/dBm =]
CatchRange +/- | 30.00|dB -]
Delay Time | ﬂlms B
Use Peak Power [ On
Use SParameter [ On

The dialog contains all parameters for configuring the settings for level control test
setup.

The remote commands required to define these settings are described in Chap-
ter 6.13.12, "SOURce:POWer Subsystem", on page 382

Sensor
Selects the R&S NRP power sensor for power control.

Note: In remote control, the sensors are set up using the SENSe commands. The
remote measurement is triggered by the READ query which also provides the measure-
ment results.

The software version of the connected power sensor can be retrieved by means of the
remote control command : SENS: POW: TYPE?.

Use the "Setup >" Chapter 4.2.3.4, "NRP Info/Update", on page 101 dialog to update
the sensor software.

Remote command:
[ : SOURce<hw>] : POWer: SPC:SELect on page 390

State
Activates power control using the selected sensor.

The control loop periodically adjusts the generator output. After switching off, the run-
ning loop is completed.

Remote command:
[ :SOURce<hw>] : POWer:SPC:STATe on page 390
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Measured Level
Indicates the current reading of the sensor.

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:

® During warm up after switching on or connecting the instrument

After a substantial change of the ambient temperature

After fastening the power sensor module to an RF connector at high temperature

After several hours of operation

When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.

® Switch off the RF power source for zeroing, but do not disconnect it from the power
sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Remote command:
:SENSe<ch>[:POWer] : ZERO on page 330

Target Level

Specifies the nominal level expected at the input of the sensor. The signal generator
adjusts the output power accordingly, in order to meet the target value at the sensor
input, and thus the power required at the DUT.

Remote command:
[ :SOURce<hw>] : POWer:SPC: TARGet on page 390

Limit - RF Level
Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter
an RF level above this value, the instrument limits the output power to this specified
value, and generates a warning message.

However, the level indication in the status bar is not affected.

Note: The limit value is always effective, regardless of whether you work with "NRP
Power Control" or not.

The value is not affected by an instrument preset ((PRESET] key), *RST and the
"Save/Recall" function. It is influenced only by the Factory Preset and the factory value
is equal to maximum level.

Remote command:
[ :SOURce<hw>] : POWer:LIMit [ :AMPLitude] on page 386
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Catch Range +/-
Sets the capture range of the control system.

Within the range:
Target Level +/- Catch Range

the power control locks and tries to achieve the target level. Readings outside the
range are not considered.

Remote command:
[ : SOURce<hw>] : POWer : SPC: CRANge on page 389

Delay Time
Defines a waiting period between the level adjustment of the generator and the next
measurement of the power sensor.

With this parameter, you compensate any dead times in the controlled system.

Remote command:
[ :SOURce<hw>] : POWer:SPC:DELay on page 389

Use Peak Power
Activates control by means of the peak power values, provided the power sensor sup-
ports this function. Otherwise, the dialog does not show this parameter.

Remote command:
[ :SOURce<hw>] : POWer: SPC: PEAK on page 390

Use SParameter - Power Sensors
Activates the use of the S-Parameter correction data of the connected power sensor.
For sensors with attenuator this checkbox is automatically checked.

Refer to the manual of the connected R&S NRP power sensor for a description on how
to use the SParameter table.

Remote command:
:SENSe<ch>[:POWer] : CORRection:SPDevice: STATe on page 323

4.3.5.6 User Correction

The "User Correction" function is used to create and activate lists in which level correc-
tion values predefined by the user are freely assigned to RF frequencies. Correction is
performed by the user-defined table values being added to the output level for the
respective RF frequency.

With frequencies which are not contained in the list, the level correction is determined
by interpolation of the closest correction values.

The lists are created in the "List Editor". Each list is stored in its own file with the prede-
fined file extension *. uco. The name of the User Correction file can be freely
selected. The files are loaded from the "Lists..." file manager. Externally created tables
with pairs of frequency and level values can be converted into User Correction files
using the import function. The external files must have the file extension * . txt or

* _csv. These file formats are provided e.g. by the Microsoft Excel program. The sepa-
rators for table columns and for decimal floating-point numerals can be set. In addition,
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internally created User Correction data can be exported into ASCII files using the
export function.

The amplitude can also be linearized automatically by means of an R&S NRP power
sensor connected to one of the generator output signals. With the aid of the "Fill with
Sensor" function, a table with correction values for external test assemblies can be
automatically determined, e.g. for compensating the frequency response of cables.
The User Correction list with the correction values acquired by the sensor is generated
in the "Edit User Correction List" menu. The correction values can be acquired any
time irrespective of the modulation settings of the generator.

If user correction is activated, the "UCOR" display (User Correction) is shown in the
header together with the "Level" display. The RF output level is the sum of both values.

"Level" + "UCOR" = Output level

If activated, user correction is effective in all operating modes.

User Correction Menu

Lo To open the "User Correction" menu, select "RF > Configure > User Correction" or use
BYE| enuator...

Autornatic Level Control . the [MEN U] key Under "RF".

MNRP-Z Level Contral
User Correction

The combined menu "ALC/UCOR" is divided into the several sections.

User Correction Settings

The "User Correction" settings are set in the most lower section of the combined dia-
log; this section is used to activate/deactivate user correction, and to create, select and
activate the lists.

The upper section provides access to the automatic level control settings, see Chap-
ter 4.3.5.4, "Automatic Level Control - ALC", on page 153.

User Correction Settings

User Correction I 0.00 dB

User Cor. Data... | ucor
Edit User Cor. Data... |

ImportExport === |

State - User Correction
Activates/deactivates user correction.

The "UCOR" status message appears in the frequency and level display.

Remote command:
[ :SOURce<hw>] :CORRection|[:STATe] on page 342

User Correction Value - User Correction
Indicates the current value for level correction.

Remote command:
[ : SOURce<hw>] : CORRection:VALue? on page 342
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User Cor. Data - User Correction
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

Select User Correction Data
MNew User Correction Data
File Manager...

Remote command:

[:SOURce] : CORRection:CSET:CATalog? on page 335

[ :SOURce<hw>] : CORRection:CSET[:SELect] on page 341
[:SOURce] : CORRection:CSET:DELete on page 337

Edit User Cor. Data - User Correction
Calls the editor for editing the selected user correction list.

A list consists of any number of frequency/level value pairs. The currently selected list
is displayed.

Each list is saved as a separate file with extension * . uco. The file name and the direc-
tory to which the file is saved are user-selectable.

Note: Save list only after filling both columns (frequency and level), otherwise the
entries are lost.

1 Data ucor list [ |
Frequency/Hz FPower/dB

B 5 300 000.00 542

7 £ 300 000.00 473

B 7 300 000.00 415 J

g 8 300 000.00 372

10 3 300 000.00 3.28 | +|
Goto || Edit I Save |

"Frequency /H Enters the frequency to which the level correction value applies.

Note: The "Fill..." function allows to automatically enter any number
of frequencies with freely selectable range and increment.

Using the "Fill With Sensor" function of the "Edit" sub menu requires
only the entry of the frequency values. The level values are automati-
cally acquired by the connected power sensor.

"Power/dB" Enters the level correction value to which the specified frequency
applies. The values can be entered manually or automatically with the
"Fill With Sensor" function (available in the "Edit" sub menu).

"Goto" Selects row for editing.

Gota First
Goto Last
Goto Row...

If Goto row is selected, a window opens for entering the requested
row.

oK | cancer |
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Calls a selection of possible actions described below.

Insert Row
Insert Range...
Fill...

Fill With Sensor...
Delete Row
Delete Range...

Insert a new row before the marked row.

Insert new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

IRuws to Insert I I

OK | Cancel |

Opens a sub menu for defining a set of list values to be automatically
entered in the ucor list (see "Filling the Correction List automatically”
on page 164).

Calls the menu to activate the filling of the user correction list with
level values acquired by the selected power sensor (see "Filling the
Correction List with Power Sensor Measurement Data" on page 165).

Deletes the marked row.

Allows to delete any number of rows starting with the marked row.
The number of rows to be deleted can be defined in an entry window.

IRuws to Delete I I I

0K | Cancel |

The list is saved under its current name.

Remote command:

[ : SOURce<hw>] : CORRection:CSET[:SELect] on page 341

[ : SOURce<hw>] : CORRection:CSET:DATA: FREQuency on page 335
[ :SOURce<hw>] : CORRection:CSET:DATA: POWer on page 336

Import/Export

User correction list can be imported from externally created files or exported into text or
CSV-files. The import/export settings are available after clicking the "Import/Export"

button.

Import/Export >>>
Expands the menu with the area for import and export of user correction files.

Externally edited Excel tables with any number of frequency/level value pairs can be
imported as text or CSV-files and used for user correction.

Conversely, you can also export internally created user correction lists as text or CSV-

files.
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<<= Hide |mDOI'UEXDOI‘t| === Hide ImporLfExportl

Import / Export UCOR Files ————Impaort/Export UCOR Files
lode fimport  ~ lode [Expor 'ii

ASCII File Settings———— — ASClFile Setings———
ST o B Extension T

Decimal Point IP-Jint vl Decimal Point IP-Jint ,l
Sl ST IC':"“'“a :I' Column Separator IC-Jmma vl

Select ASCIl Source | Select ASCII Destinatimj
Select Destination | Select Source |

| it
LI Export |

Mode - User Correction
Selects if user correction lists should be imported or exported. The settings offered
depend on the selected mode.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange : MODE on page 340

Extension - User Correction
Selects the file extension of the ASCII file to be imported or exported. Selection "TXT"
(text file) or "CSV" (Excel file) is available.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe:EXTension on page 338

Decimal Point - User Correction
Selects the decimal separator used in the ASCII data between '.' (decimal point) and ',
(comma) with floating-point numerals.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:DECimal
on page 339

Column Separator- User Correction
Selects the separator between the frequency and level column of the ASCII table the
user correction list is exported to or imported from.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:COLumn
on page 339

Select ASCII Source / Destination - User Correction
Calls the "File Manager" for selecting the ASCII file to be imported into a user correc-
tion list (source) or the ASCII file the user correction list is exported (destination) in.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe:SELect on page 338
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Destination / Source - User Correction
Calls the "File Manager" for selecting the user correction list to be exported (source)
into an ASCII file or the destination for the ASCII file to be imported (destination) in.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:SELect on page 341

Import / Export - User Correction
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as user correction list.
When export is selected, the user correction list is exported into the selected ASCII file.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:EXECute on page 340

Filling the Correction List automatically

The "Fill Table" menu enables you to automatically set the level correction values.

Fill User Correction Data

From I 1
Range I 3
Select column to fill IFrequencyIHz vl

Start Value | 0.00 [Hz =]
End Value | 0.000 000000000 |Hz =]
Increment Value | 0.000 000 000 000 | Hz j

The start line and the number of rows to be filled are defined under "From" and
"Range."

The column to be filled is selected under "Select column to fill". Depending on the
selection here, the default for start, end, and increment value are set. As the settings
are interdependent, a change of one parameter may result in the automatic change of
one or more of the other parameters. The filling of the column with the selected value
settings is started with button "Fill".

@ The correction list entries are only computed when the "Fill" button is pressed.

From
Sets the start value of the index range.

Remote command:
n.a.

Range
Sets the range for filling the table.

Remote command:
n.a.
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Select column to fill
Selects either the frequency or the level column to be filled with the value defined
below.

Remote command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

Remote command:
n.a.

End value
Displays the end value for the frequency or the level entries.

Remote command:
n.a.

Increment value
Sets the increment for the frequency or the level entries.

Remote command:
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.

Remote command:
n.a.

Filling the Correction List with Power Sensor Measurement Data

The level correction values for the user correction list can be acquired by means of
R&S NRP power sensors. The R&S NRP sensors are connected to either the
[SENSOR] connector or to one of the [USB] interfaces. Configuration of the connection
is performed in the "Power Sensor" menu (see Chapter 4.3.6.2, "NRP Power Viewer",
on page 170). The filling of the user correction list with measurement data is performed
in the ucor list editor (see "Edit User Cor. Data - User Correction" on page 161).

In the editor, the frequencies for which the correction values are to be acquired are
entered in the frequency column (either manually or by means of the "Fill..." menu).

Do not save the list at this point, because the frequency entries are lost as long as
there are no entries for the level column also. In the following these entries are auto-
matically acquired by the connected power sensor.

All level correction values for the given frequency values are measured using the
Power Sensor and automatically filled in the selected list after the "Execute" button is
pressed. The list is automatically stored and recalled again after filling.
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Fill User Correction Data with Sensor Settings

The "Fill with Sensor" button of the "Edit User Correction Data" menu opens the asso-
ciated menu.

Sensor |1 - NRP-Z11 3/M 200001 K4
List To Fill IUZJUSETCONECIIOI'IDETE

— Used SLIB Setings For Measuremeant—
WMadulation [orcwy
Amplitude lmlm
Use SParameter [ or
Attenuator Mode |

Fixed Range (PEP} In

|5 980.0 ... 6000.0 dBm

This dialog describes all parameters for filling a table automatically with sensor read-
ings.

To select the sensor and determine its parameters, refer to Chapter 4.3.6.2, "NRP
Power Viewer", on page 170.

To fill the table, press the "Execute" button.

Fill User Correction Data with Sensor
Enables you to fill the table with correction data acquired by a connected power sensor
from Rohde & Schwarz.

"Sensor" Displays connected sensors for selection.
"List To Fill" Indicates the used list file.

"Include Zeroing"
Performs a zeroing procedure before acquiring the user correction
data to improve precision. Since during zeroing no signal may be
applied to the sensor, RF is temporarily switched off at the generator.
When unchecked, the zeroing procedure is skipped. The RF signal
level might be blanked shortly. This setting is recommended if blank-
ing of RF is undesirable or the absence of power at the sensor can
not be guaranteed.

"Execute" Performs automatic filling of the list, provided a sensor is detected
and the user correction list contains at least one frequency value.

Remote command:

[ : SOURce<hw>] : CORRection:ZERoing:STATe on page 342

[ :SOURce<hw>] : CORRection:CSET:DATA[ : SENSor<ch>] [ : POWer] : SONCe
on page 337

Used SMB Settings for Measurement
Displays the settings relevant for the measurement.

"RF Source" Shows the path for which the correction menu settings are made.
"Modulation" Indicates the modulation state
"Amplitude" Shows the currently set level.
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"Use SParameter"
Indicates whether SParameter correction is used.

"Attenuator Mode"

Displays the selected mode of the attenuator.
"Fixed Range (PEP) In:"

Shows the level range.

Remote command:
n.a.

Reverse Power Protection

The reverse power protection prevents against overload by an external signal applied
to the RF output of the R&S SMB.

The R&S SMB equipped with frequency options up to 6 GHz includes a reverse power
protection as standard. For instruments equipped with frequency option R&S SMB-
B112 or R&S SMB-B112L a reverse power protection option R&S SMB-B30 is availa-
ble. Refer to the data sheet for additional information and the respective option.

The reverse power protection is tripped when the power of the external signal becomes
too high. A relay opens and interrupts the internal connection to the RF output. This
condition is indicated in the display header by the "OVERLOAD" status message.

Overload

If an "Overload" status message is indicated in the display header, reset the overload
protection by pressing the [RF ON/OFF] key.

The RF input is activated when the overload protection is reset.

Remote command:
:0UTPut<hw>:PROTection:TRIPped? on page 316
:OUTPut<hw>:PROTection:CLEar on page 316
:0UTPut<hw>[:STATe] on page 317

RF Measurement

NRP Sensor Mapping

The "NRP Sensor Mapping" lists all R&S NRP sensors detected by the instrument.

Any R&S NRP sensor that supports the USB legacy protocol and is connected to one
of the USB interfaces, is detected automatically and added to the list. Vice versa, the
R&S SMB removes a sensor from the list, when it is disconnected.

R&S NRP sensors that are connected via LAN or use the USBTMC protocol are not
automatically detected. They are detected by the scan search function.
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Access:

> Select "RF > config... > RF Measurement > NRP Sensor Mapping"

Freq RF OFF MOD OFF Level
1.000 000 000 000]etz | |-30.00]m |
A: ALC-Auto Info
Sensor Name Protocol | Conn. | Map. | = =
1|NRP18SN-900101 | Visa w 2
2 |NRP335N-%-900011 Wisa w -
Start Scan | Clear " <<< Hide I —
Add Sensor ————
IP or Host Mame |NROB—1D1824
Add LAN Sensor |
Device ID or Mame |NFRQE§
Sernial Number |1D1524
Add USBTMC Sensor |

The dialog lists all detected R&S NRP sensors for selection and mapping. You can
also browse the network for sensors.

The detected sensors are characterized by the used protocol and the correspond-
ing connector icon. In the "Mapping" column, you can assign the sensor to one of
the available sensor channels. The list can contain several entries but the

R&S SMB can only use up to four sensors simultaneously.

The remote commands required to define these settings are described in Chap-
ter 6.12, "SENSe, READ and INITiate Subsystems", on page 318.

Settings

SeNSOr MapPiNg LiSt......ccccciiiiiiiiiie e e e e e e e e e e 168

RS To= | o 1 PP 169

L7 == P UURRRR SR 169

Add Sensor/Hide 'Add SENSOI ... .o e 169

Add SeNSOr SEHINGS. .ciii i 169
L Add LAN SenS0r SEHNGS. .....c.cveveverereveeeeeeseeeeeeeseeeeeetesssesssssesseesssessssesesesenns 169
L Add USB SENSOr SEHINGS. .......vveeeereeeeeeeeeeeseee et seseseeeeseseeeesesesee e eenen e e 169

Sensor Mapping List
Displays a list of all sensor entries with information on the sensor name, the used pro-
tocol, the connector and the assigned mapping.

If a sensor is connected via LAN or uses the USBTMC protocaol, its protocol is indica-
ted as "Visa".

Remote command:

:SLISt[:LIST]? on page 321

:SLISt:ELEMent<ch>:MAPPing on page 319

:SLISt:SENSor:MAP on page 320
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Scan
Scans the network and the USB connections for sensors connected via the VISA com-
munication protocol, i.e. sensors that are addressed via LAN or USBTMC.

Sensors communicating via the USB legacy protocol are detected automatically.

Remote command:
:SLISt:SCAN[:STATe] on page 320

Clear
Removes the selected sensor from the sensor mapping list.

Remote command:
:SLISt:CLEar:LAN on page 319
:SLISt:CLEar:USB on page 319
:SLISt:CLEar[:ALL] on page 319

Add Sensor/Hide 'Add Sensor"
Shows or hides the "Add Sensor" settings.

Add Sensor settings
Configures settings to add sensors connected to the R&S SMB over USB or LAN.

Add LAN Sensor settings <— Add Sensor settings
Configures settings to add sensors connected to the R&S SMB over LAN.

"IP Address or Host Name"
Displays the host name or the IP address of a R&S NRP power sen-
Sor.
If the R&S SMB does not detect a connected R&S NRP sensor, you
can assign the address information manually.

"Add LAN Sensor"
Adds a detected R&S NRP sensor connected in the LAN to the list of
sensors, including its device ID or name and its serial number.

Remote command:
:SLISt:SCAN:LSENsor on page 319

Add USB Sensor settings — Add Sensor settings
Configures settings to add sensors connected to the R&S SMB via USB.

"Device ID or Sensor Name"
Displays the device identifier or the name of the R&S NRP power
sensor.
If the R&S SMB does not detect a connected R&S NRP sensor, you
can assign the ID or name manually.

"Serial Number"
Displays the serial number of the R&S NRP power sensor.
If the R&S SMB does not detect a connected R&S NRPsensor, you
can assign the serial number manually.
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"Add USBTMC Sensor"
Adds a detected R&S NRP sensor connected at the USB interface to
the list of sensors, including its device ID or name and its serial num-
ber.

Remote command:
:SLISt:SCAN:USENsor on page 320

4.3.6.2 NRP Power Viewer

The R&S SMB features the power viewer function for measuring or monitoring either
the RF output power, or a freely selectable signal source with R&S NRP power sen-
sors.

The instrument can perform up to 4 power measurements simultaneously.

To connect the sensors you have the following options:
® connect the sensor directly at a [USB] interface.
Requires the following cables, depending on the used sensor type:
— R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors

— R&S NRP-Z3 or R&S NRP-Z4 (USB adapter cables) for sensors of the
R&S NRP-Zxx family

® connect the sensor indirectly via [USB] using the R&S NRP-Z5 USB sensor hub.
The R&S NRP-Z5 USB sensor hub (high-speed USB 2.0) can host up to 4
R&S NRP sensors. It provides simultaneous internal and external triggering of all
connected sensors.

Requires additional cables, depending on the used output connector of the hub.
Choose one of the following:

— Short extension cable R&S NRP-Z2 for connection to the sensor connector.
This six-pole connection provides the external trigger capability.

— Standard USB cable (USB type A to USB type B) to any USB type A connector
of the R&S SMB. This connection does not support external triggering.

® connection the sensor indirectly via USB hub with external power supply unit
Requires the following cables, depending on the used sensor type:
— R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors

— R&S NRP-Z3
or R&S NRP-Z4 (USB adapter cables) for sensors of the R&S NRP-Zxx family

® connect an R&S NRPxxN power sensors via LAN
Using the Ethernet interface requires PoE (Power over Ethernet) to provide the
electrical power.

To establish the connection, you can use:
— A PoE Ethernet switch, e.g. R&S NRP-ZAP1 and an RJ-45 Ethernet cable.
— A PoE injector and an RJ-45 Ethernet cable.

See also:

® Chapter 3.2, "Instrument Tour", on page 48 for the assignment to the available con-
nectors
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® (etting Started manual of the R&S NRPSeries Power Sensors

® The Rohde & Schwarz website http://www.rohde-schwarz.com, section "Power
Meters & Voltmeters" for information on the sensor hub and the available accesso-
ries.

Detection and mapping

The R&S SMB automatically detects a connected R&S NRP power sensor and indi-
cates it in the dilaogs "NRP Power Viewer" NRP Power Viewer Settings and NRP Sen-
sor Mapping dialogs. By default, sensors 1 to 4 are assigned to the sensors at the USB
connectors, according to their sequence of connection. In the "Sensor Mapping dialog",
you can change the mapping.

For device specific information on the connected sensor, see Chapter 4.2.3.4, "NRP
Info/Update”, on page 101. For information on the scope of your power sensor refer to
the manual of your R&S NRP power sensor.

On connection, the R&S SMB immediately starts the measurement of a detected

@ R&S NRP power sensor. If you perform an instrument preset ([Preset] key or *RST),
the R&S SMB stops the measurements. The connection and the mapping of the power
sensors remain, the measurements must be restarted.

A sensor continuously measures the average signal power of the selected source,
such as an external signal, or the output signal of the signal generator with the RF level
used as reference value. The R&S SMB shows the result in the NRP Power Viewer
Settings settings dialog, but you can also permanently display the readings in the block
diagram.

O Further functions of the R&S SMB related to R&S NRP power sensors are:

® Acquisition of level correction data, see Chapter 4.3.5.6, "User Correction”,
on page 159.
The acquired level correction data is used to create and activate lists in which level
correction values predefined by the user are freely assigned to RF frequencies.
Correction is performed by the user-defined table values being added to the output
level for the respective RF frequency.

® NRP Level Control, see Chapter 4.3.5.5, "NRP Level Control", on page 155.
Note that "NRP Power Viewer" automatically disables "NRP Level Control", and
vice versa.

® The software version of the connected power sensor can be retrieved by means of
the remote control command SENSe<ch>[:POWer] : TYPE? on page 329.
Use the Chapter 4.2.3.4, "NRP Info/Update", on page 101 dialog to update the sen-
sor software.

@ "NRP Power Viewer" automatically disables NRP Level Control, and vice versa.
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NRP Power Viewer Settings

Access:

» Select one of the following:

e Select "RF > config... > RF Measurement > NRP Power Viewer".
e Press the [menu] key and select "RF > RF Measurement > NRP Power

Viewer".
W 2 - NRP18AN S/N 100992 -
Level (Peak) -19.35[dBm =]

Level (Average) _53 .63 ’dBm v|

Display Permanent Prionty IAvg. vl
Zero |

Source |F2F j

Level Offset IOﬁ 'I I U.U{JldB vl
Filter IAum vI I 65 536

Use Default Aperture Time [ On
Aperture Time| 1[].[]{]U|ps j
Use SParameter [~ On
Enable Logging [~ On

The dialog shows the settings and measurement values of the sensor selected in
the field next to the connector symbol. For indicating the parameters of another
sensor, switch to the respective sensor in the selection list.

When you connect your power sensor(s) via the R&S NRP-Z5 USB sensor hub, each
channel of the hub is firmly assigned to the associated sensor channel in the genera-
tor.

The remote commands required to define the settings are described in Chapter 6.12,
"SENSe, READ and INITiate Subsystems", on page 318.

Sensor
Selects the R&S NRP power sensor for display.

In remote control, the sensors are set up using the SENSe commands. The remote
measurement is triggered by the READ query which also provides the measurement
results.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the com-
mand header.
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Suffix 1 denotes the sensor connected at the first [USB] interface, and suffix 2, 3 and 4
are assigned to further sensors connected via USB. The suffix is identical to the index
which is assigned automatically to each sensor upon connection.

Note: The software version of the connected power sensor can be retrieved by means
of the remote control command SENS: POW: TYPE?.

Use the "Setup >" Chapter 4.2.3.4, "NRP Info/Update", on page 101 dialog to update
the sensor software.

Remote command:
SENSe<ch>[:POWer] : STATus [ : DEVice]? on page 329

Type
Indicates the type and the serial number of the connected R&S NRP power sensor.
The sensor type is automatically detected.

Remote command:
SENSe<ch>[:POWer] : TYPE? on page 329
SENSe<ch>[:POWer] : SNUMber? on page 328

State
Activates/deactivates level measurement by the power sensor.

The local state is set with the INIT command. Switching the local state off enhances
the measurement performance.

In remote control, the sensors are set up using the SENSe commands. The remote
measurement is triggered by the READ query which also provides the measurement
results. The state is not influenced by these commands, measurements results can be
retrieved with local State on or off.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the com-
mand header.

Suffix 1 denotes the sensor connected at the first [USB] interface, and suffix 2, 3 and 4
are assigned to further sensors connected via USB. The suffix is identical to the index
which is assigned automatically to each sensor upon connection.

To query the availability of a sensor at a given connector, use the command
SENSe<ch>[:POWer] :STATus [:DEVice] ? on page 329.

Remote command:
:INITiate<hw>[:POWer] :CONTinuous on page 322

Level (Peak)
With certain power sensors only, for example R&S NRP-Z81.

Indicates the measured peak level value with the selected unit.

Remote command:
:READ<ch>[:POWer] ? on page 322

Level (Avg.)
Indicates the measured level value with the selected unit.

Remote command:
:READ<ch>[:POWer] ? on page 322
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Unit
Selects the unit used for result display.
The power sensor provides the measured value in Watt.

In which unit the measured value is indicated is selected here and might be Watt, dBm
or dBuV.

Remote command:
:SENSe<ch>:UNIT[:POWer] on page 330

Permanent Display State

Activates the permanent indication of the power measurement result in the upper right
corner of the block diagram. The instrument shows the type of sensor, the correspond-
ing connector, the measurement source and - if set - the offset.

[1NRF’188N 7350 dBm;g]

It is possible to switch the permanent display active for several sensors. In this case,
the instrument indicates the values of the sensor with the lowest port number in the
display.

Remote command:
:SENSe<ch>[:POWer] : DISPlay:PERManent: STATe on page 324

Display Priority
Determines whether the instrument displays the measured average or the peak power
permanently on the screen.

To select the peak power display, it is required that the R&S NRP power sensor sup-
ports this feature. On power-on or connecting a sensor the average power value is set
by default.

To enable the permanent display in the block diagram, select Permanent Display State.

Remote command:
:SENSe<ch>[:POWer] :DISPlay:PERManent:PRIority on page 324

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:

® During warm up after switching on or connecting the instrument

After a substantial change of the ambient temperature

After fastening the power sensor module to an RF connector at high temperature
After several hours of operation

When low-power signals are to be measured, e.g. less than 10 dB above the lower
measurement limit.
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® Switch off the RF power source for zeroing, but do not disconnect it from the power
sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Remote command:
:SENSe<ch>[:POWer] : ZERO on page 330

Source
Selects the source for measurement.

"RF" Measurement source is the RF signal of the generator. The RF fre-
quency is used as the measurement frequency of the sensor and the
corresponding correction factor is used.

In this mode the RF frequency of the generator is send to the sensor
automatically if changed.

"User" Measurements source is any freely selectable source. The frequency
is entered manually under frequency (e.g. for measurement of ampli-
fier gain with 2 sensors).

Remote command:
:SENSe<ch>[:POWer] : SOURce on page 328

Frequency
Source User only

Enters the frequency for measurement source "User".

Remote command:
:SENSe<ch>[:POWer] : FREQuency on page 327

Level Offset

Activates and defines a level offset which is added to the measured value. This allows
e.g. an attenuator in the signal path to be considered. The offset is always entered in
dB, irrespective of the selected unit for result display.

Remote command:
:SENSe<ch>[:POWer] : OFFSet : STATe on page 328
:SENSe<ch>[:POWer] : OFFSet on page 327

Filter
Determines the length of the filter used for the measurement. The filter length affects
the measurement time directly.

The averaging filter is used to reduce fluctuations in the measured result to the extent
desired. Such fluctuations can be caused by inherent noise of the measuring instru-
ment, modulation of the measurement signal or beats from the superposition of adja-
cent carriers. A more stable display has to be traded off against longer measurements.
The measurement result is obtained from a two-stage averaging process.

Note: Longer measurements do not mean that it takes longer to display a new result,
but rather that it takes longer for the result to settle when the power changes.
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Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time win-
dows. The number N is the filter length, the factor of 2 arises because the output sig-
nals from the microwave detector to suppress low-frequency noise are chopped at the
same rate as the time windows, which means that an independent measured value can
only be obtained from two consecutive values. As the filter length is the multiplier for
the time window it directly influences the measurement time.

The filter length can be selected automatically or can be manually set to a fixed value.
As a preliminary, you should always check if the auto mode is giving satisfactory
results because you will always have to adjust an optimal, manual filter-length setting if
the power is not constant.

Selection "Fixed Noise" is offered for achieving defined measurement accuracy.

|lAut0lv

"User"

"Fixed Noise"

The filter length is automatically selected and adapted to the currently
measured value. With very high signals the filter length and therefore
the measurement time can be short. With very low signal levels the
filter length and therefore the measurement time is increased in order
to reduce noise. The used filter length is indicated in the field to the
right, see Filter Length.

The filter length is set manually.

The filter length is entered in the entry window to the right. As the fil-
ter length works as a multiplier for the time window, this results in a
constant measurement time.

Note: The time window varies depending on the used sensor. For
most sensors it is fixed to 20 ms. For the R&S NRP-Z81 sensor it is
10 us. Therefore, the user filter length for the R&S NRP-Z81 has be
about 1000 times larger than the filter length for other sensors in
order to achieve the same filtering result.

The Auto Once button can be used to search for the optimum filter
length for the current measurement conditions. The found filter length
is indicated in the field to the right, see Filter Length.

The averaging factor is selected so that the sensors intrinsic noise (2
standard deviations) does not exceed the specified noise content.
The desired noise content is entered in the entry field to the right, see
Noise Content.

To avoid very long settling times when the power is low, the averaging
factor can be limited with the Timeout parameter.

Remote command:
:SENSe<ch>[:POWer] :FILTer: TYPE on page 326

Filter Length — Filter
Indicates the used filter length for filter type "Auto" or "User".

Remote command:
:SENSe<ch>[:POWer] :FILTer: LENGth:AUTO? on page 324
:SENSe<ch>[:POWer] : FILTer: LENGth [ : USER] on page 325

Noise Content — Filter
Sets the noise content for filter type "Fixed Noise".
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Remote command:
:SENSe<ch>[:POWer] : FILTer :NSRatio on page 325

Timeout — Filter
Sets a time limit for the averaging process.

Remote command:
:SENSe<ch>[:POWer] :FILTer:NSRatio:MTIMe on page 325

Auto Once  Filter
Calculates the optimum filter length for the current measurement conditions and indi-
cates the value in the Filter Length.

Remote command:
:SENSe<ch>[:POWer] :FILTer: SONCe on page 326

Use Default Aperture Time
Enables you to specify a user-defined aperture time for the respective sensor.

The sensor default setting is usually sufficient. If however, the readings vary, it is rec-
ommended that you adjust the aperture time exactly to one modulation period, in order
to obtain stable readings. To specify the aperture time, see Aperture Time.

Remote command:
:SENSe<ch>[:POWer] :APERture:DEFault:STATe on page 321

Aperture Time
Defines the acquisition time for the respective sensor, provided the entry field is
enabled, see Use Default Aperture Time.

For example you can adjust the aperture time exactly to one signal period, in order to
obtain a sufficient low average value.

Remote command:
:SENSe<ch>[:POWer] : APERture: TIMe on page 321

Use SParameter - Power Sensors
Activates the use of the S-Parameter correction data of the connected power sensor.
For sensors with attenuator this checkbox is automatically checked.

Refer to the manual of the connected R&S NRP power sensor for a description on how
to use the SParameter table.

Remote command:
:SENSe<ch>[:POWer] : CORRection:SPDevice:STATe on page 323

Enable Logging
Activates recording of R&S NRP power sensor readings.

If enabled, every value measured by a connected power sensor and indicated in the
user interface, is written to a log file. Per measurement the function logs the measured
value (2 readings when you work with peak sensors), the sensor type and the mea-
surement time (time stamp).
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The function automatically creates the file name SensLog<n>. txt and stores the file
in *txt format under /var/user/SensorLogging on the hard disk. You can enable
logging for each connected sensor separately. If enabled, one file per sensor is written.

Note: This specific function is intended for measurements with long time intervals, or if
there is a risk that the connection to the sensor can be interrupted and you need the
data for reconstruction.

The simplified recording function continuously writes the values in the file of the corre-
sponding sensor number, like Sens1Log. txt. When you start a new measurement,
the existing data will not be overwritten, but added to the file.

If you use this function, it is recommended that you regularly remove the files from the
hard disk, since they require storage capacity.

Remote command:
:SENSe<ch>[:POWer] : LOGGing: STATe on page 327

4.3.7 RF Sweep and List Mode

4.3.7.1 Overview

The R&S SMB offers three different sweep types (frequency sweep, level sweep and
LF sweep) to be activated alternatively. Each type has 6 modes which differ with
respect to the sweep cycle mode (continuous, individual and step-by-step) and trigger-
ing mode (automatic, internal and ex